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Preface

Welcome to the Proxedo Network Security Suite 1.0 Administrator Guide!

This document describes how to configure and manage Proxedo Network Security Suite 1.0 and its components.
Background information for the technology and concepts used by the product is also discussed.

1. Summary of contents

Chapter 1, Introduction (p. 1) describes the main functionality and purpose of the Proxedo Network Security
Suite.

Chapter 2, Concepts of the PNS Gateway solution (p. 3) describes the features and capabilities of the different
components of PNS, as well as the concepts of PNS.

Chapter 3, Managing PNS hosts (p. 16) describes the main configuration utility of PNS.

Chapter 4, Registering new hosts (p. 52) explains how to manage several firewalls using a single management
Server.

Chapter 5, Networking, routing, and name resolution (p. 61) describes the management of network interfaces,
such as Ethernet cards.

Chapter 6, Managing network traffic with PNS (p. 82) describes how to customize the firewall system for
optimal security.

Chapter 7, Logging with syslog-ng (p. 173) introduces the capabilities of syslog-ng.

Chapter 8, The Text editor plugin (p. 193) discusses how to manage external services from Management Console.
Chapter 9, Native services (p. 197) describes the built-in DNS, NTP and mailing services of PNS.

Chapter 10, Local firewall administration (p. 212) explains how to manage PNS from a local console.
Chapter 11, Key and certificate management in PNS (p. 226) introduces the use and management of certificates.
Chapter 13, Advanced MS and Agent configuration (p. 275) discusses various advanced topics.

Chapter 12, Clusters and high availability (p. 254) introduces the use and management of PNS clusters.

Chapter 14, Virus and content filtering using CF (p. 300) discusses the concepts, configuration, and use of the
Content Filtering framework and the related modules.

Chapter 15, Connection authentication and authorization (p. 330) details the authentication and authorization
services provided by PNS and the Authentication Server.

Chapter 16, Virtual Private Networks (p. 359) how to build encrypted connections between remote networks
and hosts using virtual private networks (VPNs).
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Chapter 17, Integrating PNS to external monitoring systems (p. 381) describes how to integrate PNS to your
monitoring infrastructure.

Appendix A, Packet Filtering (p. 384) discusses how to configure and manage the built-in packet filter of PNS.

Appendix B, Keyboard shortcuts in Management Console (p. 403) describes the keyboard shortcuts available
in Management Console.

Appendix C, Further readings (p. 405) is a list of suggested reference materials in different PNS and network
security related fields.

Appendix D, Proxedo Network Security Suite End-User License Agreement (p. 407) includes the text of the
End-User License Agreement applicable to PNS products.

Appendix E, Creative Commons Attribution Non-commercial No Derivatives (by-nc-nd) License (p. 414) includes
the text of the Creative Commons Attribution Non-commercial No Derivatives (by-nc-nd) License applicable
to The Proxedo Network Security Suite 1.0 Administrator Guide.

2. Target audience and prerequisites

This guide is intended for use by system administrators and consultants responsible for network security and
whose task is the configuration and maintenance of PNS firewalls. PNS gives them a powerful and versatile
tool to create full control over their network traffic and enables them to protect their clients against
Internet-delinquency.

This guide is also useful for IT decision makers evaluating different firewall products because apart from the
practical side of everyday PNS administration, it introduces the philosophy behind PNS without the marketing
side of the issue.

The following skills and knowledge are necessary for a successful PNS administrator.

Skill Level/Description

Linux At least a power user's knowledge.

Experience in system administration Certainly an advantage, but not absolutely necessary.
Programming language knowledge It is not an explicit requirement to know any

programming language though being familiar with the
basics of Python may be an advantage, especially in
evaluating advanced firewall configurations or in
troubleshooting misconfigured firewalls.

General knowledge on firewalls A general understanding of firewalls, their roles in the
enterprise IT infrastructure and the main concepts and
tasks associated with firewall administration is essential.
To fulfill this requirement a significant part of Chapter
3, Architectural overview in the PNS Administrator's
Guide is devoted to the introduction to general firewall
concepts.

Knowledge on Netfilter concepts and IPTables In-depth knowledge is strongly recommended; while
it is not strictly required definitely helps understanding
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Skill Level/Description

the underlying operations and also helps in shortening
the learning curve.

Knowledge on TCP/IP protocol High level knowledge of the TCP/IP protocol suite is
a must, no successful firewall administration is possible
without this knowledge.

Table 1. Prerequisites

3. Products covered in this guide
The PNS Distribution DVD-ROM contains the following software packages:

m Current version of PNS 1.0 packages.
m Current version of Management Server (MS) 1.0.

m Current version of Management Console (MC) 1.0 (GUI) for both Linux and Windows operating
systems, and all the necessary software packages.

m Current version of Authentication Server (AS) 1.0.

m Current version of the Authentication Agent (AA) 1.0, the AS client for both Linux and Windows
operating systems.

For a detailed description of hardware requirements of PNS, see Chapter 1, System requirements in Proxedo
Network Security Suite 1.0 Installation Guide.

For additional information on PNS and its components visit the PNS website containing white papers, tutorials,
and online documentations on the above products.

4. About this document
This guide is a work-in-progress document with new versions appearing periodically.

The latest version of this document can be downloaded from https://docs.balasys.hu/.

4.1. Feedback

Any feedback is greatly appreciated, especially on what else this document should cover, including protocols
and network setups. General comments, errors found in the text, and any suggestions about how to improve
the documentation is welcome at <support@balasys.hu>.
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Chapter 1. Introduction

This chapter introduces the Proxedo Network Security Suite (PNS) in a non-technical manner, discussing how
and why is it useful, and what additional security it offers to an existing IT infrastructure.

1.1. What PNS is

PNS provides complete control over regular and encrypted network traffic, with the capability to filter and also
modify the content of the traffic.

PNS is a perimeter defense tool, developed for companies with extensive networks and high security requirements.
PNS inspects and analyzes the content of the network traffic to verify that it conforms to the standards of the
network protocol in use (for example, HTTP, IMAP, and so on). PNS provides central content filtering including
virus- and spamfiltering at the network perimeter, and is capable of inspecting a wide range of encrypted and
embedded protocols, for example, HTTPS and POP3S used for secure web browsing and mailing. PNS offers
a central management interface for handling multiple firewalls, and an extremely flexible, scriptable configuration
to suit divergent requirements.

The most notable features of PNS are the following:

Complete protocol inspection.  In contrast with packet filtering firewalls, PNS handles network connections
on the proxy level. PNS ends connections on one side, and establishes new connections on the other; that way
the transferred information is available on the device in its entirety, enabling complete protocol inspection.
PNS has inspection modules for over twenty different network protocols and can inspect 100% of the commands
and attributes of the protocols. All proxy modules understand the specifications of the protocol and can reject
connections that violate the standards. Also, every proxy is capable to inspect the TLS- or SSL-encrypted
version of the respective protocol.

Unmatched configuration possibilities. ~The more parameters of a network connection are known, the more
precise policies can be created about the connection. Complete protocol inspection provides an immense amount
of information, giving PNS administrators unprecedented accuracy to implement the regulations of the security
policy on the network perimeter. The freedom in customization helps to avoid bad trade-offs between effective
business-processes and the required level of security.

Reacting to network trafficc PNS can not only make complex decisions based on information obtained
from network traffic, but is also capable of modifying certain elements of the traffic according to its configuration.
This allows to hide data about security risks, and can also be used to treat the security vulnerabilities of
applications protected by the firewall.

Controlling encrypted channels. PNS offers complete control over encrypted channels. The thorough
inspection of embedded traffic can in itself reveal and stop potential attacks like viruses, trojans, and other
malicious programs. This capability of the product provides protection against infected e-mails, or websites
having dangerous content, even if they arrive in encrypted (HTTPS, POP3S, or IMAPS) channels. The control
over SSH and SSL traffic makes it possible to separately handle special features of these protocols, like port-
and x-forwarding. Furthermore, the technology gives control over which remote servers can the users access
by verifying the validity of the server certificates on the firewall. That way the company security policy can
deny access to untrusted websites having invalid certificates.
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Centralized management system. The easy-to-use, central management system provides a uniform interface
to configure and monitor the elements used in perimeter defense: PNS devices, content vectoring servers, as
well as clusters of these elements. Different, even completely independent groups of PNS devices can be
managed from the system. That way devices located on different sites, or at different companies can be
administered using a single interface.

Content vectoring on the network perimeter. PNS provides a platform for antivirus engines. Using PNS’s
architecture, these engines become able to filter data channels they cannot access on their own. PNS’s modularity
and over twenty proxy modules enables virus- and spamfiltering products to find malicious content in an
unparalleled number of protocols, and their encrypted versions.

Single Sign On authentication. Linking all network connections to a single authentication greatly simplifies
user-privilege management and system audit. PNS’s single sign on solution is a simple and user-friendly way
to cooperate with Active Directory. Existing LDAP, PAM, AD, and RADIUS databases integrate seamlessly
with PNS’s authentication module. Both password-based and strong (S/Key, SecurelD, X.509, and so on)
authentication methods are supported. X.509-based authentication is supported by the RDP and SSH proxies
as well, making it possible to use smartcard-based authentication mechanisms and integrate with enterprise
PKT systems.

1.2. Who uses PNS?

The protection provided by the PNS application-level perimeter defense technology satisfies even the highest
security needs. The typical users of PNS come from the governmental, financial, and telecommunication sectors,
including industrial companies as well. PNS is especially useful in the following situations:

m To protect networks that handle sensitive data or provide critical business processes.

m To solve unique, specialized IT security problems.

m To filter encrypted channels (for example, HTTPS, POP3S, IMAPS, SMTPS, FTPS, SFTP, and so
on).

m To perform centralized content filtering (virus and spam) even in encrypted channels.

m To filter specialized protocols (for example, Radius, SIP, SOAP, SOCKS, MS RPC, VNC, RDP,
and so on).
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Chapter 2. Concepts of the PNS Gateway solution

This chapter provides an overview of the PNS Gateway solution, introduces its main conceptss and explains
the relationship of the various components.

2.1. Main components of the PNS Gateway solution
A typical PNS Gateway solution consists of the following components:

®m One or more PNS firewall hests. Application-level Gateway is inspecting and analyzing all
connections.

B A Management Server (MS). MS is the central managing server of the PNS Gateway solution. MS
stores the settings of every component, and generates the configuration files needed by the other
components. A single MS can manage the configuration of several PNS firewalls — for example,
if an organization has several separate facilities with their own firewalls, each of them can be managed
from a central Management Server.

®m One or more desktop computers running the Management Console (MC), the graphical user interface
of MS. The PNS administrators use this application to manage the entire system.

m Transfer agents. These applications perform the communication between MS and the other
components.

m One or more Content Filtering (CF) servers. CF servers can inspect and filter the content of the
network traffic, for example, using different virus- and spamfiltering modules. CF can inspect over
10 network protocols, including encrypted ones as well. For example, SMTP, HTTP, HTTPS, and
SO on.

®m One or more Authentication Server (AS). AS can authenticate every network connection of the
clients to a variety of databases, including LDAP, RADIUS, or TACACS. Clients can also authenticate
out-of-band using a separate authentication agent.

Note
@ The name of the application effectively serving as the Application-level Gateway component of Proxedo Network Security Suite is Zorp,
commands, paths and internal references will relate to that naming.

The following figure shows how these components operate:
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Figure 2.1. The architecture of the PNS firewall system
2.1.1. PNS

The heart of the PNS—based firewall solution is the firewalling software itself, which is a set of proxy modules
acting as application layer gateways. PNS is an application proxy firewall. For details on the architecture of
PNS itself, see Section 2.2, The concepts and architecture of PNS firewalls (p. 12).

PNS must be installed on an Ubuntu-based operating system (Ubuntu 18.04 LTS) which installs automatically
when booting from the PNS installation media.

2.1.2. Management Server (MS)

The Management Server (MS) handles the configuration tasks of the entire solution. Your firewall administrators
use the Management Console (MC) application on their desktop to access MS and modify the configuration of
your firewalls. MS is the central command center of the solution: it stores and manages the configuration of
PNS firewall hosts.

The real power of MS surfaces when more than one PNS firewalls have to be administered: instead of configuring
the different firewalls individually and manually, you can configure them at a central location with MS, and
upload the configuration changes to the firewalls. Because MS stores the configuration of every firewall, you
can backup the configuration of your entire firewall system. In case of an emergency, you can restore the
configuration of every firewall with a few clicks.
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2.1.3. Transfer Agent

Technically, MS does not communicate directly with the PNS host: all communication is done through the PNS
Transfer Agent application, which is responsible for transporting configuration files to the managed hosts,
running MS-initiated commands, and reporting the firewall configuration and other related information to MS.
The PNS Transfer Agent is automatically installed on every PNS host. The communication is secured using
Secure Socket Layer (SSL) encryption. The communicating hosts authenticate each other using certificates.
For more information, see Section 13.1.1.5, Configuring authentication settings (p. 280).

Communication between the agents and MS uses TCP port 1311. If PNS and MS is installed on the same host,
communication between the transfer agent and the MS server uses UNIX domain sockets.

Warning
A Agent connections must be enabled on every managed host, otherwise MS cannot control the hosts. For details, see Appendix A, Packet
Filtering (p. 384).

By default, the MS host initiates the communication channel to the agents, but the agents can also be configured
to start the communication, if required.

2.1.4. Management Console (MC)

The Management Console (MC) is the graphical interface to Management Server (MS). A single MS engine
can manage several different PNS firewalls. MC is designed so that almost all administration tasks of PNS can
be accomplished with it and therefore no advanced Linux skills are required to manage the firewall.

port 1314.

Note
@ MC can connect to the MS host remotely, even over the Internet. All connections between MC and MS are SSL-encrypted, and use TCP
MC can only alter configurations stored in the MS database. It does not directly communicate with the firewall hosts.

Commit ZMS ipload FIREWALL

s oo [l ™

| _—,
et ~—t
. — database

Figure 2.2. Communication between MC, MS, and PNS
MC can be installed on the following platforms:

® Microsoft Windows Vista or later

B Linux
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2.1.5. Authentication Server (AS)

PNS can authenticate every connection: it is a single sign-on (SSO) authentication point for network connections.
During authentication, PNS communicates with the Authentication Agent (AA) application that runs on the
client computers.

However, PNS does not have database access for authentication information such as usernames, passwords and
access rights. It operates indirectly with the help of authentication backends through an authentication middleware,
the Authentication Server (AS). To authenticate a connection, PNS connects to AS, and AS retrieves the
necessary information from a user database. AS notifies PNS about the results of the authentication, together
with some additional data about the user that can be used for authorization.

I Zorp service I I ‘ZAS|Routers
I "'\ Eondition 1
| M &y Condition 2 I

ﬂuihenticatiun | iutheniicatiun | u
I "~ ZAS I
[ |

policy provider . '
A 1
I I instance 2 ’
o

Zorp Zorp Authentication Server

e

Figure 2.3. The operation of AS
AS supports the following user database backends:

m plain file in Apache htpasswd format

m Pluggable Authentication Module (PAM) framework

m RADIUS server

m LDAP server (plain BIND, password authentication, or with own LDAP scheme)
®m Microsoft ActiveDirectory

AS supports the following authentication methods:

m plain password-based authentication
m challenge/response method (S/KEY, CryptoCard RB1)
m X.509 certificates

m Kerberos 5

2.1.6. The concept of the CF framework

CF is not a content vectoring engine, it is a framework to manage and configure various third-party content
vectoring modules (engines) from a uniform interface. PNS uses these modules to filter the traffic. These
modules run independently from PNS. They do not even have to run on the same machines. PNS can send the
data to be inspected to these modules, along with configuration parameters appropriate for the scenario. For
example, a virus filtering module can be used to inspect all files in the traffic, but different parameters can be
used to inspect files in HTTP downloads and e-mail attachments. Also, different scenarios can use a different
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set of modules for inspecting the traffic. Using the above example, HTTP traffic could be inspected with a virus
filter, a content filter, and all client-side scripts could be removed. E-mails could be scanned for viruses using
the same virus filtering module (but possibly with stricter settings), and also inspected by a spam filtering
module.

Zorp proxy

-.\ ‘Routers
— - ZCV Condition 1 - Fals
Rule group Condition/ 2 - True

Default action

Figure 2.4. Interaction of PNS and CF

m A PNS proxy can send data for further inspection to a CF rule group.
m A rule group is used to define a scenario (using a set of router rules).

m The router rules of the scenario are condition — action pairs that determine how a particular object
should be inspected. This decision is based on meta-information about the traffic or objects received
from PNS and on information collected by CF.

» The condition can be any information that PNS/CF can parse, for example, the client's IP address,
the MIME-type of the object, and so on.

 The action is either a default action (such as ACCEPT or REJECT), or a scanpath — a list of content
vectoring module instances (the modules and their settings corresponding to the scenario) that
will inspect the traffic. Rule groups have a scanpath configured as default, but the routers in the
group can select a different scanpath for certain conditions.

The examples demonstrated on Figure 2.5, Content vectoring scenarios in CF (p. 8) can be translated to the
CF terms defined in the previous paragraph as follows:
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Scenario 1:
HTTP
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Zorp

Content Vectoring

E‘:cenarin 2:
SMTP

Internal Mail Server

Figure 2.5. Content vectoring scenarios in CF

1. There are two rule groups (scenarios) defined, one for HTTP traffic, one for SMTP.
2. Router rules in the HTTP rule group call a scanpath.

3. The scanpath includes module instances of a virus filtering, a content filtering, and an HTML module
that are configured to remove all scripts.

This is only a basic example, further router rules could be used to optimize the decisions (for example, there
is not much sense in trying to remove client-side scripts in non-HTML files that are downloaded, and so on).
Similarly, another rule group corresponds to the SMTP scenario, with a scanpath including a virus filtering
and a spam filtering module instance.

The whole process is summarized in the following procedure.
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2.1.6.1. Procedure - Content vectoring with CF

Step 1. A PNS proxy sends the traffic to be inspected to an appropriate CF rule group.

Step 2. CF evaluates the router conditions of the rule group. If no condition is fulfilled, the action set as default
(a default scanpath, or an ACCEPT/REJECT) is performed. Otherwise, the action/scanpath specified
for the condition is followed.

Step 3. The traffic is inspected by the module instances specified in the selected scanpath. A module instance
can be used in multiple scanpaths, with different parameters in each one.

Step 4. The processed traffic is returned to PNS.

2.1.6.2. Supported modules

The CF framework was designed to allow the easy and fast integration of various third-party content vectoring
tools. Currently the following modules are supported:
m Virus filtering modules:
* NOD32 (http://www.eset.com)
» Clam AntiVirus (http://clamav.net)

® Spam filtering modules:

» SpamAssassin (http://spamassassin.apache.org/)

® Other modules

* HTML filtering module: Capable of general content filtering, as well as filtering JavaScript,
ActiveX, Java, and Cascading Style Sheets (CSS).

* Mail header filtering: Capable of filtering and manipulating mail headers in SMTP traffic.

» Mime filtering: Capable of filtering, removing, and adding MIME headers and objects in HTTP,
POP3, and SMTP traffic.

* General stream editing module: Capable of replacing strings in data streams.

» Custom application: CF provides a general interface to inspect the data with other third-party
applications.

Some of the listed modules must be licensed separately from PNS/CF. For details, contact your distributor.

2.1.7. Virtual Private Networking (VPN) support

PNS uses strongSwan to support native Linux IPSec solutions, and also supports OpenVPN (an SSL-based
VPN solution). PNS supports both transport and tunnel mode VPN channels. Tunnel authentication is possible
with X.509 certificates and with pre-shared keys (PSK). IPSec settings can be negotiated manually, or using
Internet Key Exchange (IKE).
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Figure 2.6. Virtual Private Networks

2.1.8. Native services

Native services provide a limited number of server-like features in PNS. Their use is optional and depends on
the needs and security requirements of your organization. The use of Network Time Protocol (NTP) and Bind
is recommended, while Postfix is useful for managing mail traffic from various firewall components locally.

These services are called native because they are installed with PNS and are available by default. They are
implementations of the actual Linux services of the same names. These services provide networking services
that are either difficult to implement with application proxies (or at the packet filter level) or provide services
for the firewall itself. For more information on these services, see Chapter 9, Native services (p. 197).

m NTP: PNS hosts can function both as a Network Time Protocol (NTP) client and server. Time
synchronization among the PNS hosts is very important for correct logging entries. Once the firewall's
time is correctly synchronized, it can act as the authentic time source for its internal networks.

m DNS: PNS features a fully functional ISC BIND 9 DNS server. It is optional and definitely not
mandatory to use if security regulations explicitly prohibit the installation of non-firewall software
on the firewall machine. However, in small and mid-sized networks, it can be beneficial to have a
built-in name server, if it is solely used as a forward—only DNS server.

B SMTP: PNS uses Postfix as the built-in SMTP server component. Postfix is used for SMTP queuing.
PNS also has an application proxy for inspecting SMTP traffic, while CF can be used to perform
virus, spam, and content-based filtering on the SMTP traffic. The primary role of this Postfix service
is to provide a Mail Transport Agent (MTA) for the firewall itself: a number of mail messages can
originate from the firewall, and these messages are delivered using the Postfix service. Although the
Postfix service is a fully functional MTA in PNS, it is not intended to be a general purpose mail
server solution for any organization.

2.1.9. High Availability

PNS supports multi-node (2+) failover clustering, as well as load balance clusters (most load balance
configurations use external devices). Clustering support must be licensed separately. PNS supports the following
failover methods:

m Transferring the Service IP address

m Transferring TP and MAC address

m Sending RIP messages

For more information see Chapter 12, Clusters and high availability (p. 254).
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2.1.10. Operating system

PNS runs on Ubuntu-based operating systems. Currently it supports Ubuntu 18.04 LTS. You can either install
the PNS packages on an existing Ubuntu server installation from the official APT repositories, or use our
installation media to install a minimal Ubuntu 18.04 LTS server and the PNS packages.

2.2. The concepts and architecture of PNS firewalls

The following sections discuss the main concepts of PNS firewalls.

2.2.1. Access control

A firewall controls which networks and hosts can be accessed, and who can access them. To create traffic rules,
first you must accurately define the networking environment of PNS, then you can apply access control on the
traffic. This can be achieved using zones and rules.

Zones consist of one or more IP subnets that PNS handles together. By default, there is only a single zone: the
IP network 0.0.0.0/0, which practically means every available IP addresses (that is, the entire Internet). You
can organize zones into a hierarchy to reflect your network, or the structure of your organization.

Although zones consist of IP subnets and/or individual IP addresses, zone organization is independent of the
subnetting practices of your organization. For example, you can define a zone that contains the 192.168.7.0/24
subnet and it can have a subzone with IP addresses from the 10.0.0.0/8 range, and the single IP address of
172.16.54.4/32. For details on zones, see Section 6.2, Zones (p. 82).

2.2.2. Operation modes of PNS

The first line of network defense is a packet filter that blocks traffic based on the IP address or TCP/UDP port
number of the source (that is, the client) or the destination (that is, the server) of the connection. That way,
more thorough analysis, such as traffic inspection or content vectoring is performed only on traffic that is
permitted at all. This technology using both packet filtering and application proxying together is called multilayer
filtering.

m Packet filtering: Traffic that can be filtered based on IP and TCP/UDP header information can be
blocked at the packet filter level. Likewise, it is possible to forward traffic at the packet filter level
without analyzing them with application proxies. For such traffic, PNS operates like an ordinary
packet filtering firewall. Forwarding traffic at the packet filter level may be desirable special protocols
that cannot be proxied, or if proxying causes performance problems in the connection, or in case of
non-TCP/UDP or bulk traffic. PNS provides a number of built-in, protocol-specific proxy classes
for the most typical protocols, and it has a generic proxy for protocols not supported by the built-in
proxies. Packet filter level forwarding is not recommended, unless it is absolutely unavoidable.
Application proxies provide a higher level of security. Packet filters are the first line of defense, they
can be used to block unwanted traffic. What is not blocked by default, on the other hand, should be
filtered by the appropriate application proxies.

m Traffic proxying: Application level services inspect the traffic on the protocol level (Layer 7 in the
OSI model). PNS provides a generic proxy, called PlugProxy that does not perform special data
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analysis, but can be used to proxy the traffic. Application proxies always provide an additional level
of filtering over packet filters.

2.2.3. Packet filtering in PNS

In PNS, packet filtering is handled by the kzorp kernel module, therefore packet filtering services are completely
handled on the kernel level. When PNS starts, it sends all information about the traffic permitted to pass the
gateway (that is, the list of configured services, zones, firewall rules, and so on) to the kzorp module.

Application-level services (also called proxy services) are handled on two levels:

m The kzorp kernel module receives and accepts the connections.
m All other functionality is performed by PNS in the userspace.

For both service types, the kzorp kernel module makes the client-side access control (DAC) decision. Both
service types can be configured from a uniform interface using MC.

Handling packet filtering in the kernel has the following important consequences:

m Packet filtering rules can match on zones as well, not only on IP addresses.

m Network Address Translation (NAT) is available also in the kernel, therefore it is possible to NAT
packet filtering services. However, not every type of NatPolicy can be used with packet filtering
services. For details, see Section 6.7.5, NAT policies (p. 157).

m The tproxy table of the iptables utility that earlier PNS versions used to perform transparent proxying
is empty. PNS does not use it, but it is available if for some reason you want to add rules manually.

2.2.4. Proxying connections

PNS is a proxy gateway. It separates the connection between the client and the server into two separate
connections: one between the client and PNS, and another between PNS and the server. PNS receives the
incoming client connection requests, inspects them, and transfers them to the server. PNS also receives the
replies of the server, inspects them, and replies to the client instead of the server. That way PNS has access to
the entire network communication between the client and the server, and can enforce protocol standards and
the security policy of your organization (for example, permit only specific clients to access the server, or enforce
the use of strong encryption algorithms in the connection).

Proxying can take two basic forms:

m Nontransparent: In case of nontransparent proxying, client connections target PNS instead of their
intended destination.This solution usually requires some client-side setup, for example, to configure
the proxy settings in the web browser of the client.

m Transparent: To integrate to your network environment easily, PNS can operate transparently. In
case of transparent proxying, the client connections target the intended destinations server, and PNS
inspects the network traffic directly. The client and the server do not detect that PNS mitigates their
communication. In case of transparent proxying, no client side setup is required. This means that
you do not have to modify the configuration of your clients and servers when PNS is integrated into
your network: PNS is invisible for the end user.
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2.2.5. Traffic analysis with proxies
The traffic in a connection usually consists of two parts:

m control information (for example, headers and metainformation)

m data (the payload)
The protocol proxies of PNS analyze and filter the control part of the traffic, but — in most cases — ignore the
payload. (The antivirus and spam-filtering modules of CF inspect the payload.) PNS proxies can thoroughly
inspect the protocol headers to ensure compliance to the protocol, disable the use of prohibited options, and so
on. PNS can handle commonly used protocols, including;:

m FTP/FTPS

m HTTP/HTTPS

m IMAP/IMAPS

m NNTP/NNTPS

m POP3/POP3S

m RDP
m SIP
m SMTP/SMTPS
B SQLNet
m SSH
m SSL/TLS
m Telnet

m VNC
Every protocol proxy can handle the SSL/TLS encrypted version of the protocol, and inspect the embedded
traffic, giving control over HTTPS, SMTPS, and other connections.

For more information on supported protocols and for a complete list of proxies, see Proxedo Network Security
Suite 1.0 Reference Guide.

2.2.6. Proxy customization

The default settings of the protocol proxies of PNS ensure that the traffic complies to the relevant RFC for the
given protocol. To provide flexibility, and to solve a wide variety of custom scenarios, you can customize the
proxies and change their parameters to best suit your environment and your security requirements. For example,
you can:

m Disable selected commands in FTP.

®m Modify the transferred headers in HTTP.

B Permit using only selected web browsers.

m Specify which encryption algorithms are permitted in SSL/TLS.
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In addition, the proxies in PNS are fully scriptable, and can be programmed in Python to perform any custom
functionality. For information on customizing proxies, see Section 6.6.1, Customizing proxies (p. 134), and
Proxedo Network Security Suite 1.0 Reference Guide.

2.2.7. Modular architecture

Today, network traffic often uses more than a single protocol: it embeds another protocol into a transport
protocol. For example, HTTPS is HTTP protocol embedded into the Secure Socket Layer (SSL) protocol. SSL
encrypts HTTP traffic and many firewalls simply permit encrypted traffic pass without thorough inspection.
This is not an optimal solution from a security aspect, and PNS has a better solution to this problem: it decrypts
and inspects the SSL traffic, and passes the data stream to an HTTP proxy to inspect it. This modular architecture
(that is, proxies can be stacked into each other, or even chained together for sequential protocol analysis) allows
for sophisticated inspection of complex traffic, for example, to perform virus filtering in HTTPS, or spam
filtering in POP3S traffic.
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Chapter 3. Managing PNS hosts

There are two ways to manage PNS firewalls:

m Using the Management Server (MS) and the Management Console (MC) graphical user interface
(GUI). PNS and MS are designed to be configured using the Management Console (MC). The
Proxedo Network Security Suite 1.0 Administrator Guide (p. i) focuses primarily on the preferred
MC-based administration method.

® Manually editing the configuration files of every host. This method requires advanced Linux skills
and deep technical knowledge about how PNS works. For more information on this procedure, see
Chapter 10, Local firewall administration (p. 212).

Note
@ You cannot mix the two administration methods: once you start editing configuration files manually, you cannot continue or revert to
using MC, unless you rebuild the configuration from scratch.

3.1. MS and MC

MC itself is just a graphical frontend to MS. It is MS that stores configuration information and manages
connections with the agents on managed hosts. The MS-based firewall management can only be performed
through MC; there is no console alternative. MC is not “bound” to a particular MS host, as long as the proper
username/password pair is known, it can be used to connect to any MS host.

MC can be started the following way:

® Windows: Locate the PNS folder in the Start menu and click on the MC icon. If no such folder has
been created when MC was installed, start zmc . exe manually from the installation folder.

m Linux: Start MC from the Network or Internet menu of your desktop environment, or from the
console by executing the following command: ./<installation-directory>/bin/zmc.
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Figure 3.1. Selecting the MS engine to connect to
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When you first start MC after the installation, the list of reachable MS hosts is empty, therefore you must define
a new host. To define a new host, click New. MC configurations are stored in a folder named .zmsgui. This
folder (for the Windows version of MC) is created in the installing user's profile directory, which is typically
%systemroot%\Documents and Settings\%username% The name of the file that stores MC configurations
is zmsgui.conf. The Linux version of MC stores configuration information in the same manner, within the
user's home directory.

3.1.1. Procedure - Defining a new host and starting MC
Purpose:

To define a new host entry and start MC, complete the following steps.
Steps:

Step 1. To define a new entry in the list of reachable MS hosts, click New.

ZMC - New server =

New server

Engine: |examplehost

Address: [198.51.100.1

port: |

Cancel ‘ oK |

Figure 3.2. Defining a new host in MC

Step 2. Enter a name for the host in the Engine field. It can be an arbitrary string and does not have be the
same as the hostname of the MS Host.

Step 3. Enter the IP address of the host in the IP address field.
Step 4. Optional step: Fill the Port field or leave it empty to use the default TCP port 1314.
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You can change the port assignment later, if needed.

Step 5. Click OK. The new entry is now listed in the Engine list.

Step 6. To continue with authentication, click OK.

Login to ZMS x

Welcome to the
ZORP Management System

Enter your username

|admin|

Cancel ‘ OK |

Figure 3.3. MC authentication

By default, the built-in administrator account of MS and therefore PNS is admin. Its MS password
was defined during installation.

The name of the administrator can be changed or additional administrators can be added later through
MC. To modify existing users or add new ones, see Section 13.1.1, Configuring user authentication
and privileges (p. 277). To create user accounts with limited privileges (for example, users who can
only look at the configuration for auditing purposes, but cannot change anything) see Section 13.1.1.4,
Configuring user privileges (p. 279).

Expected outcome:

After entering the correct password, if network connectivity is provided, the MC main screen greets you.

@
A

Note
When MC connects to a MS engine for the first time, it displays the SSH-style fingerprint of the MS host. During later connections, it
checks the fingerprint automatically.

Warning
MC and the MS to be accessed must have matching version numbers, that is, MS 7.0.1 must be accessed with MC 7.0.1. Login is not
permitted if the version number of MS and MS is different.

3.2. MC structure

MC is divided into three main parts:

m Section 3.2.1, Configuration tree (p. 19)

B Section 3.2.2, Main workspace (p. 25)

B Section 3.2.3, Menu & status bars and Preferences (p. 25)
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Figure 3.4. MC main screen

Note
For more information on the configuration buttons of the button bar, see Section 3.3.2, Configuration buttons (p. 33).

®

The following sections introduce MC components and highlight their main purposes.

3.2.1. Configuration tree

The configuration tree lists the configurable components of a PNS system. Whenever you select an item in the
configuration tree, the main workplace displays the configurable parameters of the selected item. The
configuration tree is organized hierarchically and this hierarchy maps the management philosophy of PNS.

Configuration

- | Default_corporate

~ [llzMms_Host
[ElManagement agents
[E]Management server
[Elnetworking

~ [Firewall_Host
[ElNetworking
[Management agents

~ [MlFirewall_Cluster
[Elnetworking
[EManagement agents

Figure 3.5. Configuration tree in MC

The topmost item in the configuration tree is the Site's name that you have entered during MS host installation.
There are usually one or more items below it: MS and/or PNS hosts.

In the most basic scenario, where MS is installed on the PNS machine, there is only one machine listed. Note
that in this case the name that appears here is the name of the MS host entered during installation. Under each
host, a varying number of configuration components are listed.

By default two components are available for each host:
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B Management agents
m Networking
Because the MS_Host in this example is a Management server too, it has a third component for configuring

management server parameters.

Each site, host, and component has status icons or leds on its left. These are described in detail in Section 3.3.6,
Status indicator icons (p. 41).

The number of components increases as you start the real work: many services have standalone configuration
components that you have to add to the configuration tree to use them.

The forthcoming chapters deal with these components in detail.

3.2.1.1. Site

The biggest configuration entity most PNS systems consist of is the Site. A Site is a collection of network
entities that belong together from a networking aspect.

From the firewall administration point of view, the Site is the collection of the machine nodes. If the company
is large and/or has geographically separated subdivisions, more than one firewall may be required. If they are
all administered by a single (team of) administrator(s), they can all fall under the supervision of a single MS
host. In this case, the Site consists of a MS Host and a number of firewalls

The reverse of this setup is not possible: a single PNS firewall cannot be managed by more than one MS hosts,
because this setup would cause indefinite and confused firewall states.

If you purchased the High Availability (HA) module for PNS too and therefore have two firewall nodes clustered,
they can be administered as a single MS host. Clusters are described in detail in Chapter 12, Clusters and high
availability (p. 254).

MC machines do not belong to the Site(s) they administer technically, though physically they are located in
close proximity to them.

A Site is a typical container unit and components of a Site (that is, the Hosts) share only few but important
properties:

®m Zone configuration
All Hosts (firewalls) belonging to the same Site share a common zone configuration. For more
information on zones, see Chapter 6, Managing network traffic with PNS (p. 82).

m Public key infrastructure (PKI) settings
PNS makes heavy use of PKI, for example, in securing communication between MS and the firewalls,

in authenticating IPSec VPN tunnels, proxying SSL-encrypted traffic.

Although a Site can be managed by a single MS Host only, a MS Host can manage more than one sites.
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Tip

A possible reason for a company to create more than one site may be to maintain different Zone structures for different sets of firewalls.
This is a frequent requirement for geographically distributed corporations that have separated network segments defended by PNS
firewalls, but want to maintain central (MS-based) control over their firewalls.

Another possible user of multi-site, single-MS setups is a support company that performs outsourced PNS administration for a number
of clients. In this scenario all business clients are ordered into separate sites, but all these sites are managed by the support company's
single MS Host.

3.2.1.2. Host
A Site is composed of one or more Hosts. Hosts can be the following items:

m PNS firewalls,

m CF hosts,

m AS hosts, and

B MS-managed hosts.

At the very minimum setup, when PNS and MS are installed on the same machine, there is one Host registered
for the given Site. The number of PNS firewall nodes per Site is only limited by the number of licenses purchased.
With the exception of Zone and PKI settings, configuration parameters are always per Host.

To display system statistics for a Host component (MS or PNS), click on the name of the Host. The statistics
are displayed under the Host tab. The following statistics are available:
Processor

Load average

Memory usage: RAMand SWAP
Only on PNS hosts:

e The version number of PNS

|
|
m Uptime
|
|

» The number and status of running PNS Instances, Processes and Threads

The validity and size of the product licenses (PNS, MS, and so on) available on the host. MC displays
a warning if a license expires soon, and an alert e-mail can be configured as well. For details on
configuring e-mail alerts for license expiry, see Procedure 11.3.8.8, Monitoring licenses and
certificates (p. 253).

Note
@ To access license information from the command line, login to the host and enter:

/usr/lib/zms-transfer-agent/zms_program_status hoststat
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States: 62.50 % user, 0.00 % system, 37.50 % idle, 0.00 % nice
Process load; 1

Memory
RAM: 515024 kB total. 18080 kB unused, 23252 kB buffers, 295332 kB cached
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Figure 3.6. Host statistics
The statistics are automatically refreshed every 30 seconds by default.
Tip

Although host statistics can seem a less important, auxiliary service, it is extremely useful when firewalls operate under continuous
heavy load and you want to optimize resource allocation.

3.2.1.3. Component

The actual configuration of hosts is performed using configuration components. These components are bound
to the specific firewall services. For example, there are separate components for Postfix (Mail transport), for
NTP (Time) and for PNS itself. The list of usable components depend on the type of host under configuration.
Most components belong to PNS firewall hosts.

By default, there are two components added for each host: Networking and Management Agent. For MS
hosts the Management Server component is added automatically.

3.2.1.3.1. Procedure - Adding new configuration components to host
Purpose:

To add a new confiugration component to a host, complete the following steps.

Steps:

Step 1. Select the host you want to add a new component to in the Configuration tree.
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Figure 3.7. Adding new components

Step 2. Navigate to the Hosttab, and under the Components in use section, click New.

Step 3. Select the configuration component to add from the Components available list.

Note
@ For managing PNS firewall hosts, it is essential to add the Application-level Gateway and the Packet Filter
components, at the very minimum.

The configuration components are strictly focused on the service they manage and all have a distinctive
graphical management interface accordingly. For more information on the different components, see
the respective chapters.
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ZMC - Add new component x
Components available
u = % @ fil
Authentication Content Mail Management Management Networking
Server Vectoring transport agents server

Component templates

Description

Mail transport minimal
Mative proxy with mail spool and local mail forwarding
Mail spool setup for Zorp and local mail Forwarding

Local mail Forwarding only

Mail transport default

OK

Figure 3.8. Configuration components
The following components are available:

m Authentication Server: Authentication Server (AS).
m Content Vectoring: Content Filtering (CF).

® Mail transport: POSTFIX.

® Management agents:

® Management server: Management Server (MS)
m Networking:

m Packet filter:

m System logging: syslog-ng

m Text editor:

® Time: NTP

m VPN:

m Application-level Gateway:

Step 4. Select the template to use for the component from the Component templates list.

Step 5. Depending on the component, either enter default values for the component in the appearing new
window or select a default configuration template.
These built-in templates are configuration skeletons with some default values and options preset.
Creating new configuration templates is also possible.

Step 6. Click OK.
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3.2.2. Main workspace

Most of MC is occupied by the main workspace where you can manage the various components of the
Configuration tree. The majority of configuration tasks are performed here. The contents of this pane depends
on which component you select in the configuration tree.

You can add new administratice components to the host at the bottom part of the main workspace.
If you select a different Host in the Configuration tree, the contents of the main workspace change too.

Tip
The keyboard shortcuts of MC are listed in Appendix B, Keyboard shortcuts in Management Console (p. 403).

3.2.3. Menu & status bars and Preferences

Although most options of the menu bar are available as buttons on other parts of the MC window, there are
some special menu points that have no corresponding button in the main workspace. The buttons are described
in the section which deal with the corresponding MC part where they appear.

3.2.3.1. Procedure - Configuring general MC preferences
Purpose:

To configure general MC preferences, complete the following steps.
Steps:

Step 1. Navigate to Edit > Preferences... and select the General tab.
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ZMC - Preferences x

Preferences

Zorp Class Editor | Zorp Rules
Confirmations

Confirm exit

Confirm commit component

Confirm revert component

Confirm upload component

Actions follow dependent components
Trees

Expand menu tree Expand trees in plugins
Font

Text editor fonk: |Monospace 14 J
Result dialog
[0 scrollto the last line [ Keep results after closing the window
Program status
Auto refresh: |30 =
Display status tooltip
Show: ’1—|T| s
Browser
® System defined
O Custom

Browser path: |
ChangelLog
Edit changelogwhen: O Commit O Quit ® Never

Cancel OK

Figure 3.9. Edit > Preferences... > General - Editing MC preferences

Step 2. Edit confirmation window preferences in the Confirmations section.:

m To display a confirmation window before quitting MC through File > Quit or Ctr1+Q,
select Confirm exit.

m To display a confirmation window before committing & the configuration changes to a
component, select Confirm commit component

m To display a confirmation window before reverting # the configuration changes to a
component, select Confirm revert component

m To display a confirmation window before uploading & the configuration changes to a
component, select Confirm upload component

® Commit and Upload can be combined into a single action, which means that if you want
configuration changes to reach the firewall immediately — and not just the MS database —
you can do it with a single click. To combine Commit and Upload, select Actions follow
dependent components

Step 3. Edit tree-related preferences in the Trees section:
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Step 4.

Step 5.

Step 6.

Step 7.

Step 8.

Step 9.

® Expand menu tree

m Expand trees in plugins

Edit text editor font-specific preferences in the Font section:

To configure the Text editor font of MC, click .. Select the font Family, Style and the font Size and
click OK.

Edit result dialog-specific preferences in the Result dialog section:
m Scroll to the last line
m Keep results after closing the window
The status of the interfaces is automatically updated periodically. To configure the update frequency,

edit the Program status section:
Auto refresh in seconds.

To turn of auto-refresh, deselect Auto refresh.

Edit the length of the delay after status tooltips are displayed when you hover your mouse over a status
led or status icon in the Display status tooltip section:
Enter the value of the delay in Show in seconds.

To turn off status tooltips, deselect Show.

For details on status, see Section 3.3.6, Status indicator icons (p. 41).

Edit browser-specific preferences in the Browser section:

The Proxedo Network Security Suite 1.0 Administrator Guide (p. i) and Proxedo Network Security
Suite 1.0 Reference Guide are automatically installed with MC in HTML format and are accessible
from the Help menu. The guides are opened in the default System defined browser.

To configure a different browser, select Custom and enter in the Browser path field the full path
name of the browser to use.

Y

Edit changelog-specific preferences in the ChangeLog section:

MS now records the history of configuration changes into a log file. The logs include who, when
modified which component of the PNS gateway system. Component restarts and other similar activities
are also logged, and the administrators can add comments to every action to make auditing easier. By
default, MC displays a dialog automatically to comment the changes every time the MS configuration
is modified, or a component is stopped, started, or restarted. The changelogs cannot be modified later.

Tip
The latest version of these guides, as well as additional whitepapers and tutorials are available at the _Documentation Page.

For details on writing changelong comments, see Procedure 3.3.4, Recording and commenting
configuration changes (p. 39).
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To configure when MS automatically opens the New changelog entry window, change Edit changelog
when to:

® Commit if you want to automatically open the New changelog entry window after
committing ® the configuration changes to a component.

B Quit if you want automatically open the New changelog entry window only before quitting
MC through File > Quit or Ctr1+Q.

m Never if you never want to automatically open the New changelog entry window.

3.2.3.2. Procedure - Configuring PNS Class Editor preferences
Purpose:

To configure PNS Class Editor preferences, complete the following steps.

Steps:

Step 1. Navigate to Edit > Preferences... and select the Application-level Gateway Class Editor tab.

@

Figure 3.10. Edit > Preferences... > PNS Class Editor - Editing PNS Class Editor preferences

Step 2. Configure display-related preferences in the Display section:
® To enable syntax highlighting, select Enable syntax highlighting.
m To enable syntax validation by checking braces, select Enable braces check.
m To display line numbers, select Display line numbers.

m To display right margin, select Display right margin. Enter the column number where you
want the right margin line to be displayed in Right margin at column.

Step 3. Configure tabulation in the Tabs section:
m Enter the indentation width in spaces in the Tabs width field.
m For auto-indentation, select Enable auto indentation.

m For smart behavior for Home and End keys, select Smart Home/End behaviour.

3.2.3.3. Procedure - Configuring PNS Rules preferences

Purpose:
To configure PNS Rules preferences, complete the following steps.
Steps:

Step 1. Navigate to Edit > Preferences... and select the Application-level Gateway Rules tab.
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ZMC - Preferences x

Preferences

: Zorp Class Editor | Zorp Rules
Confirmations

Confirm exit

Confirm commit component

Confirm revert component

Confirm upload component

Actions follow dependent components
Trees

Expand menu tree Expand trees in plugins
Font

Text editor fonk: |Monospace 14 J
Result dialog
[0 scrollto the last line [ Keep results after closing the window
Program status
Auto refresh: |30 =
Display status tooltip
Show: ’1—|T| s
Browser
® System defined
O Custom

Browser path: |
ChangelLog
Edit changelogwhen: O Commit O Quit ® Never

Cancel OK

Figure 3.11. Editing MC preferences

Step 2. Configure rule list-related preferences in the Rule list section:
m To display the complete content of a cell as tooltip, select Show full cell content as tooltip.

®m To wrap cell content if it exceeds a certain length, select Wrap cell content to multiple
lines. Define the Maximum number of rows in cell.

3.2.3.4. Procedure - Configuring MS hosts

Purpose:
To add, delete or edit MS hosts, complete the following steps.
Steps:

Step 1. Navigate to Edit > Servers....

Step 2. ® To add a new host, click New. For details on the configuration steps, see Procedure 3.1.1,
Defining a new host and starting MC (p. 17).
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to that new host, but will stay logged in to the host that you are currently configuring. To configure the new

Note
@ MC cannot connect to more than one MS host simultaneously. After adding a new host, MC will not change
host, navigate to File > Relogin... and login to the new host.

m To edit an already existing host, click on the name of the host and click Edit.

m To delete an already existing host, select the name of the host and click Delete.

Warning
A There is no confirmation window after clicking Delete, the host is deleted instantly. Make sure that you only
click Delete if you want to actually delete a host.

Step 3. Click Close.

3.2.3.5. PKI menu

PKI settings are always site-wide and can be configured graphically using the PKI menu only. For more
information on PKI usage under PNS, see Chapter 11, Key and certificate management in PNS (p. 226).

3.2.3.6. Variables menu

To clarify management it is possible to define system variables for MS. These variables all have a scope,
depending on which component is selected in the Configuration tree when they are declared.

Altogether, variables can work in three scopes that correspond to configuration levels in the Configuration
tree: Site, Host and Component.

When referencing variables inside configuration windows, $ characters must precede and follow their names. For example,

Tip
Using variables is especially useful in sophisticated, enterprise PNS environments where complex configurations have to be maintained.
$autobind-ip$.

By using variables it is simpler and error-free to change a value that is present at many different places. Modifying
a corresponding variable results in changed values everywhere they are used.

®

By default there are two host variables defined:

Note
Instead of variables, you are recommended to use links.

m Hostname, and

B autobind-ip.
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3.2.3.6.1. Procedure - Defining variables

Steps:

Step 1. Select a Site, Host or Component in the configuration tree.
Step 2. Navigate to Edit > Variables....

Step 3. To create a new variable, click New.

Step 4. Enter the Name-Value pair in the respective fields.
Step 5. Click Close.

3.2.3.6.2. Procedure - Editing variables

Steps:

Step 1. Select a Host in the configuration tree.

Step 2. Navigate to Edit > Variables....

Step 3. To edit a variable, select the variable and click Edit.
Step 4. Enter the new Name-Value pair in the respective fields.
Step 5. Click Close.

3.2.3.6.3. Procedure - Deleting variables

Steps:

Step 1. Select a Host in the configuration tree.

Step 2. Navigate to Edit > Variables....

Step 3. To delete a variable, select the variable and click Delete.

Warning
A There is no confirmation window after clicking Delete, the variable is deleted instantly. Make sure that you only click Delete
if you want to actually delete a variable.

Step 4. Click Clese.

3.2.3.7. Status bar

The bottom line of MC is called the status bar. When working with configuration components it can be used
to check whether changes have already been Committed or there are Unsaved changes. By checking the status,
you can determine whether what you see on the MC interface is the same as the information currently stored
in the MS configuration database (committed status) or not.
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Committed

Figure 3.12. The Status bar

3.3. Configuration and Configuration management

Most configuration tasks concerning PNS are component-based and even those that are site-wide, such as Zone
manipulation, must be individually uploaded to all firewalls of the given site. Therefore, configuration tasks
can be organized into cycles and most elements of these cycles are the same regardless of the component that
is configured. In fact, most of the configuration is repetitive and therefore can easily be procedurized.

In this section, after a brief overview of the most typical steps, the configuration process and the tools (buttons)
that are used to perform each task are presented.

3.3.1. Configuration process

When you login to MS through MC, first an SSL encrypted channel is built, then firewall configurations currently
stored in the MS database are downloaded into MC. When you finish doing configuration changes they are
committed back into the MS database. At this point no changes are made to the firewall(s); only the database
on the MS host is modified. It takes a separate action, an upload issued to actually propagate changes from the
database down to the firewall(s). With this upload action the configuration changes get integrated into the
configuration files on the PNS machine(s). For final activation, a reload or restart (depending on the situation
and the service being modified) is needed to activate the changes.

A complete configuration cycle consists of the following steps.

3.3.1.1. Procedure - Configuring PNS - the general process

Step 1. Select the component that you want to configure in the Configuration tree.
Step 2. Perform the actual configuration changes on the component. For details, see the relevant chapters.

Step 3. Commit @& changes to the XML database of MS. Otherwise, the changes are lost when you navigate
to another component.
Write a brief summary about the changes into the Changelog. For details, see Procedure 3.3.4,
Recording and commenting configuration changes (p. 39).

Step 4. To activate the changes, upload & them to the affected PNS firewall hosts from the MS database. MS
converts the changes to the proper configuration file format and sends them to the transfer agents on
the firewall nodes. The changes are applied on the firewall nodes.

Step 5. Reload the altered configurations on the firewalls, or restart the corresponding services.

Note
@ Not all of these steps are performed in each configuration cycle. Service reloads or restarts are typically postponed as long as possible
and are likely to be performed only after all configuration tasks with the various service components are finished.

www.balasys.hu 32



Configuration buttons e

3.3.2. Configuration buttons

Most administration commands for the configuration tasks can be issued from either the menus or the buttons
in the Button bar. The number of buttons visible varies based on the component that you have selected in the
Configuration tree.

2 E| I a-5-&-@- & B

Figure 3.13. The Button bar

3.3.2.1. Commit and Revert
The @ Commit changes and 1 Revert changes buttons are always visible, at the minimum.

@ Commit is used when you finish a (set of) configuration changes and want zo save these changes to the XML
database of MS.

# Revert serves the opposite purpose: before committing changes to the MS database, it is possible to clear,
to undo them in MC.

Note
@ It is very important to remember that Revert is limited to MC, it cannot clear configuration changes that are already committed to the
MS database. Those changes can be undone by performing a new round of changes in MC and then committing these changes again.

Both Commit and Revert are component—focused controls. This means that before you select another component
from the Configuration tree, you must commit the changes in the current component, otherwise they are lost.
In such cases, MC displays the following warning:

i Question x

Do you want to commit changes
before leaving the component?

X cancel @no ‘ @D yes ‘

Figure 3.14. Warning: commit changes before leaving the component

3.3.2.2. Upload current configuration

& Upload is used to upload the configuration changes committed to the configuration database on the MS Host
further to the corresponding PNS firewall(s).

immediately — and not just the MS database — you can do it with a single click. To combine Commit and Upload, navigate to View >

Tip
Commit and Upload can be combined into a single action, which means that if you want configuration changes to reach the firewall
Preferences and select Actions follow dependent components.
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3.3.2.3. Control service

@ Under Control service, you can Reload or Restart services so that they re-read the new configuration files
that are already on the corresponding PNS firewalls after a successful Commit / Upload cycle.

Restarting or Reloading the given service depends on the type of service (some cannot be reloaded, only
restarted) and the intended outcome.

After clicking Control service, the following actions are available:

What do you want to do with these services?

‘Apply action For dependent components:

Cancel ‘ Start Stop Restark Reload Status

Figure 3.15. The service control dialog

Note
@ ‘ Besides Restart and Reload, there are also Start and Stop functions available here to start or stop services.

3.3.2.4. View and Check current configuration

View current configuration and ¥ Check current configuration are both used to retrieve information
on the current state of the PNS firewall(s).

View current configuration displays the configurations of the component selected in the Configuration tree
on the selected host. This information comes from the MS configuration database, which is not necessarily the
same as the actual settings on the selected host — when changes are already committed, but not yet uploaded.
For example, if you select the MS_Host > Networking component and then click View current configuration,
you will see the following:
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Zorp Management Console - admin@localhost

File Edit Wiew Configuration Management PKI Monitoring Help

Configuration | @I [E E [ @ ﬁl @ [ B

- [] loefault_Corporate
- [l zms_Host

@Management agents Name

MNetworls interface configuration

Type Additional info [Connects |Description

[E]Management server

[E] Metworking

[E]Packet filter
@Zcrp

<= [l Firewall_Host

[E]networking Duew | ﬁgeletel Rename | Control Vljj

EManagement agents ~ ~ e

. i - = . 3
< [l Firewsll_Cluster Famnily IIPv4 | ¥ Activate at boot time
[E]networking Type specific parameters

ﬁManagement agents

[~ Alias of | L' [~ VLAN | ﬂ

Connects I | [¥ Spoof protection

Description I |

Activation |Script |

-l

Interfaces | Routing | Naming | Resolverl

Commited

Figure 3.16. Networking configuration on MS_Host

It is a file-by-file listing of the active configuration on the selected host. Note that it is not necessarily the same
configuration that is stored in the MS database: after a commit but prior to an upload event they can differ
significantly. To query this difference, click Check current configuration. Using the Linux diff utility by
default, it compares configurations stored in the MS database with the configurations currently active on the
selected host.
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Check configuration - o x

File Edit

Mon Jul 29 23:16:21 2019

Component 'Management agents' on host 'ZMS':
File '/etc/zmsagent.conf': done
Checksums differ

Host Database
mode 00644 00640
size 653 926 |
inode 153530 NA
ctime Thu May 16 11:29:13 2019 NA
mtime Thu May 16 11:29:13 2019 NA

F@ -1,9 +1,13 @@

Save | Find | Clear | Dock | Close |

Figure 3.17. Checking current configurations

The differences are marked in red, otherwise you see the normal output of diff, with + and — signs designating
data from the host and from the database, respectively. The diff command can be replaced with another utility
of your choice under the Management Server component. For details, see Chapter 13, Advanced MS and
Agent configuration (p. 275).

3.3.2.5. Files

Configuration files:

@ Files provides further information and configuration options of the files and attributes described in the output
window of Check current configuration and the diff command.

Files serves two purposes.: It provides vital information about which configuration files a component (of the
Configuration tree) uses and gives chance to modify the properties of the listed files.

For example, in case of the Networking component, the list of used files is the following.
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¥ ZMC - Files x

Files

Configuration files

Jetcjhostname

Jetcjhosts root  root 0644
Jetcjmailname reot  root 0644
Jetc/networkfinterfaces  root  root 0644
Jetcinetwork/static-routes root  root 0644
[etejnetworks root  root 0644

File settings

Filename Ijs(cjhuslnams

Mode: |usaa owner: Imﬂt Group: Imﬂt

Consider different if these properties change

F Mode 7 owner [ Group F checksum
¥ size ¥ Modification time ¥ status modification time ¥ |node
Check All Uncheck All

Postprocess script

Postprocess command: | Snexecute
Configuration | Scripts
X cancel Fok

Figure 3.18. Files used by the Networking component

Apart from the name and location of files, you can retrieve information about owner, owner group, access rights
and file type parameters. The Manage column is very important and has a corresponding checkbox immediately
below the file listing: this can be used to control what files MS manipulates on the host machine, if needed.

Note
@ It is not recommended to take files out of the authority of MS, because it can severely limit the effectiveness of MS—based administration.
However, it is possible to do it, if you deselect the checkbox under the Manage column.

File settings:

To modify the properties of a file, click on the file in the list. The following subwindow opens.
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| E3
Files
Configuration files
Filename - ‘-:wne\" Group | Mode ‘ Mﬁnaqe‘ -
fetcihosts root  root 0644
Jete/mailname oot 0644
Jetc/netw oot 0644
Jetcjnetw ot 0644
fetcjnetworks { 0644
. —— ﬂ
ile settings
Filename Ijs(cjhuslnams
Mode: 0644 owner: |root Group: |root
Consider different if these properties change
7 Mode 7 owner I+ Group 7 checksum
7 gize 7 Modification time ¥ status modification time I Inode
Check All Uncheck All
Postprocess script
Pastprocess command: | Saexecute
Configuration | Scripts
X cancel Dok

Figure 3.19. Changing file properties

Warning
A There must be a solid reason for changing these properties and you must be prepared for the possible consequences of such actions. A
good understanding of Linux is recommended before making changes in file properties.
Consider different if these properties change:

The third part of the window is for configuring the work of the comparison utility, which is diff by default.
You can define what file properties you are interested in when checking for changes.

[ | x
Files
Configuration files
Filename ~ | owner ‘ Gloup|Mode ‘ Manage‘ ‘ -
Jetcfhosts 0644
Jetc/mailname 0644
etc/network/interfaces 0644
0644
fetoinetw 0644
: . Taeanis j
File settings
Fillenamme: ‘_‘etc_‘\'\c‘st\'\a\'\'\e
oot Group: [root
¥ Mode I Owner ¥ Group I Checksum
7 size 7 Modification time 7 status modification time 7 Inode
checkal | uncheckal |
Postprocess script
Postprocess command: | Smexecute
Configuration | Scripts
¥ cancel Hax

Figure 3.20. Configuring diff conditions

Tip
Checking for configuration file differences is beneficial from a security aspect too: it is an additional tool for making sure nobody has
altered critical files on the firewall.

www.balasys.hu 38



Committing related components e

Postprocess script:

At the bottom of the Configuration tab, you can specify a postprocess command that is run after the
corresponding configuration file is uploaded to the firewall host. Some services rely heavily on this option. For
example, Postfix that runs / usr/sbin/postmap %f as a postprocess command to transport virtual domains
and set various access restrictions are properly.

Scripts tab:

Configuration files under Linux are re-read during service reloads or restarts. These actions are performed by
running the corresponding scripts exclusively from the /etc/init.d directory. The Scripts tab of the Files
window provides an interface where you can check starting scripts and alter and fine-tune them with special
Pre upload and Post upload commands. With simple components, such as Networking, these options
are rarely used, but in some cases might prove especially useful.

Some components, for example, Text Editor, can manage configuration files that are automatically reloaded.
They cannot be restarted after a Commit. To set the status icon of these components to Running,
selectConfiguration automatically runs on the Scripts tab.

3.3.3. Commiitting related components

Some components are related to or dependent upon each other, meaning that modifying one modifies the other
too. If modifying a component affects another component, the status of this related component changes to
Invalidated in the Configuration tree. MC automatically handles related components and all actions (Commit,
Reload, and so on). Just select the Apply action for the dependent components checkbox in the confirmation
dialog of the action.

When reloading or restarting a component related to the Packet Filter, the skeleton of the Packet Filter is
automatically regenerated. See Appendix A, Packet Filtering (p. 384) for details on generating skeletons.

3.3.4. Procedure - Recording and commenting configuration changes

Purpose:

MS now records the history of configuration changes into a log file. The logs include who, when modified
which component of the PNS gateway system. Component restarts and other similar activities are also logged,
and the administrators can add comments to every action to make auditing easier. By default, MC displays a
dialog automatically to comment the changes every time the MS configuration is modified, or a component is
stopped, started, or restarted. The changelogs cannot be modified later.

The behavior of the changelog window can be configured in Edit > Preferences > General. For details, see
Procedure 3.2.3.1, Configuring general MC preferences (p. 25).

To review the existing changelog entries, navigate to Management > Changelogs. The window contains two
filter bars: the Changelog entries filters for changelog entries, the Components filters inside a single changelog
entry, if it contains too many actions. For details, see Section 3.3.10, Filtering list entries (p. 47).

Steps:
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Step 1. Optional step: If the New changelog entry window is not configured to display automatically after
committing or quitting, you can add a new changelog entry manually. To do this, navigate to Edit >
Changelog....

Step 2. Review the details of the changelog entry. Every changelog entry includes the following information:
m Date : The date when the action was performed.
® Administrator: The MC username of the administrator who performed the action.
m Host: The PNS Hosts affected by the action.
m Component: The MC components affected by the action.

m Action: The type of change that was performed.

Step 3. Enter the following:
® Summary: Enter a short summary of the changes.

m Description: Enter a detailed description of the changes.

Step 4. To save the changelog entry, click Send.

3.3.5. Multiple access and lock management

Most firewalls are administered by a group of administrators and not just by a single individual. In a PNS system
each administrator can have their own MC console and administrators can be separated geographically. Regardless
of their locations they administer the same set of PNS firewalls through a single MS host machine. Therefore,
to avoid configuration errors caused by more than one administrator working with the same component
simultaneously, a configuration lock mechanism ensures that a component's configuration can only be modified
by a single administrator at a given time. Locking is per component: as soon as you change, for example, a
setting in a component, the status bar displays the following string: Unsaved changes and that component is
locked for you. Active locks can be viewed at Management > Locks:

Lock management

Owner | Active locks Information

Other Default_Corporate/ZMS_Host/Networking admin@localhost

Figure 3.21. Management > Locks - Viewing active locks
The Owner column can take two values:

m Other
meaning that someone else is working with the given component
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m Self
indicating your own locks.

Lock placement is automatic. The first administrator that starts modifying a component's settings gets the lock.
In the Active locks column the exact name of the locked component (Site/Host/Component) is displayed.
Locks are cooperative, meaning that any administrator can release any other administrator's locks by selecting
the desired component in the Lock management window and then clicking Release. The administrator whose
lock is released this way is immediately notified in a warning dialog.

Note
@ Because this is a rather radical interaction, concurrent administrators should discuss lock situations before possibly devastating each
other's work.

It is not possible to edit a component that is already locked by someone else, because a warning dialog
immediately appears upon trying to change anything inside the given component:

* Question

This component is locked by somebody else
You can either wait for the lock to become free or you can view the configuration in read-only mode

Do you want to wait?

Figure 3.22. Question on a locked component

As soon as the locking administrator commits the changes, the lock is released and the information box above
disappears.

A component can be locked by multiple administrators at once; there is a lock queue mechanism implemented
in MS, meaning administrators can preregister for future locks while the current lock is active. Since there is
no hierarchy among PNS administrators from MS's aspect and anyone can release anyone else's locks, it is
crucial for administrators to cooperate well and respect each other's work — and each other's locks.

3.3.6. Status indicator icons

The Configuration tree in MC displays various indicators to provide a quick overview about the status of the
managed sites, hosts, and components. Site and Host-level status is indicated by leds, while icons are used to
display Component-level status information.

Configuration

- | Default_corporate

~ [llzMms_Host
[ElManagement agents
[E]Management server
[Elnetworking

~ [Firewall_Host
[ElNetworking
[Management agents

~ [MlFirewall_Cluster
[Elnetworking
[EManagement agents

Figure 3.23. Status indicator icons and leds

Hovering the mouse cursor over a led or icon displays a tooltip with the full description of the status.
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Tip
Status tooltips are displayed for the period configured in Edit > Preferences (for details, see Section 3.2.3, Menu & status bars and
Preferences (p. 25)). It is also possible to disable the tooltips altogether.

Configuration :| 2 A ¥~ E

Host management

Management | Host states
Management ] Tansfer connection: connected

I ™onitor connection: disconnected

] Kkey distribution: all keys are syncronized
[| configuration: committed

Systern loggirf Configuration states on components
SSH Invalidated: 0
DNS Committed: 9
Date and tim4 Uploaded: 0
Running: 4

Mail transport

Note
@ Similar leds are also used throughout MC to display information about the state of various objects, for example, network interfaces, PNS
instances, NTP servers, Heartbeat resources, and so on. These are described in their respective sections.

3.3.6.1. Site-level indicators

The Site-level led displays the validity of the certificates used by the PKI system of the Site (for details, see
Chapter 11, Key and certificate management in PNS (p. 226)). The led has the following three different states:
B Greeni: All certificates are valid.
m Yellow 1: One or more certificate will expire soon.

B Red i: One or more certificate has expired.

®

Note
Expired or soon-to-expire certificates are displayed in bold on in the PKI management tabs.

3.3.6.2. Host and cluster-level indicators
The status of the Host is displayed by four different leds. From left to right, these are the following:

®m Transfer and Monitor connection

m Key distribution
® Configuration
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All four leds can be Blue, 1, indicating a partial or unknown status: this appears when the status of the nodes
of a cluster differs from each other. For example, the transfer agent led is blue if the agent could establish the
connection to only one of the nodes, or if the state of the agent is unknown.

Hovering the mouse pointer above the leds displays a tooltip containing detailed information of the leds,
including a summary of the committed/uploaded/and so on components.

Transfer and Monitor connection
These leds indicate the status of the Transfer and Monitoring agent connections, respectively.

B Green I: the agent is connected to the host.
m Yellow i: a connection attempt is in progress.
m Red i: the agent is disconnected.

The management connection leds display unknown status if the given connection is not enabled on the host
and is in the disconnected state.

Key distribution
This led indicates the availability of the required certificates and keys on the Host.

® Green I: normal state.

m Red i the certificates have been modified (for example, refreshed), but the new certificates have not
been distributed yet to the Host.

Warning
A This status led is especially important, because if the certificates are not distributed properly, MS will not be able to communicate with
the Host. For details on distributing certificates, see Section 11.3.5.2, Distribution of certificates (p. 236).

Configuration

The Component led indicates the worst state of the components available on the host. That is, if all components
are normal, but one is not committed, the led will be in the unsaved state.

3.3.6.3. Component-level status indicators

The status of each component on a host (or cluster) is indicated by a single icon. The components can have the
following state:

Modified m: The component has been modified, but the changes have not been commited to the MS database
yet.

Invalidated @: This status indicates that the component has to be updated because of a modification that was
performed in another component. For example, committing modifications of the Application-level Gateway
component invalidates the Packet filter component, because the packet filtering rules have to be regenerated.
Invalidated components automatically become modified when they are selected from the Configuration tree.
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Committed @: The modifications of the component have been saved to the MS database, but the new configuration
has not been uploaded to the host. For details, see Section 3.3.2.1, Commit and Revert (p. 33).

Uploaded m: The new configuration has been successfully uploaded to the host. For details, see Section 3.3.2.2,
Upload current configuration (p. 33).

Running @: The uploaded configuration has been successfully activated on the host (for example, the
service/instance has been restarted/reloaded, and so on). For details, see Section 3.3.2.3, Control service (p. 34).

Partial @ m: These states appear when the status of the nodes in a cluster differs from each other. For example,
the partial uploaded icon indicates that the new configuration was not successfully uploaded to all nodes.

Locked: The component is in use (and has been modified) by another user (for details, see Section 3.3.5, Multiple
access and lock management (p. 40)). This status is indicated by the above icons having grayed colors, for
example, @,

Occassionally it might be required to manually modify the status of a component. This can be done from the
Configuration menu through the Mark as Committed and Mark as Running menu items.

®

3.3.7. Copyl/Paste and Multiple select in MC

Note
Only uploaded components can be marked as running.

MC provides two graphical aids that can help administration when parts of a host's configuration settings have
to be recreated on another host.

m Copy-paste
Elements of the configuration (for example, network interfaces, proxies, policies, and so on) can be
copied and then pasted to another host. This method can also duplicate an element on the same host.
All settings of the element are copied to the target host.

To copy a configuration element, select the file content for example, right-click and select Copy.

To paste a configuration element, right-click where you want to paste the element and select Paste.

A

®m Multiple select

Warning
Make sure to verify the settings of the pasted element, especially the parameters that used links.

 To select consecutive multiple components, select the first component, press Shift and click the
last component.

* To select multiple components that are not consecutive, select the first component, press Ctrl and
click the next component that you want to select.

If you select multiple components, after right-clicking, the View, Check, Upload and Control

operations are permitted. After clicking one of the options, all configuration files are batch-processed.
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Additionally, a program, for example an archiving script, can be run on the configuration files of all
selected components. To do this, either select the command from the drop-down menu or enter the
command in the Run program field and click Execute.

®

Note
Multiple selected components can also be copy-pasted.

& Zorp Management Console - admin@localhost =X

Fle Edit wiew Configuration Management PKI Monitering Help ‘

criwrtin | B | @ |
~ [Default_corporate -
+ [@JzMs_Host Multiple component management
ez | v| Boare
Networking
[ElPacket filter
Ezorp
~ [lFirewall_Host

[Elnetworking
[EManagement agents

= [MlFirewall_Cluster
[Elnetworking
[ElManagement agents

[commited |

Figure 3.24. Selecting multiple components in the Configuration tree

3.3.8. Links and variables
You have two options to refer to components involved in network configurations.

m Create links
m Use variables

If you use links, you can manually enter IP addresses or select the link target from a drop-down menu. Using
links has the advantage that future changes in the network setup does not influence the operability of the
connection.

You can delete the existing links with the Unlink and Unlink as value options.

m Unlink ceases the link connection totally, meaning that the link field is left empty.

®m Unlink as value deletes the link but leaves the target IP address in the field which will then behave
as a manually added address.

You can refer to components with variables. By using variables you change values appearing in several places
at once. If you modify a variable, all corresponding values are changed. Variables are denoted with $ characters
preceding and following their names.
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— Example 3.1. Referring to components with variables
% The following is an example for a variable:
| w—

$autobind-ip$

3.3.9. Disabling rules and objects

During the management and maintenance of the firewall host it is often useful to be able to temporarily turn
off certain rules, policies, and so on. In PNS this feature is implemented through the Disable/Enable options
of the local menus. To display the local menu of a rule or object, right-clicking on the object. For example, a
packet filter rule that is only rarely used can be simply disabled when it is not required, to be enabled again
when it is required. Disabled rules and objects are generated into the configuration file as comments with the
# prefix.

Disabled objects can be edited, modified similarly to any other object. However, their validity (for example,
the required parameters are filled, their name is unique, and so on) is checked only when they are enabled again.

The following objects can be disabled in the various MC components:
Host:

® Quarantine cleanup rules
Packet filter:
® Rules

m Groups
m Tables

® Chains

Disabling a group automatically disables its childrens as well.

®

Application-level Gateway:

Note
Generated rules do not remain disabled after skeleton generation.

m Instances
® Rules

m Policies (including matchers)

Networking:
m Interfaces

B Routes

Date and time:

m NTP time servers
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Content vectoring:

B Routers and rule groups
AS:

® Routers

Heartbeat:

® Resources
IPSec VPN:

m Connections

Mail transport:

m Listen interfaces

m Transport maps
® Virtual maps
m Sender address restrictions

m Recipient address restrictions

3.3.10. Filtering list entries

MC displays information in several places as tables of entries having various parameters or meta-information.
Such filter windows are used to display firewall rules, Application-level Gateway logs, active connections, and
so on. The common properties and handling of these tables is summarized in this section.

Bl ZMC-loguiewer B
Log viewer
Wed 29-3-2006 06:26:00 - Thu 30-3-2006 06:28:00
Program contains | | [ 85| % Edit bookmarks
T\mes(ampl Hustl Prugraml P\dl Message =
29 Follow| BDJumpto| [4 Pra!\uusl M Nextl @gtapl @Egpurtl [0/0]

Figure 3.25. A filter window
Filter windows consist of three main parts:

m Filter bar

m Table displaying the entries

www.balasys.hu 47



Filtering list entries e

m Command bar to perform various actions on the selected entries
The actions available in the command bar are described at the documentation of the actual component using
the filter window (for example, Log viewer).
Each entry of the table consist of a single row, with the various parameters displayed in labeled columns.
m To sort the entries, click on the column headers.
m To modify the order of the columns, drag the column header to its desired place.
m To hide a single column, right-click on the column header and click Hide This Column.

m To configure the columns to be displayed, right-click on the column header and click Set columns...,
select a column and move it with the arrow. Click OK.

To filter the entries, use the filter bar located above the table. The Filter type specifies the column to search
for the expression (string or regular expression) that you type in the field. To search, click Filter now. To
restore the full list, click Clear. To create custom filter expressions, selecting the Advanced option as Filter
type. The filter expressions can also be combined using the logical AND (if all criteria are met) and OR (if any

criteria are met) operations. You can run custom filters once (click Ok), or you can bookmark them for repeated
use (click Save).

Tip

To display the Advanced filter editor dialog with the latest advanced filter, click ....

A MC.Fiteredtor
Filter editor

Name: [

4 Add Logic [if all criteria are met |+ |
Timestamp |+ | after ~|] = |
Timestamp |+ | after ~|] -

O colour matching g

[ save ‘ xgance\| ok ‘

Figure 3.26. Advanced filtering

Saved filters are also displayed in the Filter type combobox. To manage saved filters (delete, rename and edit),
click Edit bookmarks.
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Boolimarlc editor

Name =

[l

@oelete| [Fedt | pename |

X Close

Figure 3.27. Editing bookmarks

In some cases (for example, in the Log viewer), you can configure advanced filters to highlight the entries
matching the filter expression. To configure highlighting, select Color matching and set the color of the
highlighting.

Tip

By assigning different colors to different bookmarked filters, the important elements of the table can be highlighted in several colors.

3.4. Viewing PNS logs

Logs provides an interface for inspecting the log messages collected on a host. To view the logs of a host, select
the Host and click 3 View log.

Tip
PNS can also create reports about the transferred traffic. For details, see Section 6.9, Traffic reports (p. 171).

The log viewer interface consists of a filter bar to select the messages to be displayed a list of the actual log
entries (including meta-information such as timestamp, and so on), and a command bar.
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% ZMC - Log viewer —ox
Log viewer

Wed 29-3-2006 06:26:00 - Thu 30-3-2006 06:28:00
Program contains | || &5 | %s| Edit bookmarks
T\mss(amp‘ Hnst‘ Prugram‘ pid | Message =
ggpuuuw| 8D Jump tu‘ K Premuus‘ M Next‘ gitop‘ mEgpurt‘ [0/0]

Figure 3.28. Viewing logs
The following information is displayed about the messages:

® Timestamp: The exact date when the message was received.

m Host: The host sending the message.

m Program: The application sending the message (for example, cron, zms-engine, and so on).
m Pid: The Process ID of the application sending the message.

m Message: The message itself.

The Log viewer window is a Filter window. Therefore, you can use various simple and advanced filtering
expressions to display only the required information. For details on the use and capabilities of Filter windows,
see Section 3.3.10, Filtering list entries (p. 47).

3.4.1. The command bar of the log viewer

The command bar offers various operations to display and export the logs of the host. The following operations
are available:

m Follow: Start the follow mode and monitor the log messages real-time. The list is updated every
second.

®m Jump to: Select a time interval and display the log messages received within this interval. To specify
an interval, enter its Start date and Start time, and either both End date and End time, or the
Interval length. Enter the name of the log file in the Log file field.
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Jump to log interval

Interval

Start date: [wed 29-3-2006

Start time [0s:26:00 hh:mm:ss

End date: [Thu 30-3-2006

End time: [0s:28:00 hh:mm:ss

interval length: |24:nz:nn hhimm:ss

Log file

Log file: Imsssages

P

Figure 3.29. Selecting the log interval to be displayed

m Previous: Display the log messages of the previous period (using the same interval length).
m Next: Display the log messages of the next period (using the same interval length).
m Stop: Stop the Follow mode.

m Export: Export the currently displayed log messages into a file on the local machine that is running
MC, using either plain text or CSV file format.

m Type of messages: The rightmost combobox selects the type of messages that are displayed (for
example, zms , packet filter, and so on).
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Chapter 4. Registering new hosts

PNS and MS can be used in several network scenarios. In the simplest case there is only a single firewall host
having both PNS and MS services installed. In this case the communication between MS and the PNS
management agents takes place locally, using Unix domain sockets and it does not require network
communication setup. However, when the two functions, that is, firewalling and management, are separated
and installed on two different machines, the initial communication channel between the two requires manual
setup. After successful setup all further communication is initiated automatically without manual interaction.
This channel setup is a one-time action, therefore it must be configured separately for each new PNS firewall
under the authority of a MS host. This process is called bootstrapping and can be performed similarly to running
a wizard. By the end of the bootstrapping process the new host is added to the host configuration database of
the MS host machine.

The connection between MS and PNS can be established in the following ways.

m Using bootstrap
® Manually through the Recovery Connection function
m Completely manually

Bootstrapping a PNS host is one of the most simple methods. Bootstrapping is similar to running a wizard, that
is, answering questions and allowing the wizard to carry out the necessary configurations. Alternatively, the
connection can be established manually. This method may especially be needed in troubleshooting scenarios
with the help of the Recovery Connection button. Hosts can be added on a completely manual way, by selecting
a site and then clicking Add in the main workspace. For more details, see the PNS Reference Guide.

4.1. Procedure - Bootstrap a new host
Purpose:

To bootsgrap a new host, complete the following steps.
Steps:

Step 1. Select the desired site in the configuration tree.

Step 2. Click Bootstrap at the bottom of the screen. This will start the wizard.
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Figure 4.1. Bootstrapping a new host

Note
Alternatively, to register a host manually, click New next to Bootstrap.

Step 3. Select a host template.
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Select host template to create new host from

Description = |

Cluster minimal template

Host default template

Host minimal template

Cancel | Back | Forward |

Figure 4.2. Selecting a host template

The default templates are the following. New templates can be created later.

® Cluster minimal template
To configure clustered solutions.

m Host default template
To add the NTP, Application-level Gateway and Packet filter components automatically
to the Configuration tree under the name of the newly added host.

For details, see:

» NTP: Chapter 9, Native services (p. 197)
+ Application-level Gateway: Chapter 6, Managing network traffic with PNS (p. 82)
* Packet filter: Appendix A, Packet Filtering (p. 384)

® Host minimal template
To add only the two default components: Management agents and Networking.

It is recommended to select the Host default template because it alredy has some components
pre-configured.

Tip
If you work with several PNS hosts it can be useful to create predefined templates, to save repetitive work. For details on
creating templates manually, see Chapter 6, Managing network traffic with PNS (p. 82).
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Step 4. Enter the details of the new host.

r -

ZMC - Bootstrap new host ®

Fill required template parameters

Host variables

[«

Host name |examplehostname

Component variables

<

Networking name |Networking

Component variables

L«

Management agents name |Management agents

Component variables

Date and time name |Date and time

KNEY

NTP Server |

Component variables

[«

Packet filter name |Packet filter

Component variables

Zorp name |Zorp

[«

Cancel Forward ‘

Figure 4.3. Parameters of the new host
Host name: the name of your PNS firewall.
Networking name: The name of the Networking component.
Management agents name: The name of the Management agents component.
Date and time name: The name of the Date and time component.
Host name: The name of the Host component.

NTP Server: Specify a time server that PNS synchronizes its system time with. Usually, but not
necessarily it is an external time source. For the up-to-date list of publicly available time servers, see
http://support.ntp.org/bin/view/Servers/WebHome. For more information on NTP, see Chapter 9,
Native services (p. 197).

Packet filter name: The name of the Packet filter component.

Application-level Gateway name: The name of the Application-level Gateway component.

Step 5. Enter the IP address and configuration port number of the Transfer agent.
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Step 6.

Enter management IP address of new host

1P address [1.2.3.4

Port [1311

X cancel ‘ <@ Back ‘ & Forward

Figure 4.4. Entering the management IP address of the host

Before you start, discover which network interface and IP address is reachable from your network
location. Firewalls almost always have more than one of these. Ensure that the IP address you type in
is reachable from your location and that packets will find their way back from the firewall. In other
words, make sure that all routing information is correctly configured.

You can configure other interfaces of PNS to be reachable for configuration purposes later.

Step a. Enter the IP address.
Refer to the Firewall's installation documentation for the IP address information.

Step b. Leave the Port field default (1311.

Create a certificate for SSL. communication establishment
Firewalls are administered from a protected, inside interface and while this method is highly
recommended, it is not necessarily required. All the configuration traffic is encrypted, using SSL.

The administrative connection is encrypted using SSL, which requires a certificate, especially the
public key it contains. This certificate and the private key used for encryption/decryption are sent to
the Management agent on the firewall node that uses it to encrypt the session key it generates. For
more information on SSI. communication establishment, see Chapter 11, Key and certificate
management in PNS (p. 226).

Enter the parameters of the certificate and it will be generated automatically.
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Generate certificate for Management agents

(O Use an existing certificate

Certificates

(® Create a new certificate

Unique name |examplehostname

Subject
Country |US State |
Locality |NewYork Organization |Example Inc.
Org. Unit |Documentation Dept| Common Name |examplehostname

Algorithm RSA

Digest SHA256 v
Bits [2048 hd
Valid after |Sat 03-08-2019 J Length |365 days

valid before sun 02-08-2020 -

Cancel ‘ Back ‘ Forward |

Figure 4.5. Creating a certificate for SSL communication establishment

Step a. To Create a new certificate, enter a name for the certificate in the Unique name field.
Alternatively, to Use an existing certificate, browse for a certificate from Certificates.
The following steps describe the details of creating a new certificate.

string length and restricted character issues. However, it is recommended to enter a name that will later
— when there are more certificates in use in your system — uniquely and easily identify this certificate

Tip
@ There are no particular requirements for the Unique name and Common Name fields other than trivial
as the one used for establishing agent communication.

Step b. In the Country field, enter the two-character country code of the country where PNS
is located. For example, to refer to the United States, enter US.

Step c. Optional step: In the State field, enter the state where PNS is located, if applicable.
For example, California.

Step d. In the Locality field, enter the name of the city where PNS is located. For example,
New York.

Step e. In the Organization field, enter the name of the company that owns PNS. For example,
Example Inc..

Step f. In the Org. Unit field, enter the department of the company that administers PNS. For
example, IT Security.

Step g. Enter a Common Name that describes you or your subdivision.
Alternatively, you can use the default value: the name of your PNS firewall node.
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Step h. Configure the RSA algorithm. Select whether to use SHA-256 or SHA-512 Digest.
Select the asymmetric key length from the Bits list.

®

Step i. Configure the validity range of the certificate.

Note
The U.S. National Institute for Standards and Technology (NIST) recommends 2048-bit keys for RSA.

To select the start date from the Valid after field, click ..

To configure the validity range, either select the end date from the Valid before field

by clicking ! or enter the validity Length in days and press Enter.

Step 7. Enter MS Agent CA password.

Manually entered passwords protect private keys against possible unauthorized access. Even if an
attacker has read access to your hosts, your private keys cannot be stolen (read). These passwords are
used to encrypt the private keys and therefore they are never stored in unencrypted format at all.
Certificates are issued by Certificate Authorities (CA) and it is actually the CA's private key that
requires this protection. The certificate used by the Management agents are issued by the MS_Agent_CA.
You have to enter the password for this CA that you defined for this purpose when installing MS
service. See also Chapter 11, Key and certificate management in PNS (p. 226).

Note
@ To generage a strong password, it is recommended to use a password generator.

Tip
Take detailed logs of the installation process, including the bootstraps where all these passwords are recorded.
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F] ZMC - Bootstrap new host 3
Select issuer and validator CA
Issuer CA [zMs_agent_ca ﬂ
Password |
Engine validator CA group [ZMS_Engine_CA j

X cancel ‘ <@ Back ‘ % Forward

Figure 4.6. Entering MS Agent CA password

Step 8. Enter the One-Time Password.

The one-time password is the one that you have entered during the installation of zms-transfer-agent
on the PNS host. It is a one-time operation: to establish an SSL channel between the Management
agents of PNS and the MS host, certificates are required. Yet there are no certificates to use, therefore
you have to provide the zms-transfer-agent on PNS a certificate to use for communication channel
buildup purposes. This password is used to establish a preliminary encrypted communication channel
between PNS and the MS host, where the certificate can be sent. All communication among the parties
is performed using SSL.

Enter the one-time password

password [Feee]

X cancel ‘ <@ Back ‘ & Forward

Figure 4.7. Entering the One-Time Password

Step 9. Click the final OK button if all password phases were successful to build up the connection.
The displayed logs provide information about the steps the wizard takes in the background. To save
the output for later analysis if needed (either by you or support personnel), click Save.

®

Note
If anything goes wrong the wizard takes you back to the window you made a mistake in, so that you can correct it.
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After the bootstrap process has finished successfully, the new host is ready to be configured.

4.2. Reconnecting to a host

When you start up MC and select a host in the Configuration tree, the connection with the host is automatically
established. If, for some reason it breaks, you have to reconnect the host manually.

4.2.1. Procedure - Reconnecting MS to a host
Step 1. Navigate to Management > Connections....

F] ZMC - Manage connections x
Manage connections

iConnection | Tansfer mode ‘Transfer state ‘Mumtur mode ‘Mum(ur state ‘Lasl result ‘ =

~ Default_Corporate
ZMS_Host local connected disable disconnected
Firewall_Host active connected disable disconnected

- Firewall_Cluster
Master active connected disable disconnected
Slave active connected disable disconnected

Transferagent:  Connect Disconnect Monitor agent:  Connect Disconnect
X Close

Figure 4.8. Managing connections manually

This window accurately shows that it is not the PNS host that directly communicates with MS, but the
Management agent installed on it.

Agents are responsible for reporting firewall configuration and related information to the MS and are
also responsible for accepting and executing configuration commands. Communication between the
Transfer Agent and MS uses TCP port 1311. The Transfer Agent must be installed on all firewall
nodes to be managed with MS. By default, MS establishes the communication channel with the agents,
but the agents can also be configured to start the communication if required.

Step 2. Connect and/or disconnect the appropriate agents with the corresponding buttons.
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Chapter 5. Networking, routing, and name
resolution

MS is a complex central management facility for PNS firewalls. Besides firewall-centric configuration settings,
such as firewall policies, packet filter rules, it allows for the configuration of several basic parts of the operating
system. In fact, one of the design goals of MS was to eliminate the need for command-line configuration of the
operating system and PNS as much as possible. Therefore tools are provided to perform basic, operating
system—level configuration tasks.

The Networking component that is present by default for each host in the Configuration tree serves this
purpose by providing access to all the relevant network-related configuration areas of the host's operating
system. The possible settings in the Networking component are mostly related to ordinary network configuration
issues and there are hardly any variables directly related to firewalling functions.

The main window of the Networking component is divided into the following four tabs.

m [nterfaces tab for configuring general interface-related settings
B Routing tab for managing network routes

®m Naming tab for configuring name resolution

B Resolving tab for configuring client-side DNS resolution
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Zorp Management Console - admin@zms - o x

File Edit View Configuration Management PKI Help

Configuration & aw aAcs @
= [lll Balasys_IT Securi
0 ys - v Interfal:es|Routing|Naming|Resolver|
= 000 zms
[E management agents  Network interface configuration
[E] Management server
Status| Name | Type Additional Info | Connects | Description
8 Packet filter loopback 127.0.0.1
[E] Package sources
[E] Licences
New Delete Edit Setlink up| Setlink downl ﬂ ﬂ
: [ Required for online
i Type specific parameters
Interface has no option
[ Alias of: I Ll [ VLAN: I Ll
Connecks: I J Spoof protection
New | Delete | Edit | ﬂ ﬂ
Commiktted

Figure 5.1. Tabs in the Networking component

5.1. Configuring networking interfaces

The configuration of network interfaces can be performed on the Interfaces tab of the Networking MC
component. These tasks fall into the following categories.

m General interface configuration

m Configuring virtual networks and alias interfaces

B Enabling spoof protection

®m Configuring interface options and activation scripts

General and special interface configuration features are available for every host managed from MS, while spoof
protection is intended for PNS gateways or other hosts that have an active packet filter installed.

5.1.1. General interface configuration

The Interfaces tab of the Networking MC component lists the network interfaces available on the host, along
with their type, IP addresses, and connected zones.

www.balasys.hu 62



General interface configuration e

| Zorp Management Console - admin@localhost =X
File Edit Wiew Configuration Management PKI Maonitoring Help

- [} [loefault_Corporate

< [l zMs_Host I Network interface configuration

@Management agents

Configuration |

Name Type Additional info [Connects |Description
@Management server

G}

[E]Packet filter
@:orp
<= [l Firewall_Host

[E]Metworking Duew | ﬁgeletel Rename | Control 'ljj

Management agents & 0 —— -~ aeaeeas

< [ Firewsll_cluster Famnily IIPv4 vl ¥ Activate at boot time
[E]Metworking Type specific parameters

Management agents

loopback 127.0.0.1

[~ Alias of | Ll [ VLAN | ﬂ

Connects I | [¥ Spoof protection
Description I J
Activation |Script | =

Delete

Duew |

A| w
Interfaces | Routing | Naming | Resclver

Commited

Figure 5.2. Network interface configuration

Tip

If you do not see one or more physical interfaces of your host listed here, it is most likely because they were not configured before
bootstrapping took place. The bootstrapping process not only establishes the connection between MS and the host (Management agents
on it), but it also queries host configuration and inserts this information into the MS database. When selecting a host entry in MC, the
information is read from the MS database, and not from the host directly. Therefore, MC does not detect parameters that were unavailable
for MS during bootstrapping.

To correct this situation, define the missing interface(s): click New and configure them as required.

5.1.1.1. Procedure - Configuring a new interface

Purpose:
To define a new interface, complete the following steps.
Steps:

Step 1. Navigate to Networking > Interfaces tab.
Step 2. Click New.
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Step 3. In the Name field, enter a name for the interface (for example, ethO0).

Step 4. Select the Type of the interface.

MNetwarl interface configuration

Name |Type |.A.-:I-:Iiti->na| info |-:I->nn-’:cts Description
fo loopback 127.0.0.1
{ = :
el b ZMC - New interface x

Family |IPv4 New interface

Type specific parg
Address |T
Name: IethO
Broadcast IT
Gateway |T
[~ Alias of
Connects
Description

|.A.cti'\.-'ation |Eicript

Figure 5.3. Defining a new interface

Step 5. Optional step: Enter a description, if you want to. To enter a longer description, click J

Step 6. Click OK.
Step 7. Configure the parameters of the interface below the table: enter the IP Address, Nddress, and other
data as required. The list of type-specific parameters depend on the type of interface you are configuring.

For static interfaces, that is, regular Ethernet interfaces enter the Netmask parameter using the CIDR
notation.

Warning
A As with all firewalls, you can specify only one gateway address in the network configuration and only for a single interface.
The gateway box for all other interfaces must be empty.
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Figure 5.4. Configuring a new interface

Note
@ If the configuration information you enter in MC is not the same as the current settings on the host, the settings of the host
are overwritten during the next Upload action.

If you change interface settings, To activate the changes, you have to restart the modified network interface.
Additionally, it may be required to temporarily stop an interface for security or maintenance reasons with the
Actions button under the network interface listing.

Warning
Restarting the interface might terminate all ongoing connections of the interface.

Note
@ The interfaces are controlled individually.
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5.1.1.2. Dynamic interfaces

Dynamic interfaces are interfaces that are either created dynamically, or obtain IP configuration information
dynamically from a designated server (for example, dhcp, bootp, ppp). Because their IP configuration is not
known when PNS boots up (and can be different at each boot sequence), the services using these interfaces
cannot include the IP address of the interface in the firewall rules related to the service. To overcome this
problem, PNS can bind to interfaces instead of IP addresses. Dynamic interfaces are referenced by their name
in the firewall rules. The operating system automatically notifies the running PNS instances when the IP
configuration information of the interface is received from the server. IP address changes are also automatically
handled within PNS. For more information on configuring firewall rules, see Section 6.5, Configuring firewall
rules (p. 121).

— Example 5.1. Referencing static and dynamic interfaces in firewall rules
— Dynamic interfaces can be used in firewall rules the same way as static interfaces. The following rule references a static interface:

Rule(proto=6,
dst_iface='eth0',
service="test'

)
The following rule references a dynamic interface called dyn:

Rule(proto=6,
dst_iface='dyn',
service="test'

)

5.1.2. Configuring virtual networks and alias interfaces

In some cases it can be useful to fine-tune the network for special purposes. For example for Virtual Local Area
Network (VLAN) technology: many organizations use it for security and network traffic separation purposes.
VLANES are logically separated components of physical networks. Logical separation means that although they
are on the same physical network (otherwise known as broadcast domain) hosts on separate VLANs cannot
communicate with each other unless a router is set up that provides the interconnection. Routing functions for
VLAN, and VLAN creation in general, are typically performed by Layer 3 Ethernet switches. Provided that
VLAN-capable network cards are installed in the machine, PNS fully supports VLANs and MS provides a
control for configuring it.

VLAN interfaces are named in the following manner:
ethx.n where

x is the number of the physical interface

n istheID of the VLAN. The ID of the VLAN is usually a number (for example, O for the first VLAN
of the interface, 1 for the second, and so on)

Note
@ If you define an interface as a VLAN interface, it cannot operate as a real, physical interface at the same time.

For example, the eth1.12 VLAN interface is the 12th VLAN interface of the eth1 physical network interface. If you define a VLAN
for eth1, you cannot use eth1 as a physical interface.
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5.1.2.1. Procedure - Creating a VLAN interface

Purpose:

To create a VLAN interface, complete the following steps.

Steps:

Step 1.

Step 2.
Step 3.
Step 4.

Step 5.
Step 6.

Every VL AN interface must be connected to a physical interface. If not already configured, configure
the physical interface that will be used as the VLAN interface. See Section 5.1.1, General interface
configuration (p. 62) for details.

A

To create a new interface, click New.

Warning
If you define an interface as a VLAN interface, it cannot operate as a real, physical interface at the same time.

Set the Type of the interface. The type of the VLAN interface and the physical interface can be different.

Enter a name for the VLAN interface and click OK. The name must include the name of the physical
interface, the period (. ) character, and a number that identifies the VL AN interface (because a physical
interface can have several VLAN interfaces). For example, eth1.0.

MC creates the new interface and automatically selects the VLLAN option and the sets the parent
interface of the VLAN.

Configure other options of the interface (for example, connected zones) as needed.
To activate the changes, click 8 Commit and & Upload. Then select the physical interface of the
VLAN, click @ Control service, and Restart the interface.

A

Warning
Restarting the interface might terminate all ongoing connections of the interface.
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Figure 5.5. Configuring VLAN and alias interfaces

Using alias interfaces allows you to configure multiple IP addresses to a physical device. Alias interfaces are
named in the following manner:

ethx:n where

ethx  is the name of the corresponding physical or VLAN interface

n is the ID of the alias interface. The ID is usually a number (for example, 0 for the first alias of
the interface, 1 for the second, and so on), but it can be a more informative name too.

An alias can be defined for existing physical and VLAN interfaces.
5.1.2.2. Procedure - Creating an alias interface
Purpose:

To create an alias interface, complete the following steps.

Steps:

Step 1. Every alias interface must be connected to a physical or a VLAN interface. If not already configured,
configure this interface.

Step 2. To create a new interface, click New.
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Step 3. Set the Type of the interface. The type of the alias interface and the physical interface can be different.

Step 4. Enter a name for the alias interface and click OK. The name must include the name of the physical or
VLAN interface, the colon (:) character, and the number or name that identifies the alias interface
(because an interface can have several alias interfaces). For example, eth1:0.

MC creates the new interface and automatically selects the alias option and the sets the parent interface
of the alias.

Step 5. Configure other options of the interface (for example, connected zones) as needed.
Step 6. To activate the changes, click @ Commit and & Upload. Then select the parent interface of the alias,

click @ Control service, and Restart the interface.

A

Warning
Restarting the interface might terminate all ongoing connections of the interface.

5.1.3. Procedure - Configuring bond interfaces

Purpose:

To create a bond interface, complete the following steps. The interfaces used to create the bond interface must
be already configured. For details on configuring network interfaces, see Procedure 5.1.1.1, Configuring a new
interface (p. 63).

Steps:

Step 1. Navigate to the host, and select the Networking MC component.

Step 2. To create a new interface, select Interfaces > Network interface configuration > New. The New
interface dialog is displayed.

Step 3. Enter a name for the interface (for example, bond0) and set its type to static.
Step 4. Select Type specific options > New.

Step 5. Select bond_slaves and enter the name of the interfaces to bond into the Attributes field. Use a
single whitespace to separate the name of the interfaces (for example, eth0 eth1).

Step 6. Optional step: Select Type specific options > New to set other bond-specific options as needed (for
example, bond_mode). If an option is not listed, type its name into the Option field and its value to
the Attributes field.

Step 7. Configure the other parameters of the interface (for example, address, netmask, and so on) as needed.
Step 8. To activate the changes, click @ Commit and & Upload.
5.1.4. Procedure - Configuring bridge interfaces

Purpose:

To create a bridge interface, complete the following steps. The interfaces used to create the bridge interface
must be already configured. For details on configuring network interfaces, see Procedure 5.1.1.1, Configuring
a new interface (p. 63).
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Steps:

Step 1.
Step 2.

Step 3.
Step 4.
Step 5.

Step 6.

Step 7.
Step 8.

Navigate to the host, and select the Networking MC component.

To create a new interface, select Interfaces > Network interface configuration > New. The New
interface dialog is displayed.

Enter a name for the interface (for example, bridge0) and set its type to static.
Select Type specific options > New.

Select the bridge_ports option, and enter the name of the interfaces to bridge into the Attributes
field. Use a single whitespace to separate the name of the interfaces (for example, eth0 eth1). To
bridge every available interfaces, enter all.

Optional step: Select Type specific options > New to set other bridge-specific options as needed (for
example, bridge_stp). If an option is not listed, just type its name into the Option field and its value
to the Attributes field. For a list of available options, see the bridge-utils-interfaces manual page.

Configure the other parameters of the interface (for example, address, netmask, and so on) as needed.

To activate the changes, click @ Commit and & Upload.

5.1.5. Enabling spoof protection

Spoof protection means that the packet filter module of a firewall checks to ensure that packets arriving on an
interface have source IP addresses that are legal in networks reachable through that given interface and accepts
only those packages that match this criterion.

For example, if eth0 connects to the Intranet (10.0.0./8) and it is spoof-protected, the firewall does not
accept datagrams on this interface with source TP addresses other than the 10.0.0.0/8 range. It does not accept
datagrams with source IP address from the 10.0.0.0/8 range on interfaces other than etho either.

5.1.5.1. Procedure - Configuring spoof protection

Steps:

Step 1.

Step 2.

Select the Networking interface and next to the Connects field, click ..

Select the zones the configured interface is connected to either directly or indirectly through routers.
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Figure 5.6. Zone selection for the Connects control

Note

@ The Zone tree in the dialog window is organized IP addresses, starting from the most generic (0.0.0.0/0) to the most
specific. There is an implicit inheritance in the Connects specification: if the 10.0.0.0/8 address ranges is specified to
connect to eth1, all more specific subnets of this address range (10.0.0.0/9, /10, .../32) connect to eth1 also, unless a
more specific binding is explicitly specified.

Step 3. Select Spoof protection.

®

Note
The Packet filter ruleset must be regenerated after modifying any interface settings. It is not done automatically.

For further details on zones, see Section 6.2, Zones (p. 82). For more information on Spoof control in relation
with packet filter rules, see Section A.4.3.3, Spoof protection (p. 400).

5.1.6. Interface options and activation scripts

The bottom part of the Interfaces tab can be used to specify activation scripts and various other parameters of
the network interfaces. The following options can be configured:

m Interface activation scripts

m Interface groups

m Other interface options

5.1.6.1. Configuring interface activation scripts

Interface activation scripts can be useful for scenarios where special procedures are required to initialize
networking.
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For example, changing the Media Access Control (MAC) address of a network card before bringing it up can
be done with a pre-up script. Such scripts should also be used for configuring bridge interfaces.

The following types of activation scripts can be set:

. pre-up scripts are executed before the interface is activated.

. up scripts activate the interface.

. post-up scripts are executed after the interface is activated.

. pre-down scripts are executed before the interface is deactivated.

. down scripts deactivate the interface.

A U1 A W N R

. post-down scripts are executed after the interface is deactivated.

5.1.6.1.1. Procedure - Creating interface activation scripts
Purpose:

To create an interface activation script for an interface, complete the following steps.
Steps:

Step 1. Navigate to Networking > Interfaces and select the interface to configure.
Step 2.

Figure 5.7. Configuring interface options

To add a new option to the interface, click New.

Step 3. From the Option field, select the type of the script (pre-up, up, post-up, pre-down, down,
post-down).

Step 4. Bl Zvc-newsoipt |3

New script

Type: |up -
Seript: [fusr/sbin route add -net 192.168.0.1¢

X | [ P

Figure 5.8. Defining interface scripts

Enter the command to execute in the script into the Attributes field. Use full path name, for example,
/sbin/ifdown.
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Step 5. To execute multiple commands, repeat Steps 2-4.

Step 6. To set the order of commands, use the arrow buttons below the list of options.

Tip
If you have to use complex scripts, create a script file on the PNS host using a text editor, and add an option to run it when
needed.

5.1.6.2. Interface groups

To simplify the management of services that are available from multiple zones and interfaces, interfaces can
be grouped. Interfaces belonging to an interface group can be controlled together: the ifup and ifdown
commands support interface groups too. Firewall rules can accept connections on interface groups too. For
details on zones, services, and firewall rules, see Chapter 6, Managing network traffic with PNS (p. 82).

5.1.6.2.1. Procedure - Creating interface groups
Purpose:

To assign interfaces to an interface group, complete the following steps.
Steps:

Step 1. Navigate to the Networking component and select the Interfaces tab.
Step 2. From the list of interfaces, select the interface to add to the group.

Step 3. Under the list of options, click New.

Figure 5.9. Creating interface groups

Step 4. From Option, select group.
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Description:

Figure 5.10. Creating interface groups

Step 5. Groups are identified by a number between 1-255. To assign the interface to a group, enter a number
into the Attribute field.

Step 6. Click Ok.
Step 7. Repeat Steps 2-5 to add other interfaces to the group.

Step 8. Commit and upload your changes. To activate the changes, restart the interface.

5.1.6.3. Other interface options

The following miscellaneous options can be configured for a network interface.

®

® hwaddress: Sets the MAC address of the interface.

Note
It is rarely required to use these options in common scenarios. Only modify them if you know exactly what you are doing.

®m metric: Sets the metric used by the interface.
B mtu: Sets the Maximum Transfer Unit (MTU) of the interface.
®m media: Sets the media type of the interface.

m ttl: Sets the Time to live (TTL) parameter of the interface.

5.1.6.3.1. Procedure - Configuring interface parameters

To configure an interface parameter, complete the following steps.

Step 1. Navigate to the Networking component and select the Interfaces tab. Select the interface to configure.
Step 2. To add a new option to the interface, click New.

Step 3. From the Option field, select the parameter that you want to configure.

Step 4. Enter the value of the parameter into the Attributes field.

Step 5. Commit and upload your changes. To activate the changes, restart the interface.

5.1.7. Interface status and statistics

The state of the configured interfaces is indicated by leds of different colors before the name of the interface (i
Green — Up, 1Red — Down, I Blue — Unknown). The state of the interface is automatically updated periodically.
The update frequency can be configured in Edit > Preferences > General > Program status. Status update
can also be requested manually from the local menu of the interface. To do this, select the interface, right-click
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on it and select Refresh State. Hovering the mouse over an interface displays a tooltip with status information
and detailed statistics about the interface. The following status information is displayed:

m State: Status of the interface. Possible values: Up, Down, Unknown.

m qdisc: Queuing discipline. For details, see the Traffic Control manual pages (man tc).

m flags: Flags applicable to the interface. Possible values: UP, BROADCAST, MULTICAST, PROMISC,
NOARP, ALLMULTI, LOOPBACK.

B mtu: Maximum Transmission Unit (MTU): the maximum size of a packet (in bytes) allowed to be
sent from the interface.

The statistics about the traffic handled by the interface is divided into Received and Sent sections, relevant for
the received/sent packets, respectively.

m Errors: Number of errors encountered.

® Bytes: Amount of data received.

m Packets: Number of packets received.

® Mcast: Number of received multicast packets.

B Dropped: Number of dropped packets.

®m Overruns: Number of overruns. Overruns usually occur when packets come in faster than the kernel
can service the last interrupt.

m Collisions: Number of collisions encountered.
m Bytes: Amount of data sent.

m Packets: Number of packets sent.

® Errors: Number of errors encountered.

m Dropped: Number of dropped packets.

m Carrier: The number of carrier losses detected by the device driver. Carrier losses are usually the
sign of physical errors on the network.
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5.2. Managing name resolution
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Figure 5.11. The Naming tab

Variables on the Naming tab directly correspond to the contents of /etc/hosts and /etc/networks files.
Their use is mostly optional, name resolution is faster if most important name-IP address pairs are listed in
/etc/hosts. A correctly configured resolver can provide the same service.

®

Note
If you intend to use the Postfix native proxy on the PNS host, you exceptionally have to supply the Mailname parameter.
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5.3. Managing client-side name resolution
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Figure 5.12. The Resolver tab

The client-side of DNS name resolution information can be configured on the Resolver tab.

®

In DNS terminology, the client initiating a name resolution query is called a resolver. For details about configuring
a resolver correctly, refer to a good DNS documentation, see Appendix C, Further readings (p. 405).

Note
The Bind native proxy of PNS cannot be configured here. For information, see Chapter 9, Native services (p. 197).

5.3.1. Procedure - Configure name resolution

Step 1. List the nameservers to be used by your host in the right pane.
Step 2. Set a priority order among the nameservers. The first one on the list is queried first.
Step 3. Set up domain search order in the left pane.

Use the buttons with triangles on the right.

This information is used when you issue a name query for a hostname but without supplying the domain
name parts: for example, telnet myserver. In this case the resolver automatically tries to append domain
suffices to the hostname in the order you specify, before sending queries to nameservers.
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Figure 5.13. Domain search order

In the example above, this would be example.com and then if the query is unsuccessful
myserver .example.com.

Step 4. OPTION
Define the preferred interface in the Sortlist.

The sortlist directive specifies the preferred interface you wish to communicate on when, as a result
of a query, you receive more than one IP address for a given host. The value of Sortlist can be a network
IP address or a host IP address/subnet mask pair, where subnet mask is in the classic dotted decimal
format and not in CIDR notation.

Tip
The optimization using the Sortlist might be useful for firewalls with many interfaces installed or in the following special
network setup.

The firewall is connected to the Internet with two interfaces: one for a broadband, primary connection and another,
lower-bandwidth backup connection through a different ISP. If you want to reach a server on the Internet and the DNS query
returns two IP addresses for the same server. From its routing table your firewall deduces that both IP addresses are reachable,
but by default it uses the IP address that was listed first in the DNS response, even if that IP address is reachable through
the — slower — backup line. To avoid this situation, you can explicitly tell your resolver with the Sortlist feature that
whenever possible, it must prefer the interface that connects to the higher-bandwidth primary line.

Note that sortlist is just a preference and not an exclusive setting: if the targeted server cannot be
reached via the interface designated by the sortlist parameter, the other interface(s) and IP addresses
are tried.
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Figure 5.14. Sortlist setting

5.4. The routing editor

If a packet has to be delivered to a remote network, PNS consults the routing table to determine the path it
should be sent. If there is no information in the routing table then the packet is sent to the default gateway. For
maintaining and managing the routing table PNS offers a simple yet effective user interface on the Routing
tab of the Networking MC component. It can be used to define static routes to specific hosts or networks
through a selected interface.

[ |- = x
Fle Edit Wiew Configuration Management PKI Monitoring Help
Configuration 2R | & @ @
Routing table
mentacerts Fnetwork contains| v | | S Filter| s Clear
Management server
i Network Gateway Interface | Metric | Description | =
EllPacket fiiter 1.2.3.4/32 198.168.0.254 eth0 0 |
Networking
Management agents
Onew | @@pelete | [Fedit
&a control
Interfaces) Routinglf Naming | Resclver
lUnsaved changes

Figure 5.15. The Routing tab

The Routing tab contains the following elements:
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m A list of routing table entries in the middle of the panel.
m A filter bar on the top for searching and filtering the entries.

m A control bar on the bottom for managing the entries of the list and for activating the modifications
of the routing table on the PNS firewall hosts.

5.4.1. Routes

A route has the following parameters:

m Address: IP address of the network.
m Netmask: Netmask of the network.

®

m Gateway: IP address of the gateway to be used for transmitting the packages.

Note
The IP address and netmask parameters are displayed in the Network column of the routing entries list.

m Interface: The Ethernet interface to be used for transmitting the packages. This parameter must be
selected from the combobox listing the configured interfaces.

B Metric: An optional parameter to define a metric for the route. The metric is an integer from the 0
- 32766 range.

m Description: Notes describing what this entry is used for.
The above parameters are interpreted the following way: messages sent to the Address/Netmask network

should be delivered through Gateway using Interface.

New entries into the routing table can be added by clicking the New button of the control bar; existing entries
can be modified by clicking Edit. The updated routing tables take effect only after the new configuration is
uploaded to the host, and the routing tables are reloaded using the Actions/Reload buttons of the control bar.

ZMC - New routing entry

New routing entry
address: | L)
netmagk: [z
Gateway: | &
Interface;  [etho j
Metric 0 B
Deseription:

Figure 5.16. Adding new routing entries

5.4.2. Sorting, filtering, and disabling routes

The list of routing table entries can be sorted by all of its parameters (network, gateway, and so on) by clicking
on the header of respective column. By default, the list is displayed according to the general listing policy of
the routing tables, that is, the networks connecting via a gateway are listed after the directly connected networks.
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The list can be filtered using the filter bar above the list. Type the search pattern into the textbox, specify the
elements to be searched using the combobox on the left, and click Filter. The list will only display the routes
matching the search criteria. Click Clear to return to the full list.

Network contains|+ o Fiter| Yclear

Figure 5.17. The Filter bar

Routes can be temporarily disabled by right-clicking the selected route and selecting Disable from the appearing
local menu.

®

5.4.3. Managing the routing tables locally

Note
The route becomes disabled only after the routing table is reloaded.

When the PNS host is administered via a terminal, the routes have to be entered manually by editing the
/etc/network/static-routes configuration file. Each line of this file corresponds to a route, and has the
following format:

interface_name to address/netmask through gateway metric [metric]

For the modifications to take effect, the routing tables have to be reloaded by issuing the
/usr/lib/zms-transfer-agent/zms-routing params="reload" command.
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Chapter 6. Managing network traffic with PNS

This chapter describes how to allow traffic to pass the PNS firewall. It gives detailed explanation of the many
features and parameters of PNS.

6.1. Understanding Application-level Gateway policies

This section provides an overview of how Application-level Gateway handles incoming connections, and the
task and purpose of the different PNS components.

Application-level Gateway firewall rules permit and examine connections between the source and the destination
of the connection. When a client tries to connect a server, Application-level Gateway receives the connection
request and finds a firewall rule that matches the parameters of the connection request based on the client's
address, the target port, the server's address, and other parameters of the connection. The rule selects a service
to handle the connection. The service determines what happens with the connection, including the following:

m The Transport-layer protocol permitted in the traffic. For example, TCP or UDP.

B The service started by the firewall rule. This also determines the application-level protocol permitted
in the traffic. Application-level Gateway uses proxy classes to verify the type of traffic in the
connection, and to ensure that the traffic conforms to the requirements of the protocol, for example,
downloading a web page must conform to the HTTP standards.

m The address of the destination server. Application-level Gateway determines the IP address of the
destination server using a router. Routers can also modify the target address if needed.

m The content of the traffic. Application-level Gateway can modify protocol elements, and perform
content vectoring. See Chapter 14, Virus and content filtering using CF (p. 300) for details.

B How to connect to the server. For nontransparent connections, Application-level Gateway can connect
to a backup server if the original is unreachable, or perform loadbalancing between server clusters.

m Who can access the service. Application-level Gateway can authenticate and authorize the client to
verify the client's identity and privileges. See Chapter 15, Connection authentication and
authorization (p. 330) for details.

The operations and policies configured in the service definition are performed by a Application-level Gateway
instance.

6.2. Zones

Zones describe and map the networking environment on the IP level. IP addresses are grouped into zones; the
access policies of PNS operate on these zones. Zones specify segments of the network from which traffic can
be received (source) or sent to (destination) through the firewall. Zones in PNS can contain:

m IP networks,

m subnets,

® individual IP addresses, and

B hostnames.
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The actual implementation of a zone hierarchy depends on the network environment, and the placement and
role of PNS firewalls, the security policy, and so on.

The Internet zone which covers all possible IP addresses is defined on every site by default. If an IP address is
not included in any user-defined zones, it belongs to the Internet zone. PNS policies permit traffic between two
or more zones, so at least another zone — the intranet — must be created. Usually a special zone called
demilitarized zone (DMZ) is defined for servers available from the Internet.

Zones in PNS can have a hierarchy, with a zone containing many subzones that may have their own subzones,
and so on. From these zones, a tree hierarchy can be constructed. This hierarchy is purely administrative and
independent from the IP addresses defined in the zones themselves: for example, a zone that contains the
192.168.7.0/24 subnet can have a subzone with IP addresses from the 10. 0. 0. 0/8 range.

A network can belong only to a single zone, because otherwise the position of IP addresses in the network
would be ambiguous.

The zone hierarchy is independent from the subnetting practices of the company or the physical layout of the
network, and can follow arbitrary logic. The zone hierarchy applies to every host of a site.

Note
@ Subnets can be used directly in PNS configurations, it is not necessary to include them in a zone.

Note
@ It is recommended to follow the logic of the network implementation when defining zones, because this approach leads to the most
flexible firewall administration. Plan and document the zone hierarchy thoroughly and keep it up-to-date. An effective and usable zone
topology is essential for successful PNS administration.

6.2.1. Managing zones with MC

By default, MC defines a zone called internet on every site. The internetcontains the the 0.0.0. 0 and
the : :0 networks with the 0 subnet mask. This zone means any network: every IP address not belonging to
another zone belongs to the internet zone.

®

Note
PNS uses the CIDR notation for subnetting.
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Figure 6.1. Zones

The internet zone is typically used in firewall rules where one side of the connection cannot be defined more

exactly.

— Example 6.1. Using the Internet zone
— The Internet zone identifies all external networks. To allow the internal users to visit all web pages, simply set the destination zone of
| e—] the HTTP service to Internet. For details on creating services, see Section 6.4, Application-level Gateway services (p. 100).

Zones are managed on the Site component in MC. The left side of the main workspace displays the zones
defined on the site and their descriptions. IP networks that belong to the selected zone are displayed on the right

side of the workspace.

Note
@ The Application-level Gateway MC component has a shortcut in its icon bar to the zone editor. The zone hierarchy applies to all firewalls
of the site, so carefully consider every modification and its possible side-effect.
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Use the control buttons to create, delete, or edit the zone definitions and the IP networks. Use the arrow icons
to organize the zones into a hierarchy (see Section 6.2.3, Zone hierarchies (p. 87) for details).

— Example 6.2. Subnetting
— Suppose you have the following IP address range to put into a zone: 1.2.50.0 — 1.2.70.255. You can either define 21 IP subnets
| w— with /24 mask or you can define six subnets in the following manner: 1.2.50.0/23,1.2.52.0/22,1.2.56.0/21,1.2.64.0/22,
1.2.68.0/23,1.2.70.0/24. Whether you have a switched/routed network or you actually use /24 subnets is irrelevant from the
zone's (PNS's) point of view. As long as it encounters an IP address from the range 1.2.50.0 — 1.2.70.255, it will consider it a
member of the given zone.

Furthermore, if you define Zone A with the IP network 10.0.0.0/8 and Zone B consisting of the network 10.0.1.0/24 and the
machine, Computer C with the IP address of 10.0.1.100/32, from an IP addressing point of view, belongs to both subnets, but the
PNS rule applied in this and similar cases is that the machine is always considered to belong to the network (and thus the zone) more
specific in CIDR terms. In this example it is Zone B.

6.2.2. Procedure - Creating new zones

To create a new zone on the site, complete the following steps.

Step 1. Select the site from the configuration tree and click New.

") Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help ‘

Configuration Il o2l ‘
- [ Balabit IT Securif
l el Site management

< [0l zMs-Host

Management agents |Zones |Descript\on — |Network address | Netmask | —
Management server ntermnet Fallback zone
Networking ~ intranet
[E Packet filter office
Zorp
VPN

yen‘ X Qelete| Edit |

| | New | X Qelete| Rename | jjjj (] Eind Description

Hosts in site

[
ZMS-Host

Bootstrap New £
| |+ —

Unsaved changes

Figure 6.2. Creating a new zone

Step 2. Enter a name for the zone in the displayed window.
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Tip
Use descriptive names and a consistent naming convention. Zone names may refer to the physical location of the network
or the department using the zone (for example, building_B, or marketing).

Step 3. ") Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help ‘

Configuration :l 2] ‘
- | Balabit IT Security

Site management
= [0l zMs-Host

Management agents |ZOnes |Descript\on — |Network address | Netmask |7
Management server ntermet Fallback zone
Networking ~ intranet
[E Packet filter office
Zorp
VPN
N uuewl ) Qelete| ? Edit |
New ‘ ) Qelete| Rename | jjjj Q) Find Description
Hosts in site
N
ZMS-Host

Bootstrap New &
| |+ -

Unsaved changes

Figure 6.3. Creating a new network in a zone

To add an IP network to the zone, click New in the Networks pane.

Step 4. ® To add a network or an IP address to the zone, select Subnetwork, fill the Network and
Netmask fields, then click Ok.

m To add a hostname to the zone, select Hostname, enter the hostname into the Address field,
then click Ok. For details on using hostnames in zones, see Section 6.2.4, Using hostnames
in zones (p. 90).

Repeat this step to add other networks to the zone.

®

Note
The new zone has effect only if used in a firewall rule definition.
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New network

O Subnetwork

Network: |

Netmask: |

® Hostname

Hostname: ‘www,examplslcom

Figure 6.4. Adding networks to a zone

6.2.3. Zone hierarchies

Zones can be organized into a tree, much like the directories of a file system. Define a topmost zone and with
many subzones, each for administratively different parts of your networks. A zone and its subzone have
parent-child relationship: child zones automatically inherit all properties and settings of their parents. For
example, Zone A is the parent zone of Zone B, and all clients in Zone A may browse the web through HTTP.
Zone B inherits this setting, so all clients of Zone B have unrestricted HTTP access.

To stop a zone from inheriting the properties of the parent zone, use a DenyService. For details on DenyServices,
see Procedure 6.4.3, Creating a new DenyService (p. 105).

Zones can be reorganized as needed.

Note
@ Changing parent-child relations also changes the inheritance chain — which might cause unexpected results on your firewall policies.
Make sure to keep up-to-date documentation of your firewall configuration.
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Figure 6.5. Zones, inheritance, and DenyServices

6.2.3.1. Procedure - Organizing zones into a hierarchy

To organize zones into a hierarchy, complete the following steps.

Step 1. Select the site from the configuration tree in MC.

Step 2_ :l7Z;vaan:7a;e7n:|;rTa)’n;;ET;rd’min@ln:al-vhox =
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Figure 6.6. Configuring zone hierarchy

Using the up and down arrows located next to the Find button, move the child zone below its parent.
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Step 3. Click the right arrow to make the selected zone a children of the zone above it.
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Figure 6.7. Configuring zone hierarchy

Commit the changes to the site.

®

Note
Zone definitions are site-wide, so modifications are effective on every firewall of the site.

_ Descipton |
[

Step 5. Select all hosts of the site and upload the configuration.
This step is required because changes in the zone hierarchy must be uploaded to all firewall nodes.
Step 6. Select all hosts of the site, click the Control icon of the icon bar and reload the configuration.

To remove a child zone from the hierarchy, select the zone and click the left arrow.
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6.2.4. Using hostnames in zones

Starting with PNS 5.0, you can directly use hostnames in zones. During startup, PNS automatically resolves
these hostnames to /32 IP addresses, and updates them periodically to follow any changes in the IP addresses
related to the hostname. When using hostnames in zones, note the following points and warnings:

m Ensure that your Domain Name Server (DNS) is reliable and continuously available. If you cannot
depend on your DNS to resolve the hostnames, do not use hostnames in zones.

®m Do not use zones that include hostnames to deny access, that is, do not use such zones in DenyServices.
If PNS cannot resolve a hostname, it will omit the hostname from the zone. If the zone contains only
a single hostname (because you want to use it to restrict access to a specific site), the zone will be
empty, that will never match any connection. If you have a firewall rule that is more permissive than
the DenyService you are using the zone with the hosname, this more permissive rule will be effective,
permitting traffic you want to block. (For example, you create a rule that permits HTTP traffic to
the Internet, and a DenyService to block HTTP traffic to the example.com hostname. If PNS cannot
resolve the example.com hostname, then the broader, more permissive rule will permit traffic to the
example.com site.)

m If the hostname is resolved to an IP address that is explicitly used in another zone, then PNS will
use the rule with the explicit IP address. For example, you have a zone that includes the example.com
hostname, another zone that includes the 192.168.100.1/32 IP address, and you have two different
rules that use these zones (Rule_1 uses the hostname, Rule 2 the explicit IP address). If the
example.com hostname is resolved to the 192.168.100.1 IP address, PNS will use Rule_2 instead of
Rule_1.

m If more than one hostname is resolved to the same IP address, PNS ignores each hostname and logs
an error message. For example, this means that you cannot use a hostname in a zone if the server
uses name-based virtual hosting.

m Zones are global in PNS, and apply to all firewalls of the site, so carefully consider every modification
of a zone, and its possible side-effect.

6.2.5. Finding zones

To find a zone or a subnet, select the site in the configuration tree and click the Find button.

ZMC - Search for zones

Search for zones

vame: [

address: [

Descrij ption: ’—
aite

[~ Case sensitive

Figure 6.8. Finding zones and subnets

You can search for the name of the zone, or for the IP network it contains. When searching for IP networks,
the only the most specific zone containing the searched IP is returned. If an IP address belongs to two different
zones, the straitest match returns the most specific zone.
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— Example 6.3. Finding IP networks

—— | Suppose there are three zones configured: Zone_A containing the 10. 0. 0. 0/8 network, Zone_B containing the 10. 0. 0. 0/16 network,
| — and Zone_C containing the 10.0.0. 25 IP address. Searching for the 10. 0. 44. 0 network returns Zone_B, because that is the most
specific zone matching the searched IP address. Similarly, searching for 10. 0. 0. 25 returns only Zone_C.

This approach is used in the service definitions as well: when a client sends a connection request, PNS looks for the most specific zone
containing the IP address of the client. Suppose that the clients in Zone_A are allowed to use HTTP. If a client with IP 10. 0. 0. 50 (thus
belonging to Zone_B) can only use HTTP if Zone_B is the child of Zone_A, or if a service definition explicitly permits Zone_B to use
HTTP.

Tip
The Find tool is especially useful in large-scale deployments with complex zone and subnet structure.

6.3. Application-level Gateway instances

6.3.1. Understanding Application-level Gateway instances

Instances of Application-level Gateway are groups of services that can be controlled together. A PNS firewall
can run multiple instances of the Application-level Gateway process. The main benefits of multiple firewall
instances are the following:

B Administration
A typical firewall handles many types of traffic, many different protocols. These protocols might
have different administrative requirements. Inbound traffic is usually handled differently from
outbound traffic. For these reasons, using multiple firewall instances can make administration more
transparent.

m Availability
If an error (for example, misconfiguration) occurs and the firewall instance stops responding, no
traffic can pass the firewall. However, an error usually affects a single instance; the other ones are
still functional, so only the traffic handled by the crashed instance stops. Instances can be controlled
(started, restarted, stopped) individually from each other. This is important, because stopping or
restarting an instance stops all traffic handled by the instance.

Consider the following example. A firewall uses two instances: Instance_A for all e-mail related
traffic (the POP3, IMAP, and the SMTP protocols) and Instance_B for everything else (HTTP,
and so on). If Instance_A stops because of an error, or is stopped by the administrator, no e-mails
can be sent or received. However, all other network traffic is working.

m Performance
Separate firewall instances have separate processes and separate sets of threads, significantly increasing
the performance on multiprocessor systems (SMP or HyperThreading).

m Logging
Log settings are effective on the instance level; different instances can log in differently. For example,
if higher than average logging level is required for a type of traffic, it might worth to create an instance
for this traffic and customize logging only for this instance.
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Note
@ Although creating instances is beneficial, the number of instances that can run on a system is limited.

Each instance is a separate process and requires its own space in the system memory — quickly consuming the limited physical resources
of the computer. More instances do not necessarily make configuration tasks easier, and complex configuration increases the chance of
human errors.

Keep instance number relatively low unless you have a solid reason to use many instances.

Instances usually handle traffic based on the protocol used by the traffic, the direction of the traffic, or a special
characteristic of the traffic (for example, requires authentication). It is common practice to define an instance
for all inbound traffic that handles all services accessible from the Internet, and another one for all traffic that
the clients of intranet are allowed to use. Consider creating a separate instance for:

m special services, for example, mission-critical traffic;

m traffic accessing critical locations, for example, your servers;

m traffic that requires outband authentication.

6.3.2. Managing Application-level Gateway instances

To manage Application-level Gateway instances, navigate to the Instances tab of the Application-level Gateway
MC component.
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Figure 6.9. Managing instances

The following information is displayed for each instance:

m Name: Name and state of the instance. The colored led shows the state of the instance:

* Green — Running

* Red — Stopped

* Blue — Unknown. New instances that were not started yet are in this state.

® Number of processes: The number of CPU cores that the instance can maximally use. Select Edit
parameters > General > Number of processes to modify this setting. Default value: 1

m Log verbosity: The log level set for the instance.

m Log settings: The log specifications of the instance.

m Description: A description of the instance, for example, the type of traffic it handles.

Hovering the mouse over an instance displays a tooltip with detailed information, including the number of
processes running in the instance, as well as the number of running threads for each process.

Use the button bar below the instances table to manage and configure the instances.

www.balasys.hu

93




Managing Application-level Gateway instances

m New: Create a new instance. On a freshly installed PNS, there are no instances — you have to create
one first. See Procedure 6.3.3, Creating a new instance (p. 94) for details.

m Delete: Remove an instance.

AN

m Edit parameters: Modify the name or parameters of the instance. See Section 6.3.5, Instance
parameters — general (p. 96) for details. To modify the parameters of every instance, select = >
Default parameters.

‘Warning
Deleting an instance makes the services handled by the instance unaccessible.

B Restart: Restart the instance. To Reload, Restart, Stop, or Start an instance, click Restart- and
select the desired action. These functions are needed after modifying the configuration of an instance.
Log level sets the verbosity of logging. Active connections displays the connections currently
handled by the instance (see Section 6.8, Monitoring active connections (p. 170) for details).

Tip
Use the Shift or the Control key to select and control multiple instances.

® Arrow buttons: Move the instance up or down in the list. When PNS boots, the instances are started
in the order they are listed.

6.3.3. Procedure - Creating a hew instance

To create a new instance on a PNS firewall host, complete the following steps:

Step 1. Navigate to the Instances tab of the Application-level Gateway MC component on the PNS host.

Note
@ If the Application-level Gateway and the Packet Filter components are not available on the selected host, you have to add
them first. See Procedure 3.2.1.3.1, Adding new configuration components to host (p. 22) for details.
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Figure 6.10. Creating a new Application-level Gateway instance

Click the New button located below the Instances table.

Step 3. Enter a name for the new instance.

intra_http or intra_pop3 referring to instances that handle HTTP and POP3 traffic coming from the intranet. Use

Note
@ Use informative names containing information about the direction and type of the traffic handled by the instance, for example,
direction names consistently, for example, include the source zone of the traffic.

Step 4. Describe the purpose of the instance in the Description field.

Step 5. To modify the parameters of the instance, uncheck the Use default parameters option and adjust the
parameters as needed. For details on the available parameters, see Section 6.3.5, Instance parameters
— general (p. 96).

Step 6. Click OK.

6.3.4. Procedure - Configuring instances

To modify the parameters of an instance, complete the following steps.

Step 1. Navigate to the Instances tab of the Application-level Gateway MC component on the PNS host.

Step 2. B To modify the configuration of every instance on the site, select = > Default parameters.
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m To modify the configuration of a single instance, select an instance and click Edit
parameters. The Edit Instance window is displayed. Uncheck the Use default parameters
option.

_] ZMC - Edit default instance parameters (X |

Edit default instance parameters

General | Loggingl Rights | Miscellaneousl
Threads

Thread limit: 1000 =

Virtual instances: |4

j

Abort handling
Automatically restart abnormally terminated instances

[J] Enable core dumps

Figure 6.11. Edit instance parameters

Step 3. Adjust the settings as needed, then click OK. Instance parameters are grouped into four tabs. See
Section 6.3.5, Instance parameters — general (p. 96) for details on the available parameters.

Step 4. Commit and upload the changes.

Step 5. To activate the changes, select Restart button to or Restart- > Reload.

6.3.5. Instance parameters — general

To modify instance parameters, select Application-level Gateway > Instance > Edit parameters. The General
tab has the following parameters:

www.balasys.hu 96



Instance parameters — general e
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Figure 6.12. General instance parameters

m Enabled: Uncheck this option to inactivate the instance.
m Instance: The name of the instance.

m Stop instance before remame: When renaming and instance and this option is enabled,
Application-level Gateway stops the instance, renames it, then starts the renamed instance.

® Description: The description of the instance.

m Thread limit: The number of threads the instance can start. Set Thread limit according to the
anticipated number of concurrent connections. Most of the active client requests requires its own
thread. If the Thread limit is too low, the clients will experience delays and refused connection
attempts.

® Number of processes: The number of Application-level Gateway processes the instance can start.
This setting determines the number of CPU cores that the instance can use. If our PNS host has many
CPUs, increase this value for instances that have high traffic. Note that the Thread 1imit and
Thread stack limit parameters are apply separately for every process. For details on increasing
the number of running processes, see Procedure 6.3.9, Increasing the number of running
processes (p. 100).
For every process, Application-level Gateway uses a certain amount of memory from the stack. At
most, a process uses the default value of the stack size of the host (which is currently 8 MB for
Ubuntu 18.04 LTS). Application-level Gateway uses this memory only when it is actually needed
by the thread, it is not allocated in advance.

®m Automatically restart abnormally terminated instances: If enabled, Application-level Gateway
automatically restarts instances that crash for some reason.

®m Enable core dumps: If enabled, PNS automatically creates core dumps when a Application-level
Gateway instance crashes for some reason. Core dumps are special log files and are needed for
troubleshooting.
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6.3.6. Instance parameters — logging

Instance parameters can be set on the tabs of the Edit Instance Parameters window. The Logging tab has the
following parameters:

ZMC - Edit default instance parameters

Edit default instance parameters

General Logging | Rightsl Miscellaneousl

Logging
Verbosity level: =
Message filter expression: |*.acc0unting 4 J

Include message tags

[] Escape binary characters in log files

@ Cancel

<Jok |

Figure 6.13. Instance parameters — logging

m Verbosity level: The general verbosity of the instance. Ranges from 0 to 9; higher value means more
detailed logging.

Note
@ Setting a high verbosity level (above 6) can dramatically decrease the performance. On level 9 Application-level Gateway
logs the entire passing traffic.

Tip
The default verbosity level is 3, which logs every connection, error and violation without many details.

Level 4 to 6 include protocol-specific information as well.

Levels 7 to 9 are recommended only for troubleshooting and debugging purposes.

m Message filter expression: Sets the verbosity level on a per-category basis. Each log message has
an assigned multi-level category, where levels are separated by a dot. For example, HTTP requests
are logged under http.request. A log specification consists of a wildcard matching log category,
a colon, and a number specifying the verbosity level of that given category. Separate log specifications
with a comma. Categories match from left to right. For example, http.*:5, core:3. The last
matching entry will be used as the verbosity of the given category. If no match is found the default
verbosity is used.

B Include message tags: Prepend log category and log level to each message.

m Escape binary characters in log files: Replace non-printable characters with XXto avoid binary log
files. Characters with codes lower than 0x20 or higher than 0x7F.
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Note
@ Customized logging can be very useful, but should be used with caution. Too many log specifications can decrease the overall performance
of Application-level Gateway.

— Example 6.4. Customized logging for HTTP accounting
—— | The HTTP proxy logs accounting information into the accounting category. Requested URLs are logged on level 4. To log the URLs,
| w—] but leave the general verbosity level on 3, add a new log specification to the Message filter expression list: http.accounting:4.

6.3.7. Instance parameters — rights

Instance parameters can be set on the tabs of the Edit Instance Parameters window. The Rights tab has the
following parameters:

] ZMC - Edit default instance parameters ]

Edit default instance parameters

General | Logging Rights|MisceIIaneous|

Rights
User: zorp)
Group: zorp

Chroot directory: |

Manage capabilities: |

@ Cancel ‘ <Fok |

Figure 6.14. Instance parameters — rights

Warning
A Modify these settings only if you know what you are doing, because bad rights configuration can prevent Application-level Gateway
from starting.

m User: Run Application-level Gateway as this user. By default, Application-level Gateway runs as
the normal user zorp.

B Group: Run Application-level Gateway as a member of this group.
m Chroot directory: Change root to this directory before reading the configuration file.

® Manage capabilities:

6.3.8. Instance parameters — miscellaneous

Instance parameters can be set on the tabs of the Edit Instance Parameters window. The Miscellaneous tab
has the following parameters:
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_1 ZMC - Edit default instance parameters

Edit default instance parameters

General | Loggingl Rights Miscellaneous |

Resource limits
File descriptor limit minimum: |pE[Se0]Y =
Process limit minimum: 256 =

Other options

SSL Crypto engine:

@ Cancel ‘ <ok |

Figure 6.15. Instance parameters — miscellaneous

m File descriptor limit minimum:
® Process limit minimum:

m SSL Crypto engine: The OpenSSL crypto engine to be used for hardware accelerated crypto support.

6.3.9. Procedure - Increasing the number of running processes

To increase the number of running processes in a Application-level Gateway instance, complete the following
steps.

Steps:

Step 1. Navigate to the Instances tab of the Application-level Gateway MC component on the PNS host.
Step 2. Select the instance you want to modify, and click Edit parameters.

Step 3. Uncheck the Use default parameters option.

Step 4. On the Generaltab, adjust the Number of processes option, and click Ok.

Step 5. Commit and upload your changes.

Step 6. Reload the instance.

Step 7. Start the instance.

6.4. Application-level Gateway services

Services define the traffic that can pass through the firewall. A service is not a software component, but a group
of parameters that describe what kind of traffic should Application-level Gateway accept and how to handle
the accepted traffic. The service specifies how thoroughly the traffic is analyzed (packet filter or application
level), the protocol of the traffic (for example, HTTP, FTP, and so on), if the traffic is TLS-encrypted (and also
related security settings like accepted certificates) NAT policies applied to the connections, and many other
parameters.
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Packet-filter services forward the incoming packets using the kzorp kernel module. Application-level services
create two separate connections on the two sides of Application-level Gateway (client—-Application-level
Gateway, Application-level Gateway—server) different connections and analyze the traffic on the protocol level.
Only application-level services can perform content filtering, authentication, and other advanced features.

Note
@ To allow IPSec traffic to pass PNS, you must add packet-filtering rules manually. See Procedure 16.3.3, Forwarding IPSec trdffic on
the packet level (p. 369) for details.

The following types of services are available in Application-level Gateway:

m Service: Inspects the traffic on the application level using proxies. For the highest available security,
use application-level inspection whenever possible. For details, see Procedure 6.4.1, Creating a new
service (p. 101)

m PFService: Inspects the traffic only on the packet level. Use packet-level filtering to transfer very
large amount of UDP traffic (for example, streaming audio or video). For details, see Procedure
6.4.2, Creating a new PFService (p. 104).

®m DenyService: To make a service unavailable for some reason (for example, because accessing it is
prohibited in certain zones), use DenyService. DenyService is a replacement for the umbrella zones
of earlier Application-level Gateway versions. For details, see Procedure 6.4.3, Creating a new
DenyService (p. 105).

m DetectorService: Attempts to determine the protocol used in the connection from the traffic itself,
and start a service specified. Currently it can detect HTTP, SSH, and SSL traffic. For HTTPS
connections, it can also select a service based on the certificate of the server. For details, see Procedure
6.4.4, Creating a new DetectorService (p. 107).

Services are managed from the Services tab of the Application-level Gateway MC component. The left side
of the tab displays the configured services, while the right side shows the parameters of the selected service.
Use this tab to delete unwanted services, modify existing ones, or create new ones.

6.4.1. Procedure - Creating a hew service

To create a new service that inspects a traffic on the application level, complete the following steps.
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Step ]_. | Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help |
Configuration = 9 1 & @ | @ Sh ‘

< [| Balabit IT Security
= [0l ZMSs-Host
Management agents

Firewall Rules Servicesl Policies | Proxies ‘ Instances ‘Advanced |

Service | =

Class: | Service

. DenyService
Management server Y

i Description:
Networking MyProxyService p I

1L

[ Packet filter MyPFService Proxy class: PlugProxy
vz Routing
VPN Router: |TransparentRouter(}

Chainer: IConnectChainer{)

Limit: |

NAT

Source NAT policy: I

R KA P P

Destination NAT policy: I

Authentication

Authentication policy: |

Ki[EN

Authorization policy: |

Authentication name: I

Advanced
Resolver policy: | Ll
Limit concurrency: |0 H instances
= Keepalive: Z_KEEPALIVE_NONE e |

[ 5] | [New | ®Qelete| Rename
y

Unsaved changes

Figure 6.16. Creating a new service

Navigate to the Services tab of the Application-level Gateway MC component and click New.

Step 2. Enter a name for the service into the opening dialog. Use clear, informative, and consistent service
names. You are recommended to include the following information in the service name:

m Source zones, indicating which clients may use the service (for example, intranet).
®m The protocol permitted in the traffic (for example, HTTP).

m Destination zones, indicating which servers may be accessed using the service (for example,
Internet).

Tip
Name the service that allows internal users to browse the Web intra_HTTP_internet. Use dots to indicate child zones,
for example, intra.marketing HTTP_inter.

Step 3. Click =/ in the Class field and select Service.

Step 4. In the Proxy class field, select the application-level proxy that will inspect the traffic. Only traffic
corresponding to the selected protocol and the settings of the proxy class can pass the firewall.
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Step 5.

Step 6.

Step 7.

Step 8.

Step 9.

Step 10.

Step 11.

Step 12.

Note
@ Application-level Gateway has many proxy classes available by default. These can be used as-is, or can be customized if
needed.

m For details on customizing proxy classes, see Section 6.6, Proxy classes (p. 133).

m The settings and parameters of the proxy classes are detailed in the Chapter 4, Proxies in Proxedo Network
Security Suite 1.0 Reference Guide.

m To permit any type of Layer 7 traffic, select PlugProxy. The PlugProxy is a protocol-independent proxy.

Optional Step: If the inspected traffic will be SSL or TLS-encrypted, select the Encryption Policy to
use in the Encryption Policy field. For details, see Section 6.7.3, Encryption policies (p. 149).

Optional Step: In the Routing section, select the method used to determine the IP address of the
destination server. For details, see Section 6.4.5, Routing — selecting routers and chainers (p. 109).

Optional Step: In the NAT section, the Network Address Translation policy used to NAT the address
of the client (SNAT), the server (DNAT), or both. For details, see Section 6.7.5, NAT policies (p. 157).

Note
@ To remove a policy from the service, select the empty line from the combobox.

Note
@ NAT policies cannot be used in PFServices for IPv6 traffic.

Optional Step: In the Chainer field, select the method used to connect to the destination server. See
Section 6.4.5, Routing — selecting routers and chainers (p. 109) for details.

Optional Step: To specify exactly which zones can be accessed using the service, click Routing >
Limit > ... and select the permitted zones. If this option is set, the target server must be located in the
selected zones, otherwise Application-level Gateway will reject the connection.

of the client-side connection.

Note
@ The zone set in the Limit option is the actual location of the target server. This is independent from the destination address
This option replaces the functionality of the inband_services parameter of the zone.

Optional Step: In the Authentication section, select the authentication and authorization policies used
to verify the identity of the client. See Chapter 15, Connection authentication and authorization (p. 330)
for details.

Optional Step: In the Advanced > Resolver policy field, select how Application-level Gateway should
resolve the addresses of the client requests. See Section 6.7.6, Resolver policies (p. 167) for details.

Optional Step: To limit how many clients can access the service at the same time, set the Advanced
> Limit concurrency option. By default, Application-level Gateway does not limit the number of
concurrent connections for a service (0).
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Step 13. Optional Step: To send keep-alive messages to the server, the client, or both, to keep the connection
open even if there is no traffic, set the Advanced > Keepalive option to Z KEEPALIVE SERVER,
Z_KEEPALIVE_CLIENT, or Z_KEEPALIVE_BOTH.

Step 14. Commit your changes.

6.4.2. Procedure - Creating a new PFService

To create a new packet-filter service that inspects a traffic on the packet level, complete the following steps.

Step ]__ | Zorp Management Consocle - admin@local-vbox
File Edit View Configuration Management PKI Help |
Configuration = | | ¢ & | @ f &~ ‘

<[] Balabit IT Security
= [0l ZMS-Host

Management agents

Firewall Rules Servicesl Policies | Proxies ‘ Instances ‘Advanced |

Service | 1

Denvservi Class: IService
Management server enyservice

i Description:
Networking MyProxyService p |

KAL)

[ Packet filter MyPFService Proxy class: PlugProxy
N Routing
Ve Router: ITransparentHouter(}

Chainer: Iconnettchainer()

Limit: |

NAT

Source NAT policy: I

Lol bl

Destination NAT policy: I

Authentication

Authentication policy: |

KI[EH

Authorization policy: |

Authentication name: |

Advanced
Resolver policy: | LI
Limit concurrency: IO H instances
= Keepalive: Z_KEEPALIVE_NONE [v |

[ 0] | [ New | ®Qelete| Rename

Unsaved changes

Figure 6.17. Creating a new service

Navigate to the Services tab of the Application-level Gateway MC component and click New.

Step 2. Enter a name for the service into the opening dialog. Use clear, informative, and consistent service
names. You are recommended to include the following information in the service name:

® Source zones, indicating which clients may use the service (for example, intranet).
m The protocol permitted in the traffic (for example, HTTP).

m Destination zones, indicating which servers may be accessed using the service (for example,
Internet).
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Tip
Name the service that allows internal users to browse the Web intra_HTTP_internet. Use dots to indicate child zones,
for example, intra.marketing_HTTP_inter.

Step 3. Click ~/in the Class field and select PFService.

Step 4. To spoof the IP address of the client in the server-side connection (so that the target server sees as if
the connection originated from the client), select the Use client address as source option.

Note
@ For IPv6 traffic, the PFService will always spoof the client address, regardless of the setting of the Use client address as
source option.

Step 5. To redirect the connection to a fixed address, select Routing > Directed, and enter the IP address and
the port number of the target server into the respective fields. You can use links as well.

Step 6. Optional Step: In the NAT section, the Network Address Translation policy used to NAT the address
of the client (SNAT), the server (DNAT), or both. For details, see Section 6.7.5, NAT policies (p. 157).

Note
@ To remove a policy from the service, select the empty line from the combobox.

Note
@ NAT policies cannot be used in PFServices for IPv6 traffic.

Step 7. Commit your changes.

6.4.3. Procedure - Creating a new DenyService

To create a new DenyService that prohibits access to certain services, complete the following steps.
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Step ]_. | Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help |
Configuration = 9 1 & D @ SN ‘

< [| Balabit IT Security
= [0l ZMSs-Host
Management agents

Firewall Rules Servicesl Policies | Proxies ‘ Instances ‘Advanced |

Service | =

Class: | Service

. DenyService
Management server Y

i Description:
Networking MyProxyservice p I

1L

[ Packet filter MyPFService Proxy class: PlugProxy
NG . Routing
VPN Router: |TransparentRouter(}

Chainer: IConnectChainer{)

Limit: |

NAT

Source NAT policy: I

R KA P P

Destination NAT policy: I

Authentication

Authentication policy: |

Ki[EN

Authorization policy: |

Authentication name: I

Advanced
Resolver policy: | Ll
Limit concurrency: |0 H instances
= Keepalive: Z_KEEPALIVE_NONE e |

[ 5] | [New | ®Qelete| Rename
>

Unsaved changes

Figure 6.18. Creating a new service

Navigate to the Services tab of the Application-level Gateway MC component and click New.

Step 2. Enter a name for the service into the opening dialog. Use clear, informative, and consistent service
names. You are recommended to include the following information in the service name:

m Source zones, indicating which clients may use the service (for example, intranet).
®m The protocol permitted in the traffic (for example, HTTP).

m Destination zones, indicating which servers may be accessed using the service (for example,
Internet).

Tip
Name the service that allows internal users to browse the Web intra_HTTP_internet. Use dots to indicate child zones,
for example, intra.marketing HTTP_inter.

Step 3. Click =/ in the Class field and select DenyService.
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Step 4.

Step 5.

_1 ZMC - Edit default instance parameters

Edit default instance parameters

General | Loggingl Rights Miscellaneousl

Resource limits

File descriptor limit minimum: 25600 EI

Process limit minimum: 256

Other options

SSL Crypto engine:

@) Cancel | <ok |

Figure 6.19. Configuring a DenyService

To specify how Application-level Gateway rejects the traffic matching a DenyService, use the Deny
IPv4 with and Deny IPv6 with options. By default, Application-level Gateway simply drops the traffic
without notifying the client.

Commit your changes.

6.4.4. Procedure - Creating a new DetectorService

To create a new DetectorService that starts a service based on the traffic in the incoming connection, complete
the following steps.
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Step ]_. | Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help |
Configuration = 9 1 & D @ SN ‘

< [| Balabit IT Security
= [0l ZMSs-Host
Management agents

Firewall Rules Servicesl Policies | Proxies ‘ Instances ‘Advanced |

Service | =

Class: | Service

. DenyService
Management server Y

i Description:
Networking MyProxyservice p I

1L

[ Packet filter MyPFService Proxy class: PlugProxy
NG . Routing
VPN Router: |TransparentRouter(}

Chainer: IConnectChainer{)

Limit: |

NAT

Source NAT policy: I

R KA P P

Destination NAT policy: I

Authentication

Authentication policy: |

Ki[EN

Authorization policy: |

Authentication name: I

Advanced
Resolver policy: | Ll
Limit concurrency: |0 H instances
= Keepalive: Z_KEEPALIVE_NONE e |

[ 5] | [New | ®Qelete| Rename
>

Unsaved changes

Figure 6.20. Creating a new service

Navigate to the Services tab of the Application-level Gateway MC component and click New.

Step 2. Enter a name for the service into the opening dialog. Use clear, informative, and consistent service
names. You are recommended to include the following information in the service name:

m Source zones, indicating which clients may use the service (for example, intranet).
®m The protocol permitted in the traffic (for example, HTTP).

m Destination zones, indicating which servers may be accessed using the service (for example,
Internet).

Tip
Name the service that allows internal users to browse the Web intra_HTTP_internet. Use dots to indicate child zones,
for example, intra.marketing HTTP_inter.

Step 3. In the Routing section, select the TransparentRouter option.

Step 4. Click -/ in the Class field and select DetectorService.
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Step 5.

_1 ZMC - Edit default instance parameters

Edit default instance parameters

General | Loggingl Rights Miscellaneous |

Resource limits

File descriptor limit minimum: |pESey =

Process limit minimum: 256 =

Other options

SSL Crypto engine: |

@) Cancel ‘ <ok |

Figure 6.21. Configuring a DetectorService

Step 6. Commit your changes.

Step 7. Navigate to Application-level Gateway > Firewall Rules, and create a firewall rule that uses the
DetectorService you created in the previous steps.

Step 8.

Click New, select a DetectorPolicy, and select a service that Application-level Gateway will start if
the traffic matches the DetectorPolicy. If you add more DetectorPolicy-Service pairs, Application-level
Gateway will evaluate them in order, and start the service set for the first matching DetectorPolicy. If
none of the DetectorPolicies match the traffic, Application-level Gateway terminates the connection.

.

Note

When using a DetectorService, establishing the connection is slower, because Application-level Gateway needs to evaluate
the content of the traffic before starting the appropriate service. If the rate of incoming connection requests that use the
DetectorService is high, the clients may experience performance problems during connection startup. Note that using a
DetectorService has no effect on the performance after the connection has been established.

6.4.5. Routing — selecting routers and chainers

Routers define the target IP address and port for the traffic. The default router, called TransparentRouter, uses
the IP address requested by the client. The destination selected by a router may be later overridden by the proxy
(if the Target address overridable by the proxy option of the router is enabled) and the chainer.

Routers suggest the destination IP; chainers establish the connection with the selected destination. The default
ConnectChainer simply connects the destination selected by the router.

6.4.5.1. Procedure - Setting routers and chainers for a service

To set a router or a chainer for a service, complete the following steps.
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Step 1. Navigate to the Services tab of the Application-level Gateway MC component and select the service
to modify.

Step 2.

Services |

Service |f

L

- Class: |service
DenyService

MyProxyService Description: |

MyPFService Proxy class: PlugProxy

O ap Routing

Router: |TransparentRouter(}

< |

Chainer: |Connectchainer(}

Limit: |

NAT

Source NAT pelicy: |

Destination NAT policy: |

Authentication

Authentication policy: ‘

Authorization policy: ‘

Authentication name: ‘

Advanced

KA KA KNS KK

Resolver policy: |

Limit concurrency: |G || instances

= Keepalive: Z_KEEPALIVE_NONE -

New | X) Delete| Rename ‘

Figure 6.22. Configuring routers and chainers

Click Router > ... to select and configure a router. By default, the TransparentRouter is selected. The
following routers are available:

B TransparentRouter

m DirectedRouter
® [nbandRouter
Step 3. Click Chainer > ... to select and configure a chainer. By default, the ConnectChainer is selected. The
following chainers are available:

m ConnectChainer

m FailoverChainer

B RoundRobinChainer

m SidestackChainer

Step 4. Commit your changes.
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6.4.5.2. TransparentRouter

TransparentRouter does not modify the IP address and TCP/UDP port number requested by the client; the same
parameters are used on the server side.

ZORP
Client Transparent Router Server
s —_— Requested Address: Reguested Address: -
~" 0 192.168.1.15:80 J192.1ss.1.15:an ~

Figure 6.23. Using the TransparentRouter

_1 ZMC - Edit class

=)
X

Edit value

Class: |TransparentRouter ll
[ Use client address as source

[ Target address overridable by the proxy

[] Modify target port to: |1 EI

Modify source port to: Random port above 1024 [v | Il EI

<Jok

Figure 6.24. Configuring TransparentRouter

Use client address as source

By default, Application-level Gateway uses its own IP address in the server-side connections: the server does
not see the IP address of the original client. By selecting this option, Application-level Gateway mimics the
original address of the client. Use this option if the server uses IP-based authentication, or the address of the
client must appear in the server logs.

®

Note
This option was called Forge address in earlier versions of PNS.
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FORGE Address
ENABLED
—= L“‘Fannnlllllllllllll.l'h o -
' ——y—! lient rve i 3
S— y IPciien IPserve IPciient IPserver =
il e
Client S
en FORGE Address erver
DISABLED
G -\ ~—
= I j*—-----b— o s
s =—|Pciient IPserve y
- ien erve IPzore IPserver =

Figure 6.25. Using the client address in server-side connections

Note
@ The IP address of the client is related to the source NAT (SNAT) policy used for the service: using SNAT automatically enables the Use
client address as source option in the router.

Target address overridable by the proxy
If this option is selected and the data stream in the connection contains routing information, than the address
specified in the data stream is used as the destination address of the server-side connection.

— Example 6.5. Overriding the target port SQLNetProxy

% The Oracle SQLNet protocol can request port redirection within the protocol. Configure a service using the SQLNetProxy and the Target
| e—] address overridable by the proxy router option. When a client first connects to the Oracle server, the connection is established to the
IP address and port selected by the router. However, the server can send a redirect request to the client, and the router has to reconnect
to the port specified in the request of the Oracle server. This procedure is performed transparently to the client.

Note
@ The Target address overridable by the proxy option cannot be used with InbandRouter.

This option was called Overridable in earlier versions of PNS.

Modify target port
Use the Modify target port option to connect to a different port of the server.
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ZORP
FORCED PORT
. setin the
Client Transparent Router: 93 Server
— Requested Address: Requested Address: .
.~ 192.168.1.15:80 192.168.1.15:93 B

Figure 6.26. Using TransparentRouter with the Modify target port option

Modify source port

This option defines the source port that Application-level Gateway uses in the server-side connection. The
following options are available:

B Random port above 1024: Selected a random port between 1024 and 65535. This is the default
behavior of every router.

B Random port in the same group: Select a random port in the same group as the port used by the
client. The following groups are defined: 0-513, 514-1024, 1025-.

m Client port: Use the same port as the client.

m Specified port: Use the port set in the spinbutton.

1 ZMc - Edit class =1
Edit value
Class: |TransparentRDuter ll
[ Use client address as source
[] Target address overridable by the proxy
[] Modify target port to: Il EI
Modify source port to: Random port above 1024 [v | |1 EI
<Jok

Figure 6.27. Modifying the source port

Note
This option was called Forge port in earlier versions of PNS.

®

6.4.5.3. DirectedRouter

DirectedRouter directs all connections to fixed addresses, regardless of the address requested by the client.
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ZORP
Address set in the
Directed Router:

Client 10.50.4.32:93 Server
}—-————h I — — —— -
- Requested Address: Requested Address: .
—~  192.168.1.15:80 10.50.4.32:93 —

Figure 6.28. Using the DirectedRouter

_1 ZMC - Edit class @
Edit value
Class: IDirectedRouter ﬂ

[ Use client address as source

[] Target address overridable by the proxy
Modify source port to: Random port above 1024 [v | Il EI

Destination Address | Description |
192.168.25.25:2525

elete |

| HE
@ Cancel | <ok |

Figure 6.29. Configuring DirectedRouter

| | New |

To add a destination address, click New, and enter the IP address and port number of the server to connect to.
If you set additional addresses, and the first address is unreachable, Application-level Gateway tries to connect
the next server. It is also possible to connect to the listed destinations in a round-robin fashion, see Section
6.4.5.7, RoundRobinChainer (p. 120) for details.

Tip
Use DirectedRouter for servers publicly available in the DMZ. That way outsiders do not know the real IP addresses of the servers —
the servers are not even required to have public, routable IP addresses.

DirectedRouter has the following options.

Use client address as source

By default, Application-level Gateway uses its own IP address in the server-side connections: the server does
not see the IP address of the original client. By selecting this option, Application-level Gateway mimics the
original address of the client. Use this option if the server uses IP-based authentication, or the address of the
client must appear in the server logs.
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Note
This option was called Forge address in earlier versions of PNS.

®

FORGE Address

ENABLED
(i -\ -
= i A—-----b ] — ——
*  —==m—|FClient rve i 3 .
S— y lpC'E‘” |PS"W" |PLI|ent |Pber~.rer
S

Client FORGE Address Server

DISABLED
r— -\ =
pC“E‘llt |PServe IPzorr IPserver =
i By

Figure 6.30. Using the client address in server-side connections

Note
@ The IP address of the client is related to the source NAT (SNAT) policy used for the service: using SNAT automatically enables the Use
client address as source option in the router.

Target address overridable by the proxy
If this option is selected and the data stream in the connection contains routing information, than the address
specified in the data stream is used as the destination address of the server-side connection.

— Example 6.6. Overriding the target port SQLNetProxy

— | The Oracle SQLNet protocol can request port redirection within the protocol. Configure a service using the SQLNetProxy and the Target
| w— address overridable by the proxy router option. When a client first connects to the Oracle server, the connection is established to the
IP address and port selected by the router. However, the server can send a redirect request to the client, and the router has to reconnect
to the port specified in the request of the Oracle server. This procedure is performed transparently to the client.

Note
@ The Target address overridable by the proxy option cannot be used with InbandRouter.

This option was called Overridable in earlier versions of PNS.

Modify source port
This option defines the source port that Application-level Gateway uses in the server-side connection. The
following options are available:

® Random port above 1024: Selected a random port between 1024 and 65535. This is the default
behavior of every router.

B Random port in the same group: Select a random port in the same group as the port used by the
client. The following groups are defined: 0-513, 514-1024, 1025—.

www.balasys.hu 115



Routing — selecting routers and chainers e

m Client port: Use the same port as the client.

m Specified port. Use the port set in the spinbutton.

_1 ZMC - Edit class

(=)
X

Edit value

Class: ITransparentRouter ll
[ Use client address as source

[] Target address overridable by the proxy

[ Modify target port to: II—E’

Modify source port to: Random port above 1024 [v | |1 EI

Figure 6.31. Modifying the source port

Note
This option was called Forge port in earlier versions of PNS.

®

6.4.5.4. InbandRouter

_1 ZMC - Edit class =15
Edit value
Class: IInbandRouterI ﬂ
[1 Use client address as source
Modify source port to: Random port above 1024 [v | I 1 EI

g.gancel | QﬂgK |

Figure 6.32. Configuring InbandRouter

InbandRouter determines the target address from information embedded in the transferred protocol. This is
possible only for protocols that can have routing information within the data stream. Application-level Gateway
can use InbandRouter with the HTTP and FTP protocols. InbandRouter has the following options.
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Use client

By default,

address as source
Application-level Gateway uses its own IP address in the server-side connections: the server does

not see the TP address of the original client. By selecting this option, Application-level Gateway mimics the
original address of the client. Use this option if the server uses IP-based authentication, or the address of the
client must appear in the server logs.

@]

®

Note
This option was called Forge address in earlier versions of PNS.

FORGE Address

ENABLED
(R 2\ -
= i A—-----b o -
o =—|PClient srve i ; -
S y 1en IPserve IPciient IPserver =
L
Client S

en FORGE Address erver

DISABLED
(G -\ =
— | j*—-----b— o -
s —=—|Pclient srve . -
- B ien IPserve IPzore IPserver =
_— —

Figure 6.33. Using the client address in server-side connections
Note

The IP address of the client is related to the source NAT (SNAT) policy used for the service: using SNAT automatically enables the Use
client address as source option in the router.

Modify source port
This option defines the source port that Application-level Gateway uses in the server-side connection. The

following options are available:

Random port above 1024: Selected a random port between 1024 and 65535. This is the default
behavior of every router.

Random port in the same group: Select a random port in the same group as the port used by the
client. The following groups are defined: 0-513, 514-1024, 1025-.

Client port: Use the same port as the client.

Specified port: Use the port set in the spinbutton.
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1 ZMC - Edit class

o]
&

Edit value

Class: |TransparentRouter ll
[ Use client address as source

[] Target address overridable by the proxy

[] Modify target port to: Il EI

Modify source port to: Random port above 1024 [v | |1 EI

!.gancel

<ok

Figure 6.34. Modifying the source port

Note
This option was called Forge port in earlier versions of PNS.

®

6.4.5.5. ConnectChainer

ConnectChainer attempts to connect the destination defined by the router. It terminates the connection if the
destination server is unreachable. ConnectChainer has the following options.

Connection timeout
Assume that the server is unreachable if it cannot be connected for Connection timeout seconds.

Protocol action
The type of the protocol used in the server-side connection. The default is to use the same protocol as on the
client side, but PNS can enforce the use of the TCP or the UDP protocol.
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6.4.5.6. FailoverChainer

"] ZMC - Edit class |5¢]

Edit value

Class: |Fai|0\.ferchainer ﬂ

Connection policy

Keep availability state for {60000  [;| msecs.

Connection timeout is 30000 |:| msecs.

Protocol

Action: Do not change v ‘

@ Cancel ‘ <ok |

Figure 6.35. Configuring FailOverChainer

FailoverChainer is similar to ConnectChainer, and attempts to connect the destination defined by the router.
However, if the destination is unreachable and the service uses DirectedRouter, Application-level Gateway
attempts to connect the next destination set in the router.

Tip
FailoverChainer can be used to implement a simple high availability support for the protected servers.

FailoverChainer has the following options.

Keep availability state for
Application-level Gateway does not try to connect to an unreachable server until the time set in the Keep
availability state for option expires.

Connection timeout
Assume that the server is unreachable if it cannot be connected for Connection timeout seconds.

Protocol action
The type of the protocol used in the server-side connection. The default is to use the same protocol as on the
client side, but PNS can enforce the use of the TCP or the UDP protocol.
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6.4.5.7. RoundRobinChainer

_1 ZMC - Edit class ]

Edit value

Class: |R0undR0binChaine|1 ﬂ

Connection policy

Keep availability state for {60000 [,| msecs.

Connection timeout is 30000 |5| msecs.

Protocol

Action: Do not change - ‘

@ Cancel ‘ <ok |

Figure 6.36. Configuring RoundRobinChainer

RoundRobinChainer is similar to FailoverChainer, but Application-level Gateway directs each incoming
connection to the next available server. That way the load is balanced between the servers set in the destination
list of the router. Use RoundRobinChainer together with DirectedRouter.

Tip
RoundRobinChainer can be used to implement simple load balancing for the protected servers.

RoundRobinChainer has the following options.

Keep availability state for
Application-level Gateway does not try to connect to an unreachable server until the time set in the Keep
availability state for option expires.

Connection timeout
Assume that the server is unreachable if it cannot be connected for Connection timeout seconds.

Protocol action
The type of the protocol used in the server-side connection. The default is to use the same protocol as on the
client side, but PNS can enforce the use of the TCP or the UDP protocol.
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6.4.5.8. SidestackChainer

1 ZMC - Edit class

Edit value

Class: |SideStackChainer ﬂ

Side stacked proxy |

HttpProxy

dgit | jj

Einal chainer: IConnectchainer{protocoI=ZD_PROT -

@ Cancel | <ok |

Figure 6.37. Configuring SidestackChainer

SidestackChainer does not connect to the server, but passes the traffic to the specified proxy. It is possible to
sidestack several proxies that way. Application-level Gateway connects to the server using a regular chainer
after the proxy processes the traffic. SidestackChainer has the following options.

Side-stacked proxy
The proxy class that will process the traffic. To select a proxy, click New, select a proxy class, then click Select.

Final chainer
The chainer used when connecting the server.

6.5. Configuring firewall rules

6.5.1. Understanding Application-level Gateway firewall rules

Application-level Gateway firewall rules are managed on the <Host> > Application-level Gateway > Firewall
Rules page. The following information is displayed for every rule:
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[ | Zorp Management Console - admin@local-vbox

File Edit View Configuration Management PKI Help

Configuration 2R | & @ @ y Q.

~ [] Balabit IT Security

Firewall Rules | Services | Policies | Proxies | Instances |Aduanced |
< [0 ZM5-Host

o A .
Management agents |~ None [' | || | | Edit bookmarksl
Managementserver feng, | Id |VPN | Source Iface. | Source Iface. Group | Protocoll Source Port | Dest. Port | Source Zor —
Networking -
9 1 TCP intranet
Packet filter
VPN

-

I |

| Active connections| -z Export to CSV

|Unsaved changes

Figure 6.38. Configuring SidestackChainer

Note
@ Not every column is displayed by default. To show or hide a particular column, right-click on the header of the table and select the
column from the menu.

B Active: Shows if the rule is enabled or disabled.
m ID: The unique ID number of the firewall rule.

m Tags: The tags (labels) assigned to the firewall rule. For details on assigning tags to rules, see
Procedure 6.5.5, Tagging firewall rules (p. 130).

® Protocol: The transport protocol used in the connection. This is the protocol used in the transport
layer (Layer 4) of the OSI model. For example, TCP, UDP, ICMP, and so on.

®m VPN: The rule permits traffic only from the listed VPN connections (or IPSec connections with the
specified Request ID).

m Source Zone/Subnet: The rule permits traffic only for the clients of the listed zones and subnets.
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m Source Port: The rule permits traffic only for connections targeting the listed ports of the firewall
host.

m Destination Zone/Subnet: The rule permits traffic only for connections that target addresses of the
listed zones and subnets.

B Destination Interface/Group: The rule permits traffic only for connections that target an existing
IP address of the selected interface (or interface group) of the firewall host. This parameter can be
used to provide nontransparent service on an interface that received its IP address dynamically.

m Destination Port: The rule permits traffic only for connections that target the listed ports of the
destination address.

m Service: The name of the service used to inspect the traffic.
® Instance: The service started by the rule belongs to the instance shown.

m Description: The description of the rule.

6.5.1.1. Evaluating firewall rules

When Application-level Gateway receives a connection request from a client, it tries to select a rule matching
the parameters of the connection. The following parameters are considered.

Name in MC Name in policy.py
VPN reqid

Source Interface src_iface
Source Interface Group src_ifgroup
Protocol proto

Source Port src_port
Destination Port dst_port
Source Subnet src_subnet
Source Zone src_zone
Destination Subnet dst_subnet
Destination Interface dst_iface
Destination Interface Group dst_ifgroup
Destination Zone dst_zone

Table 6.1. Evaluated Rule parameters

Application-level Gateway selects the rule that most specifically matches the connection. Selecting the most
specific rule is based on the following method.
m The order of the rules is not important.

m The parameters of the connection act as filters: if you do not set any parameters, the rule will match
any connection.

m If multiple connections would match a connection, the rule with the most-specific match is selected.
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For example, you have configured two rules: the first has the Source Zone parameter set as the
office (which is a zone covering all of your client TP addresses), the second has the Source
Subnet parameter set as 192.168.15.15/32. The other parameters of the rules are the same. If a
connection request arrives from the 192.168.15. 15/32 address, Application-level Gateway will
select the second rule. The first rule will match every other client request.

m Application-level Gateway considers the parameters of a connection in groups. The first group is
the least-specific, the last one is the most-specific. The parameter groups are listed below.

m The parameter groups are linked with a logical AND operator: if parameters of multiple groups are
set in a rule, the connection request must match a parameter of every group. For example, if both
the Source Interface andDestination Port is set, the connection must match both parameters.

m Parameters within the same group are linked with a logical OR operator: if multiple parameters of
a group are set for a rule, the connection must match any one of the parameters. If there are multiple
similar rules, the rule with the most-specific parameter match for the connection will be selected.

Note
@ In general, avoid using multiple parameters of the same group in one rule, as it may lead to undesired side-effects. Use
only the most-specific parameter matching your requirements.

For example, suppose that you have a rule with the Destination Zone parameter set, and you want to create a similar
rule for a specific subnet of this zone. In this case, create a new rule with the Destination Subnet parameter set, do
not set the Destination Zone parameter in both rules. Setting the Destination Zone parameter in both rules and
setting the Destination Subnet parameter in the second rule would work for connections targeting the specified subnet,
but it would cause Application-level Gateway to reject the connections that target other subnets of the specified destination
zone, because both rules would match for the connection.

m The parameter groups are the following from least-specific to most-specific. Parameters within each
group are listed from left-to-right from least-specific to most-specific.

1. Destination Zone > Destination Interface Group > Destination Interface >
Destination Subnet

2. Source Zone > Source Subnet

3. Destination Port (Note that port is more specific than port range.)
4. Source Port (Note that port is more specific than port range.)

5. Protocol

6. Source Interface Group > Source Interface > VPN

m If no matching rule is found, Application-level Gateway rejects the connection.

®

Note
It is possible to create rules that are very similar, making debugging difficult.
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6.5.2. Transparent and non-transparent traffic

Application-level Gateway can handle traffic both transparently and non-transparently. In transparent mode,
the clients address the destination servers directly, without being aware that the traffic is handled by
Application-level Gateway. In nontransparent mode, the clients address Application-level Gateway, that is, the
destination address of the client's connection is an IP address of the firewall host, and Application-level Gateway
determines the address of the destination server.

There are two methods to determine the destination address in nontransparent mode:

m Inband destination selection: Application-level Gateway can extract the destination address from
the incoming traffic itself. This method is currently supported for HTTP and FTP connections. For
examples, see Section 6.5.6, Configuring nontransparent rules with inband destination
selection (p. 132).

m Redirection: Application-level Gateway can redirect the traffic to a fix destination address.

6.5.3. Procedure - Finding firewall rules

Step 1. Navigate to the Firewall Rules tab of the Application-level Gateway MC component.

Step 2. 1 Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help |
i N e == o [
Configuration = &3 | &= 08 | T @& ‘
~ [ Balabit IT Security ) = -
Firewall Rulesl Services | Policies | Proxies | Instances |Advanced |
= [0 zMs-Host
i1 .
Management agents | None Ivl | I | 2 | Edit bookmarksl
Management server
: g Ena ‘ d |VPN ‘Source face ‘Source face. Group |9ro:om |Source Port ‘:Jes: Port |Source Zor —|
Networking
werking H 1 TCP ntranet
Packet filter
& ven
| 0
New ‘ £ ‘ 3 ‘ Active connections Export to CSV
| [] 2
Unsaved changes

Figure 6.39. Finding rules

Use the filter bar above the rule list to find rules. The use of the filter bar is described in Section 3.3.10,
Filtering list entries (p. 47). You can search for the parameters listed in Section 6.5.1, Understanding
Application-level Gateway firewall rules (p. 121).
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Step 3. Press Enter. The rules matching your search criteria are displayed.

Note
To save the list of

®

matching rules into a file, click Export to CSV. Note that only the visible columns will be included in

the file, in the order they are displayed.

6.5.4. Procedure - Creating firewall rules

Purpose:

Firewall rules allow a specific type of traffic to pass the firewall. To create a new firewall rule, complete the

following steps.
Steps:

Step 1.

File Edit View Configuration

| Zorp Management Console - admin@local-vbox

Management PKI Help |

Configuration

a | 1§ & @ | @ f &\ ‘

< [] Balabit IT Security
= [0 ZMSs-Host
Management agents
Management server
Networking
Packet filter

[E veN

| o=

Firewall Rulesl Services |PO|\CIES |Proxwe5 |In5taﬂce5 |Advanced |

None Ivl || 8'§}| "l Edit bookmarksl
Ena. ‘ Id ‘ VPN ‘ Source Iface. ‘ Source Iface. Group | Protocol | Source Port ‘ Dest. Port | Source Zor —
] 1 TCP ntranet
[+ 2 IPSec TCP
[ o]
New | {3 ‘ r ‘ Active connections Export to CSV

lUnsaved changes

Figure 6.40. Creating firewall rules

Login to MS and select <Host> > Application-level Gateway > Firewall Rules > New. A new window

opens.
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Step 2. _] ZMC - New rule

New rule

Enabled

Description: ||

Conditions | Service | Tags |

Conditions of connection matching

Transport protocol: TCP (default) |« [No.: |6

Sources:

Name |Value |L %3 Delete

Destinations: =
Name |Value | = &

Delete

@ Cancel ‘ <ok |

Figure 6.41. Setting connection parameters

Select the Conditions tab.

Step 3. Select the Transport protocol used in the connection. This is the protocol used in the transport layer

(Layer 4) of the OSI model. The following protocols are supported: TCP, UDP, ICMP, IGMP, DCCP,
GRE, ESP, AH, SCTP, and UDP-Lite.

m To permit both TCP and UDP traffic, select TCP or UDP.
®m To permit any Layer 4 protocol, select Any.
m For ICMP traffic, you can specify the permitted type and subtype (code) as well.
Step 4. Select the sources.  Application-level Gateway can limit the traffic that can pass the firewall only
to traffic that comes from selected source networks. To permit traffic only from specific networks,

select Sources > Add > <Type-of-network>. You can select zones, IPv4 or IPv6 subnets, interfaces,
interface groups, and ports. Use always the most specific source suitable for your rule.

®

Note
To specify multiple ports, separate the ports with a comma, for example: 80, 443
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To specify a port range, use a colon, for example: 2000: 2100

To specify multiple port ranges, separate the port ranges with commas, for example: 2000:2100, 2200 : 2400.

Step 5. Select the destinations.  Application-level Gateway can limit the traffic that can pass the firewall
only to traffic that is targeting selected destination addresses. To permit traffic only to specific networks,
select Destinations > Add > <Type-of-network>. You can select zones, IPv4 or IPv6 subnets,
interfaces, interface groups, and ports. Use always the most specific destination suitable for your rule.

Note
@ For rules that start nontransparent services, set the destination address and the port to an address of the firewall host.

Note
@ To specify multiple ports, separate the ports with a comma, for example: 80, 443
To specify a port range, use a colon, for example: 2000: 2100

To specify multiple port ranges, separate the port ranges with commas, for example: 2000:2100, 2200 : 2400.

Note
@ Starting with Application-level Gateway 3 F5, it is not mandatory to set the sources and destinations. Sources and destinations
act as a filter, they limit access to the clients or servers of the sources and destinations. A firewall rule without sources and
destinations acts as a rule that simply forwards traffic between any client and destination.
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Step 6. ] ZMC - New rule
New rule
Enabled
Description: |
Conditions Service | Tags |
Service provided by this rule
Service: MyProxyService v‘ Create new... ‘
Class: |Sen.rice ﬂ
Description: | J
Proxy class: PlugProxy - ‘
Routing Authentication
Router: |TransparentRouter() J Authentication policy: | v
Chainer: |Connectchainer() J Authorization policy: | v
Limit: | J Authentication name: |
NAT Advanced
Source NAT policy: | v Resolver policy: | v
Destination NAT policy: | - Limit concurrency: 0 ~| instances
Keepalive: Z_KEEPALIVE_NONE - |
Run in this instance: main v ‘ Create new... ‘
!. Cancel Qﬂ OK ‘

Figure 6.42. Selecting the service

Select the service to use. Select Service > Service and select the service to start for connections
matching the rule. The service determines type of traffic that will be permitted by this rule (for example,
HTTP, FTP, and so on) and also the level the traffic will be inspected (application or packet-filter
level).

Note
@ Proxy services can be used only if the Condition > Transport protocol option is set to TCP, UDP, or TCP or UDP.

Warning
A The settings and parameters of the service shown on the Service tab of the rule are for reference only. Do not modify them,
because it might interfere with other rules using the same service. To modify the parameters of a service, or to create a new
service, use the Services tab of the Application-level Gateway MC component.

Step 7. Select the instance the service should run in.
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Step 8. Optional Step: By default, new rules become active when the configuration is applied. To create a rule
without activating it, deselect the Active option of the rule.

Step 9. Optional Step: To limit the number of connections that can be started by the rule, configure rate limits
for the connections. For details, see Procedure 6.5.7, Connection rate limiting (p. 132).

Step 10. Click OK, then commit your changes.
Expected result:

A new firewall rule is created and added to the list of firewall rules. If the rule is active, the traffic
specified in the rule can pass the firewall.

6.5.5. Procedure - Tagging firewall rules

Purpose:

To add a tag to a firewall rule, complete the following steps. Tagging rules is useful, for example, to identify
rules that belong to the same type of traffic.

Steps:

Step 1. Navigate to <Host> > Application-level Gateway > Firewall Rules.

Step 2. i 1 Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help |
Configuration :| ol L &= @ @R SN ‘
~ [] Balabit IT Security - = =
Firewall Rules | Services | Policies | Proxies ‘ Instances ‘Advanced |
= [0 ZMS-Host
Management agents ~ None v| || ﬂ;| | Edit bookmarks
Management server Ena | Id |VP'\J |50urce Iface |50urce Iface. Group | Protocol | Source Port | Dest. Port |Source Zor —|
Networking
d M 1 TCP ntranet
Packet filter
VPN
| 0|
New | Delete | 7 Edit | Active connections Export to CSV
[ [»] =
Unsaved changes

Figure 6.43. Editing rules

Select the rule to tag and click Edit
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Step 3. 1 ZMC - Edit rule

Edit rule

[+] Enabled

Description: |

Conditions | Service Tags

Tags assigned to this rule

Available tags

Assigned tags
Filter: | Name ]
Name —
http
office

Assign -> |
<- Unassign |

annce‘ OK |

Figure 6.44. Tagging rules

Click Tags. The list of available tags is displayed on the left; the tags assigned to the rule are displayed
on the right.

m To create a new tag, click New, enter the name of the tag, then click OK.

m To assign a tag to the rule, select a tag and click Assign.

Note
Tags that are already assigned to the rule are not shown in the Available tags list.

®

Step 4. Click OK, then commit your changes.
Expected result:

The selected tags are assigned to the rule.
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6.5.6. Configuring nontransparent rules with inband destination selection

When using inband destination selection, Application-level Gateway extracts the address of the destination
server from the traffic. Note the following points:

m For HTTP connections, create a firewall rule that uses a nontransparent HTTP proxy and inband
destination selection. Also, set the web browsers of the clients to use Application-level Gateway as
a web proxy.

m If the clients use a caching web proxy for HTTP traffic, for example, Squid, and Application-level
Gateway is located between the clients and the web proxy, then:

* Create a firewall rule that uses a nontransparent HTTP proxy.

» Set the parent_proxy and parent_proxy_port attributes of the proxy to the address of the
caching proxy.

» Use a DirectedRouter in the service to redirect the connections to the caching proxy, or use inband
destination selection.

6.5.7. Procedure — Connection rate limiting

Purpose:

To limit the maximum rate of new connections to prevent Denial of Service (DoS) attacks, configure the
connection rate limiting options on the Limits tab of the firewall rule. You can specify the number of connections
that Application-level Gateway accepts within a given time period. Connection requests above this maximum
rate are denied.

Steps:

Step 1. Navigate to <Host> > Application-level Gateway > Firewall Rules.
Step 2. Select the rule to edit, then click Edit > Limits

Step 3. Click Enable rate limiting, then set the maximum number of permitted connection requests (per
second) in the Maximum average match rate field.
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Enabled

Description: |

Conditions | Service | Tags Limits

Connection rate limiting

Enable rate limiting

Maximum average match rate: |3 | ¢ second |w

Match packet destination IP address
Match packet destination port

[J Match packet source IP address

[] Match packet source port

Number to match in a burst: 5

Number of hashtable buckets: 20438 =
Number of hashtable entries: 16384 =
Interval between garbage collection runs: | 1000 | msecs
Idle entries expiration time: 10000 * msecs

&/ 0K

@gancel

Figure 6.45. Connection rate limiting

Step 4. ® To limit the rate of connections based on the destination in the connection requests, select
Match packet destination IP address.

m To limit the rate of connections based on the source of the connection requests, select Match
packet source IP address.

Step 5. Set other parameters as needed for your environment.

6.6. Proxy classes

A proxy component is responsible for analyzing, filtering and possibly modifying the data that is passed through
it.

Proxies work with data streams they receive as input and emit another (possibly altered) data stream as output.
They never actually see “traffic” in the traditional sense; the details of connection establishment and management
are handled by separate software components. Therefore, proxies can easily interoperate with each other or
with other non-firewall software like virus filters, since data is passed among them as simple data stream.

A proxy class is the low level proxy and its configuration settings. Proxy classes are responsible for analyzing
and checking the data part of packets and passing it between the client and the server. Proxy classes can be
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used in service definitions. Together with the other components configured as service parameters (for example,
routers) they can be used to analyze/filter communication channels among network hosts. Most proxy classes
are protocol-specific, meaning that they are aware of the protocol-specific information within the data stream
they are processing.

There are built-in proxy classes for the most typical network traffic types, like HTTP, FTP, POP3, SMTP,
telnet, and also for some less frequently used protocols, like NNTP and LDAP. They can be used in service
definitions without modifications of the default class properties and their values. See the Proxedo Network
Security Suite 1.0 Reference Guide for details.

Note
@ Proxies in Application-level Gateway are fully RFC-compliant so a traffic that pretends to be of a certain type but violates RFC
specifications concerning the given traffic type are not proxied but automatically denied instead. For example, the HTTP proxy enforces
by default the RFCs for HTTP (2616 and 1945).

— Example 6.7. RFC-compliant proxying in Application-level Gateway

—— | A good example for this rule is the CODE RED worm that infected so many IIS servers around the World: the heart of this worm was
| w— ] a specially formatted URL request which was not RFC-compliant but was nevertheless serviced by IIS servers that had not been patched
against it. Most firewall products, even application proxy firewalls let it pass through and only the most accurate ones, like Application-level
Gateway, stopped the worm, because its URL request violated RFC rules that everyone should accept and implement correctly.

If using default proxy classes and property values is not enough, it is possible to derive new classes from the
original ones. Derived proxy classes inherit all the properties of the original (parent) classes and these properties
can then be altered. The number of configurable parameters varies among proxies; proxy for HTTP traffic has
the most. It is completely up to you whether you use them in your firewall's policy settings.

Note
@ Whenever you start customizing a proxy, you do not actually create a new proxy, but derive a proxy class from the selected built-in
proxy implementation and configure different settings for it. You only modify the configuration, not the proxy module itself.

6.6.1. Customizing proxies

Default proxy classes provide an adequate level of security. You typically derive your own classes if you want
to change the values of certain attributes, like manually setting the contents (like browser type, operating system)
of the request headers leaving the HTTP proxy. Complex proxy setups —such as virus filtering of HTTP, SMTP,
traffic or proxy stacking — also require derived classes.

This process is somewhat complex involving many steps; therefore will be demonstrated using an example of
changing the User -Agent HTTP request header output by a custom HTTP proxy component.

The customized proxy class you are defining is based on an already defined proxy class. There are quite a lot
of predefined proxy classes that are available by default. For some protocols (for example HTTP and FTP)
there are more than one to choose from, each with a specific intended purpose. FtpProxyRO0, for instance, is
for read-only FTP access, while FtpProxyRW is for read/write FTP access.
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6.6.1.1. Procedure - Derive a new proxy class

Step 1. f | Zorp Management Console - admin@local-vbox
File Edit View Configuration Management PKI Help |
Configuration 2] g & O |T_|§\ <8 ‘

< [| Balabit IT Security
= [0 ZMS-Host
Management agents | Proxy Name | Parent | Description |

Firewall Rules |Services |Pol\cies Proxiesl Instances |Advanced

Management server
Networking
Packet filter

VPN

|_1HEW | (x) Delete ' Edit Description

Changed config attributes

: |Attribute ‘T‘,‘pe Value

[ I

Unsaved changes

Figure 6.46. Deriving new proxy classes
Select the Proxies tab of the Application-level Gateway component.

The Application-level Gateway class configuration window that appears is, by default, empty.

Step 2. Click New.

Step 3. Select a predefined proxy class template for the customized proxy class.
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Figure 6.47. Default proxy templates

Proxy class names are typically descriptive, but most of them comes with a detailed description as
well. For more details, see the Proxedo Network Security Suite 1.0 Reference Guide. These descriptions
either explicitly tell what the given proxy class is for or suggest attributes of the class that can be
configured to achieve a special purpose.

Step 4. Enter a name for the new proxy. You are recommended to use capital names that imply the functions
the proxy is responsible for, for example VirusHTTP or HTTPSproxy.

Step 5. Add the attributes to be configured and modify attribute values for the given class. For details, see
Procedure 6.6.1.2, Customizing proxy attributes (p. 136).

®

Note
To have the new proxy class fully functional, you have to configure it as a service parameter of the given service.

6.6.1.2. Procedure — Customizing proxy attributes

What attribute-level configuration is needed depends on the exact requirements: if you simply need an FTP
proxy that denies upload (write) requests, use the Ft pProxyRO0 without modifications in your policy definitions
— deriving a new class is unnecessary in this case.

However, if you would like to hide the browser type and operating system version information of your clients
you can do it with a derived proxy class, by customizing some of its attributes. To hide browser type and
operating system version information for instance, the creation of a custom User -Agent header is required.
Although this may be accomplished on the client side (modifying all client web browsers), it is much easier to
do with PNS.

The attributes configuration screen is divided into two main parts.

www.balasys.hu 136


../../pns-guide-reference/pdf/pns-guide-reference.pdf#zorp-guide-reference

Customizing proxies e

[ ] Zorp Management Console - admin®@local-vbox (=

File Edit View Configuration Management PKI Help |

Configuration 2| 1 % & D | @ 7 X & ‘

~ [] Balabit IT Security
= [I0[] zMs-Host

Firewall Rules |Services |POI\cies meiesl Instances |Advanced |

Management agents | Proxy Name Parent Description =
Management server [V IUT S yluislgye) 375
[E] Netwarking MyPop3Proxy Pop3Proxy

[E] Packet filter

[E] vPN =

New | (x) Delete " Edit Description

Changed config attributes

: |Attribute ‘Type |Va|ue —

| New | & ‘ i |

[ 0]
Unsaved changes

Figure 6.48. Customizing proxy attributes

The upper textbox shows the list of custom, derived proxies along with the classes they were derived from (the
Parent column). For the previous screenshot a simple HttpProxy, called MyHt t pProxy was derived from the
generic HttpProxy class.

Step 1. Navigate to Application-level Gateway > Proxies and select the proxy to customize.

Step 2. Click New under the lower table. The list of configurable attributes are displayed.
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self.use_default_port_in_transparent_mode boolean

Set the target port to the value [

Name {vpe Description =
self.permit_server_requests boolean Allow server type requests in no|
self.permit_proxy_requests boolean Allow proxy type requests in trar
selfpermit_ftp_over_http boolean Allow processing FTP URLs in not
self.permit_unicode_url boolean Allow unicode characters in URL:
self.permit_invalid_hex_escape boolean Allow invalid hexadecimal escap
self.permit_http09_responses boolean Allow server responses to use th
self permit_both_connection_headers boolean Some clients send both a Conne
selfkeep_persistent boolean Try to keep the connection to the
self.parent_proxy qgstring The address er hostname of the
self.parent_proxy_port int The port of the parent proxy to k
self default_port int This value is used in non-transps

self.use_canonicalized_urls boolean This attribute enables URL canot
self.rewrite_host_header boolean Rewrite the Host header in reque
selfrequire_host_header boolean Require the presence of the Hos
selfstrict_header_checking boolean Require RFC conformant HTTP he
self.permit_null_response boolean Permit RFC incompliant respons
self.max_hostname_length int Maximum allowed length of the
selfmax_line_length int Maximumn allowed length of lines
self max_url_length int Maximum allowed length of an L
self max_body_length int Maximum allowed length of an
self.max_chunk_length int Maximum allowed length of a sir =]
| 1 |

X Close Elen

Figure 6.49. Listing of proxy class attributes

Note
A short description for each attribute is also displayed. For a complete description of proxy classes and attributes see the
Proxedo Network Security Suite 1.0 Reference Guide.

There are syntax rules for setting attributes properly. For more information on these rules, see the Proxedo Network Security
Suite 1.0 Reference Guide or, to a limited extent, read all the available descriptions on the class selection screen.

Tip

AbstractProxy template descriptions are especially useful, since they contain the most information on syntax. For example,
to set HTTP request headers in the traffic, see Section 4.7.2.2, Configuring policies for HTTP requests and responses in
Proxedo Network Security Suite 1.0 Reference Guide.

Step 3. Select self.request_header attribute.
The attribute appears in the Changed proxy attributes listing of the Application-level Gateway class
configuration screen.
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Figure 6.50. The newly-added self-request_header attribute
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Figure 6.51. Editing an attribute
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Set the value of the attribute by clicking Edit. (Attribute Type is less relevant now.) A new window
opens which is, by default, empty.

Step 5.

Edit value of selfrequest_header

o e [vace E

| [new I @oelete| [Aedit | [Aedit key| [Aselect variable
ox

Figure 6.52. Modifying an attribute
Click the New button to define the name of the parameter you want to change.

In this example HTTP request headers are configured. These are standardized in the corresponding
RFC documentation or in any reliable book on web server administration/programming.

One of the request headers is called User -Agent which is the place to specify browser type and version
and operating system information. Popular statistics, such as the market share of web browsers, are
based on this request header.

By default, Application-level Gateway takes the original User -Agent header information it receives
from clients and uses the same value in http requests it generates.

Step 6. Enter User-Agent in the small dialog box to change the default behavior.

You can see the name of the header changing (Key column), but Type and Value columns still need
to be changed.
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Step 7.

Edit value of self.request_header

UUEESCE const_http_hdr_accept |HDR_ACCEPT

const_http_hdr_abort
const_http_hdr_drop
type_http_hdr_change_name
type_http_hdr_change_value
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const_http_hdr_change_regexp
type_http_hdr_insert

type_http_hdr_replace
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2 cancel Dok

Figure 6.53. Selecting action type for the attribute

Left-click on the Type column of the row containing the previously entered User-Agent string. A
drop-down list appears. Remember, you are changing the value of an existing attribute, so select
type_http_hdr_change_value here which changes the given header values.

Step 8. Click Edit to modify the Value column.
Set the actual value of the User -Agent request header. The following window opens.

E] ZMC - Edit tuple X

Ediit value of "User-Agent"

| Type | Value | =
const_http_hdr_change value HTTP_HDR_CHANGE VALUE

[0

| [Aedit IDge\ectvarlab\e

X canc

Figure 6.54. Editing the value of the User-Agent header

This window represents another view of the attribute you are modifying now. The Type column of
Figure Selecting action type for the attribute is now the first row in this window, while the Value
column became the second row here; it is currently empty.

Step 9. Click Edit to set the Value column and enter a string.
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i@ ZMC - Edit quoted string value x

Edit quoted string value

Quoted string value: |MyBrowser 1.0

X oo

Figure 6.55. Editing the User-Agent header

A string can be for example, My Browser.

-

Note

Web servers you visit from now on will see this information as the User -Agent header they receive and may act strangely
if they, or the content they serve (Java Servlets, for instance) are not prepared to handle unexpected values in User -Agent
headers.

Step 10. The process of changing the desired proxy class attribute is complete, you can see the result in the
Application-level Gateway class configuration window.

"1 Zorp g Console - admin@local-vb (M=
File Edit View Configuration Management PKI Help
Configuration Al AR R 2 &

< [] Balabit IT Security
< 00 ZMS-Host

Management agents Proxy Name | Parent Description
Management server | le i S S le el
[E] Networking MyPop3Proxy  Pop3Proxy
[E] Packet filter
[E vPN
| | New | () Delete | A Edit Description |
Changed config attributes "
: | Attribute |Type |Value —
! | self.transparent_mode boolean TRUE

Firewall Rules | Services | Policies Proxies | Instances | Advanced |

self.request_header  hash_AbstractHttpProxy request _header {"UserAgent": (HTTP_HDR_CHANGE_VALUE,

<1

[ | ]
| New | ®Qelete| - Edit |

Kl

0]

Unsaved changes |

Figure 6.56. The User-Agent request header attribute is changed

6.6.1.3. Customized proxies and the services

The proxy class parameter configured in the service definition defines what traffic passes through with the
help of the given service. Different services can have different proxy classes configured, even for the same
traffic type. For example, a firewall can have a number of services configured to pass HTTP traffic, each with
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its own, derived and customized proxy class parameter. If these proxy classes are parameterized differently,
the corresponding services also behave differently for the same HTTP traffic. A single service can only have
a single proxy class value configured, although that proxy class parameter can refer to a stacked proxy setup
as well.

6.6.2. Procedure — Renaming and editing proxy classes

To modify the basic attributes, for example, the name and the parent class of a proxy, complete the following
steps:

Step 1. Select the class and click Edit.

Step 2. To rename the class, edit the name of the proxy in the Proxy name field, then click Ok.

Step 3. To modify the parent class of the proxy, select the new class from the Proxy template tree on the left
of the dialog, then click Ok.

Warning
A As a result of modifying the parent class, an already configured proxy (that is, one that had its default values or attributes
modified) looses the attributes not present in its new parent class.

6.6.3. Analyzing embedded traffic

Most Application-level Gateway proxies can pass the information received as the payload of the incoming
traffic to another proxy for further analysis. This kind of complex data analysis is possible by placing a proxy
inside another one. This process is called stacking. Stacking is especially useful in filtering compound traffic,
a traffic that consists of two (or more) protocols or that needs to be analyzed in two different ways.

proxy can decrypt SSL and TLS encryption without having to use another proxy. For details on configuring Application-level Gateway
to handle encrypted connections, see How to configure SSL proxying in PNS 1.0.

Note
@ Earlier versions of Application-level Gateway used stacking to inspect encrypted protocols, for example, HTTPS or IMAPS. Now every

Usually protocols consist of two parts:

m control information, and
m data.

Protocol proxies analyze and filter the control part and except for some cases they are unaware of the data part.
At this point, further screening of the data might be needed, therefore proxies are able to stack in other proxies
capable of filtering the data part, so the external (upper) proxy passes that data traffic to the internal (lower)

proxy.
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Figure 6.57. Stacking proxies

— Example 6.8. Virus filtering and stacked proxies

—— | Virus filtering is also a multiple analysis of traffic. This is typically performed in HTTP, POP3 and SMTP traffic, because these are the
| w—1 protocols viruses generally use for spreading over the Internet (using Application-level Gateway it is possible to filter for viruses in other
protocols as well). When virus filtering is configured, a standard protocol proxy works in tandem with an antivirus engine and in this
way both protocol specific and virus filtering is performed on the data if you stack the antivirus engine into some proxy.

For details on configuring virus filtering in HTTP and HTTPS traffic, see How to configure virus filtering in HTTP.

For each stacking scenarios there are a number of attributes that can be configured. For more information see
the Proxedo Network Security Suite 1.0 Reference Guide.

6.6.3.1. Procedure - Stack proxies

Since Application-level Gateway proxies natively support TLS-encrypted connections, stacking proxies is
rarely needed in Application-level Gateway. For details on configuring TLS-encrypted connections (for example,
HTTPS), see How to configure SSL proxying in PNS 1.0. If you need to stack proxies for some reason, complete
the following steps.

Step 1. Derive a proxy class from one of the predefined ones. For details, see Section 6.6.1, Customizing
proxies (p. 134).

Step 2. Derive a proxy class for the 'external' or parent proxy.

Step 3. Configure stacking on the Application-level Gateway Class configuration screen.
Configuring stacking essentially means setting an attribute of the container proxy. The exact name of
the attribute depends on the parent proxy. For details, see the Proxedo Network Security Suite 1.0
Reference Guide. For details on setting proxy attributes, see Procedure 6.6.1.2, Customizing proxy
attributes (p. 136).
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6.7. Policies

The Policies tab provides a single interface for managing all the different policies used in Application-level
Gateway service definitions.

Policies are independent from service definitions. A single policy can be used in several services or proxy
classes. Policies must be created and properly configured before they are actually used in a service. When
configuring a service, only the existing (that is, previously defined) policies can be selected.
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Figure 6.58. The Policies tab

On the left side of the Policies tab the existing policies are displayed in a tree, sorted by policy type. If a policy
is selected, its parameters are displayed on the right side of the panel.

The policies available from the Policies tab of the MC Application-level Gateway component are listed below.
The subsequent sections describe the different policy types and their uses. The Authentication, Authentication
Provider, and Authorization policies are discussed in Chapter 15, Connection authentication and
authorization (p. 330).

m NAT Policy: Policies for source and destination network address translation.

www.balasys.hu 146



m Authentication Policy: Policies describing how clients should be authenticated in different scenarios.
See Chapter 15, Connection authentication and authorization (p. 330) for details.

B Authentication Provider: AS authentication backends: databases providing user information for
authentication. See Chapter 15, Connection authentication and authorization (p. 330) for details.

m Authorization Policy: Policies describing how clients should be authorized in different scenarios.
See Chapter 15, Connection authentication and authorization (p. 330) for details.

m Detector Policy: Policies that start a service based on the protocol used in the connection.
m Matcher Policy: Various matcher and filtering policies.
B Resolver Policy: Simple domain name resolution policies.

m Stacking Provider: External PNS hosts providing content filtering capabilities.

6.7.1. Procedure - Creating and managing policies

To create a new policy, complete the following steps.

Step 1. Navigate to Application-level Gateway > Policies and click the New button under the policies list.

Step 2. Enter a name for the policy and select the type of the new policy from Policy type combobox. If a
policy or a policy group (for example, NAT policy) is selected, the combobox is automatically set to
the same type.

i ZMC - New policy X

New policy

Bolicy name: [Demo_resolverpolicy

Policy type: [Resalver policy |

Description: ||

Figure 6.59. Defining new policies

Note
Custom policy classes can be created using the Class editor. However, this is only recommended for advanced users.

®

Step 3. Configure the parameters of the new class on the right side of the panel. Existing policy classes can
be modified here as well.

Tip
m To disable a policy or a matcher, use the local menu (right-click the selected policy). Disabled policies will be
generated into the configuration files as comments.

m To duplicate a policy, use the Copy and Paste options of the local or the Edit menu.
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6.7.2. Detector policies

Detector policies can be used in firewall rules with DetectorServices: they specify which service should
Application-level Gateway start for a specific type of protocol or certificate found in the traffic of connection.
Currently Detector policies cam detect the HTTP, SSH, and SSL protocols. In SSL/TLS-encrypted connections,
Application-level Gateway can select which service to start based on the certificate of the server.

For example, you can use this feature for the following purposes:

m enable HTTP traffic on non-standard ports

m enable SSL-encrypted traffic only to specific servers or server farms that do not have public TP
addresses (for example, Microsoft Windows Update servers)

B enable access only to specific HTTPS services (for example, enable access to Google Search (which
has a certificate issued to www.google.com), but deny access to GMail (which uses a certificate
issued to accounts.google.com))

Edit rule

Enabled

Description: ‘

Conditions Service |Tags|

Service provided by this rule

Service: ‘De‘tectorSer\nce ¥ | Create new...
Class: |Detector5&mce 57

Description: ‘

Detect

Detector ‘Service |7

New | Delete ‘ Edit ‘ Al w

Run in this instance: instance = ‘ Create new...‘

Figure 6.60. Detector policies

Detector policies contain a detector that determines if the traffic in a connection belongs to a particular protocol
or not. Firewall rules can include a list of detector-service pairs. When a client opens a connection that is handled
by a DetectorService, Application-level Gateway evaluates the detectors in the Detector policy of the
DetectorService, starting with the first detector. When a detector matches the traffic in the connection,
Application-level Gateway starts the service set for the detector to handle the connection. If none of the detectors
match the traffic, then Application-level Gateway terminates the connection.
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— Example 6.9. Defining a Detector policy
—— | Python: Below is a Detector policy that detects SSH traffic in a connection.

DetectorPolicy(name="DemoSSHDetector", detector=SshDetector())
DetectorPolicy(name="DemoHTTPDetector", detector=HttpDetector()

The following firewall rule uses the DemoSSHDetector Detector policy to start the DemoSSHService service if SSH traffic is found in
a connection, and drops other connections.

Rule(rule_id=1,
proto=6,
detect={'DemoSSHDetector' : 'demo_instance/DemoSSHService',?}

)

The following firewall rule uses the DemoSSHDetector and the DemoHTTPDetector Detector policies to start the DemoSSHService or
the DemoHTTPService services if SSH or HTTP traffic is found in a connection, and drops other connections.

Rule(rule_id=1,
proto=6,
detect={'DemoSSHDetector' : 'demo_instance/DemoSSHService',
'DemoHTTPDetector' : 'demo_instance/DemoHTTPService',}
)

6.7.3. Encryption policies

m For a basic overview about Encryption policies, see Section 6.7.3.1, Understanding Encryption
policies (p. 149).

m For examples on configuring Encryption policies, see How to configure SSL proxying in PNS 1.0.
For details on HTTPS-specific problems and its solutions, see How to configure HTTPS proxying
in PNS 1.0.

m For details on how the SSL/TLS framework works in Application-level Gateway, see Chapter 3,
The PNS SSL framework in Proxedo Network Security Suite 1.0 Reference Guide

6.7.3.1. Understanding Encryption policies

This section describes the configuration blocks of Encryption policies and objects used in Encryption policies.
Encryption policies were designed to be flexible, and make encryption settings easy to re-use in different
services.

An Encryption policy is an object that has a unique name, and references a fully-configured encryption
scenario.

Encryption scenarios are actually Python classes that describe how encryption is used in a particular connection,
for example, both the server-side and the client-side connection is encrypted, or the connection uses a one-sided
SSL connection, and so on. Encryption scenarios also reference other classes that contain the actual settings
for the scenario. Depending on the scenario, the following classes can be set for the client-side, the server-side,
or both.

m Certificate generator: Creates or loads an X.509 certificate that Application-level Gateway shows
to the peer. The certificate can be a simple certificate (Section 5.5.23, Class StaticCertificate in
Proxedo Network Security Suite 1.0 Reference Guide), a dynamically generated certificate (for
example, used in a keybridging scenario, Section 5.5.12, Class DynamicCertificate in Proxedo
Network Security Suite 1.0 Reference Guide), or a list of certificates to support Server Name Indication
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(SNI, Section 5.5.17, Class SNIBasedCertificate in Proxedo Network Security Suite 1.0 Reference
Guide).
Related parameters: client_certificate_generator, server_certificate_generator

m Certificate verifier: The settings in this class determine if Application-level Gateway requests a
certificate of the peer and how to verify it. Application-level Gateway has separate built-in classes
for the client-side and the server-side verification settings: Section 5.5.6, Class ClientCertificateVerifier
in Proxedo Network Security Suite 1.0 Reference Guide and Section 5.5.19, Class
ServerCertificateVerifier in Proxedo Network Security Suite 1.0 Reference Guide. For details and
examples, see Section 3.2.5, Certificate verification options in Proxedo Network Security Suite 1.0
Reference Guide.

Related parameters: client_verify, server_verify

m Protocol settings: The settings in this class determine the protocol-level settings of the SSL/TLS
connection, for example, the permitted ciphers and protocol versions, session-reuse settings, and so
on. Application-level Gateway has separate built-in classes for the client-side and the server-side
SSL/TLS settings: Section 5.5.10, Class ClientSSLOptions in Proxedo Network Security Suite 1.0
Reference Guide and Section 5.5.22, Class ServerSSLOptions in Proxedo Network Security Suite
1.0 Reference Guide. For details and examples, see Section 3.2.6, Protocol-level TLS settings in
Proxedo Network Security Suite 1.0 Reference Guide.

Related parameters: client_ssl options, server_ssl_option

Application-level Gateway provides the following built-in encryption scenarios:

m TwoSidedEncryption: Both the client-Application-level Gateway and the Application-level
Gateway-server connections are encrypted. For details, see Section 5.5.24, Class TwoSidedEncryption
in Proxedo Network Security Suite 1.0 Reference Guide.

® ClientOnlyEncryption: Only the client-Application-level Gateway connection is encrypted, the
Application-level Gateway-server connection is not. For details, see Section 5.5.8, Class
ClientOnlyEncryption in Proxedo Network Security Suite 1.0 Reference Guide.

®m ServerOnlyEncryption: Only the Application-level Gateway-server connection is encrypted, the
client-Application-level Gateway connection is not. For details, see Section 5.5.21, Class
ServerOnlyEncryption in Proxedo Network Security Suite 1.0 Reference Guide.

® ForwardStartTLSEncryption: The client can optionally request STARTTLS encryption. For
details, see Section 5.5.15, Class ForwardStartTLSEncryption in Proxedo Network Security Suite
1.0 Reference Guide.

m ClientOnlyStartTLSEncryption: The client can optionally request STARTTLS encryption, but
the server-side connection is always unencrypted. For details, see Section 5.5.9, Class
ClientOnlyStartTLSEncryption in Proxedo Network Security Suite 1.0 Reference Guide.

m FakeStartTLSEncryption: The client can optionally request STARTTLS encryption, but the
server-side connection is always encrypted. For details, see Section 5.5.14, Class
FakeStartTLSEncryption in Proxedo Network Security Suite 1.0 Reference Guide.

For examples on configuring Encryption policies, see How to configure SSL proxying in PNS 1.0. For details
on HTTPS-specific problems and its solutions, see How to configure HTTPS proxying in PNS 1.0.
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6.7.4. Matcher policies

In general, matcher policies can be used to find out if a parameter is included in a list (or which elements of a
list correspond to a certain parameter), and influence the behavior of the proxy class based on the results.
Matchers can be used for a wide range of tasks, for example, to determine if the particular IP address or URL
that a client is trying to access is on a black or whitelist, or to verify that a particular e-mail address is valid.
The matchers usable in a proxy class are described in the Proxedo Network Security Suite 1.0 Reference Guide.

®

Note
Matchers can also be used in custom proxy classes created with the Class editor.
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Figure 6.61. Matcher policies

Application-level Gateway has a number of predefined matcher classes; and it is also possible to make complex
decisions from the results of individual matchers using the CombineMatcher class. The available predefined
classes are listed below.

® DNSMatcher: Retrieves the IP address(es) of a domain from the name server specified.

m WindowsUpdateMatcher: Retrieves the IP addresses required for updating computers running
Microsoft Windows from the name server specified.

B RegexpMatcher: General regular expression matcher.

m RegexpFileMatcher: Regular expression based matching on the contents of files.

m SmtplnvalidRecipientMatcher: Consults a mail server to verify that an e-mail address is valid.
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m CombineMatcher: Makes complex decisions by combining the results of multiple simple matchers
using logical operations.

Apart from the predefined ones, it is also possible to create custom matcher classes. The various matcher classes
and their uses are described in the subsequent sections. The use of matchers in proxy classes is discussed in
Section 6.7.4.7, Using matcher classes in proxy classes (p. 156).

6.7.4.1. Matching domain names with DNSMatcher

DNSMatcher retrieves the IP addresses of domain names. This can be used in domain name based policy
decisions, for example to allow encrypted connections only to trusted e-banking sites. If the IP address of the
name server is not specified in the DNS Server field, the name server set in the Networking component is
used (see Section 5.3, Managing client-side name resolution (p. 77) for details).

— Example 6.10. DNSMatcher for two domain names
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Figure 6.62. Sample DNSMatcher policy

Python:
MatcherPolicy(name="ExampleDomainMatcher", matcher=DNSMatcher (server="dns.example.com",6\
hosts=("example2.com", "example3.com")))

6.7.4.2. WindowsUpdateMatcher

WindowsUpdateMatcher is actually a DNSMatcher used to retrieve the IP addresses currently associated with
the v5.windowsupdate.microsoft.nsatc.net, v4.windowsupdate.microsoft.nsatc.net, and
update.microsoft.nsatc.net domain names; only the IP address of the name server has to be specified.
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Windows Update is running on a distributed server farm, using the DNS round robin method and a short TTL
to constantly change the set of servers currently visible, consequently the IP addresses of the servers are
constantly changing.

HTTPS. For example, there is no real use in inspecting the HTTP traffic embedded into the SSL tunnel (since it is mostly file download),

Tip
This matcher class is useful to create firewall policies related to updating Windows-based machines. Windows Update is running over
but it is important to verify the identity of the servers.

6.7.4.3. RegexpMatcher

A RegexpMatcher consists of two string lists, describing the regular expressions to be found (Match list) and,
optionally, another list of expressions that should be ignored (Ignore list) when processing the input. By default,
matches are case insensitive. For case sensitive matches, uncheck the Ignere case option.

Note
@ The string lists are stored in the policy.py configuration file.

— Example 6.11. Defining a RegexpMatcher

| w— - Zorp Management Console - admin@local [ =[] x]
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Figure 6.63. Sample RegexpMatcher

The matcher below defines a RegexpMatcher called Smtpdomains, with only the smtp. example.com domain in its match list.
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Python:

MatcherPolicy(name="Smtpdomains", matcher=RegexpMatcher\
(match_list=("smtp.example.com",), ignore_list=None))

6.7.4.4. RegexpFileMatcher

RegexpFileMatcher is similar to RegexpMatcher, only the two lists are stored in separate files. The matcher
itself stores only the paths and the filenames to the lists. The files themselves can be managed either manually,

or using the FreeText plugin.

6.7.4.5. Verifying e-mail addresses with the SmtpinvalidMatcher

This matcher class uses an external SMTP server to verify that a given address (that is, the recipient of an
e-mail) exists. The following parameters have to be specified:
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Figure 6.64. Configuring SmtplnvalidMatcher

®m Server name and Server port: The domain name and the port used by the SMTP server to be queried.

® Bind address: Application-level Gateway uses this IP address as the source address of the connection
when connecting the SMTP server to be queried.

m Cache timeout: The result of a query is stored for the period set as Cache timeout in seconds. If a
new e-mail is sent to the same recipient within this interval, the stored verification result is used.

® Force delivery attempt and Sender address: Send an e-mail to the recipient as if it was sent by
Sender address. If the destination mail server accepts this mail, the original e-mail is sent. This
option is required because many mail server implementations do not support the VRFY SMTP
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command properly, or it is not enabled. (The default value for Sender address is <>, which refers
to the mailer daemon and is recognized by virtually all servers.)

6.7.4.6. Making complex decisions with the CombineMatcher

CombineMatcher uses the results of multiple matchers to make a decision. The results of the individual matchers
can be combined using the logic operations AND, OR and NOT. Both existing matcher policies (Matcher
policy) and policies defined only within the particular CombineMatcher (Matcher instance) can be used.
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Figure 6.65. CombineMatcher

New matchers can be added with the Add button. Each line in the main window of the CombineMatcher
configuration panel corresponds to a matcher. To use an existing matcher policy, set the combobox on the left
to Matcher policy. After that, clicking the ... opens a dialog window where the matcher to be used can be
selected.

Tip
Matchers can also be configured on-the-fly: set the combobox to Matcher instance, click on ..., and select and configure the matcher
as required.

Each matcher can be taken into consideration either with its regular, or with its inverted result using the Not
checkbox. The individual matchers (or their inverses) can be combined with the logical AND, and OR operations.
This can be set in the Logic combobox:
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m If all criteria are met: Corresponds to logical AND; the CombineMatcher will return the TRUE
value only if all criteria are TRUE.

m If any criteria are met: Corresponds to logical OR; the CombineMatcher will return the TRUE
value if at least one criteria is TRUE.

m If all criteria are the same: CombineMatcher will return the TRUE value if all criteria have the
same value (either TRUE or FALSE).

Tip
A CombineMatcher can also be used to combine the results of other CombineMatchers, thus very complex decisions can also be made.

— Example 6.12. Blacklisting e-mail recipients
— | A simple use for CombineMatcher is to filter the recipients of e-mail addresses using the following process:

1. An SmtpInvalidMatcher (called SmtpCheckrecipient) verifies that the recipient exists.

2. A RegexpMatcher (called Smtpwhitelist) or RegexpFileMatcher is used to check if the address is on a predefined list.
This list is either a whitelist (permitted addresses) or a blacklist (addresses to be rejected).

3. A CombineMatcher (called SmtpCombineMatcher) sums up the results of the matchers with a logical AND operation
(If all criteria are met). If the list of the RegexpMatcher is a blacklist, the result of the RegexpMatcher should be inverted
by checking the Not checkbox.

4. An SmtpProxy (called SmtpRecipientMatcherProxy)references SmtpCombineMatcher inits recipient_matcher
attribute.

Python:
class SmtpRecipientMatcherProxy(SmtpProxy):
recipient_matcher="SmtpCombineMatcher"
def config(self):
SmtpProxy.config(self)

MatcherPolicy(name="SmtpCombineMatcher", matcher=CombineMatcher\
(expr=(Z_AND, "SmtpCheckrecipient", "SmtpWhitelist")))
MatcherPolicy(name="SmtpWhitelist", matcher=RegexpMatcher\
(match_list=("info@example.com",), ignore_list=None))
MatcherPolicy(name="SmtpCheckrecipient", matcher=SmtpInvalidRecipientMatcher\
(server_port=25, cache_timeout=60, attempt_delivery=FALSE, \
force_delivery_attempt=FALSE, server_name="recipientcheck.example.com"))

6.7.4.7. Using matcher classes in proxy classes

To actually use the defined matchers, they have to be specified in the proper attributes of the particular proxy
class. The proxy classes can use matchers for a variety of tasks. The matchers to be used by the particular proxy
class can be added as Changed class attributes.
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Figure 6.66. Using a matchers in proxy classes

For example, SmtpProxy can use three different matchers: one to check the relayed domains (for example,
using a RegexpMatcher), and two SmptinvalidMatchers (one for sender, one for the recipient address verification).
For the details of the matchers usable by a given proxy class see the attributes of the class in Chapter 4, Proxies
in Proxedo Network Security Suite 1.0 Reference Guide.

— Example 6.13. SmtpProxy class using a matcher for controlling relayed zones

[ —] Python:
class SmtpMatcherProxy(SmtpProxy):

relay_domains_matcher="Smtpdomains"
def config(self):
SmtpProxy.config(self)

MatcherPolicy(name="Smtpdomains", matcher=RegexpMatcher(match_list=("example.com",),\
ignore_list=None))

6.7.5. NAT policies

Network Address Translation (NAT) is a technology that can be used to change source or destination addresses
in a connection from one IP address to another one.

Today most corporate networks work with private, non-Internet-routable IP addresses from the 10.0.0.0/8,
172.16.0.0/12 or 192.168.0.0/16 ranges. These IP addresses are suitable for intranet communication
(they can even be routed internally) but cannot be used on the Internet. Therefore a mechanism, NAT, is in
place that, whenever an internal client wants to access Internet resources, uses a public IP address for this
purpose.
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Another use for NAT is address hiding. Towards the Internet only a limited number of public IP addresses are
visible, while you may have thousands of internal clients and servers all “translated” to those few addresses.

Tip

Address hiding with the help of NAT is especially useful for published servers (usually located in a DMZ). The potential attackers only
see a few public IP addresses (or even a single one) but from this information they have no way of knowing where your servers are
actually located, how many of them there are and in what configuration.

Note
@ Although address hiding can be considered as a security feature, NAT alone is not enough to protect a network from malicious intruders.
Never use NAT in itself as a security solution.

Based on whether source or destination IP addresses are transformed two kinds of NAT can be differentiated.

m Source NAT (SNAT),
if source IP addresses are transformed.

m Destination NAT (DNAT),
if address transformation is performed on destination IP addresses.

Basically, NAT in Application-level Gateway provides a possibility to modify the source and destination TP
address at the server side before the connection is established. The source and destination IP address values are
defined previously by the router on the basis of router type, its settings and the client request. In some cases,
Proxy settings can also be involved, for example when the Target address overrideable by the proxy router
option is enabled. NAT is responsible for changing IP addresses to some other addresses depending on the
configuration of the NAT policy.

Note
@ This NAT is performed by the Application-level Gateway component and is totally different from the NAT offered by IPTables in the
Packet Filter component.

By default, when no NAT policy is set up, Application-level Gateway uses its own IP address configured for
the corresponding network interface when sending out traffic in any direction. Although this results in many
clients “using” the same (single) IP address, it is not considered as SNAT technically.

In Application-level Gateway NAT is performed on the application proxy level. In this case it is not strictly IP
address replacement, since original packets do not appear in the traffic leaving the firewall. It is an IP address
modification rule rather. If application proxying is used — meaning there is no traffic that is forwarded on the
packet filter level — packet filter level NAT is neither required nor recommended.

Service definitions contain NAT policy settings to configure application proxy—level NAT.

address replacement, since the packet filter — rules permitting — forwards the original packets it receives. You are not recommended to

Note
@ If some traffic is managed at the packet filter level, NAT must be performed at the packet filter level, too. In this case, NAT is really IP
use NAT at the packet filter level.
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For more details on packet filter-level NAT solutions, see Appendix A, Packet Filtering (p. 384).

Originally NAT meant only address translation, leaving port information travelling in TCP or UDP packets
unmodified. This can lead to errors especially in large networks where thousands of clients are NATed by a
single machine, therefore NAT technologies were modified to do port translation as well, guaranteeing that
even if two internal clients try to use the same source port number in session establishments, the packets leaving
the NAT server always have unique source IP address/port pairs.

Note
@ Port translating NAT devices are incompatible with IPSec encryption (which is a major drawback as IPSec is becoming increasingly
popular) and may be incompatible with proprietary, two-channel protocols as well.

6.7.5.1. Configuring NAT in Application-level Gateway

Before you start NAT configuration you must decide whether you need it at all. If you need traffic redirection,
for example a Web server in your DMZ, routers may serve your needs. By default, Application-level Gateway
uses its own IP address (bound to the corresponding adapter) to all connections leaving it in any direction,
unless the Use client address as source router option is set, in which case the original client IP address is used.
Consequently, NAT may not be absolutely necessary.

Note
@ Configuring SNAT Policy for a Service automatically enables the Use client address as source router function, so during SNAT the
client's address is used, not the firewall's.

Unlike in firewall-less network configurations, where NAT is a universal setting for all clients communicating
with any protocol, in Application-level Gateway different traffic can be NATed differently because NAT
configurations are linked to services. It can happen that while outgoing HTTP traffic is SNATed to a single
public IP address, SQL traffic from the same network is not SNATed at all, and finally FTP download traffic
is SNATed to a separate NAT pool.

6.7.5.1.1. Procedure - Configuring NAT

Step 1. Create the required NAT policies on the Policies tab of the Application-level Gateway MC component.
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Figure 6.67. NAT policy configuration window

Click the New button, select NAT Policy from the Policy type combobox and supply a name for the
new policy.

Names should be descriptive and ideally contain information about the direction of NATing and/or
about the type of traffic NATed.

In most network configurations NAT is typically not service-specific; a generic NAT policy may be
adequate for most outgoing or incoming traffic. There are no compulsory rules for naming.

NAT policies can be renamed any time.

Tip
Remove NAT policies from the configuration set if they are no longer needed.

NAT policies can be removed only if they are not used in any service definition.

Step 2. Configure a NAT solution.
Application-level Gateway supports several different NAT solutions.
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Figure 6.68. Editing a General NAT rule

GeneralNAT has three parameters: source address, destination address, and the translated address.
Connections arriving from the source address that target the destination address are modified to use
the translated address. If the NAT policy is used as Source-NAT (SNAT), the source address is translated
to the translated address, if the policy is used as Destination NAT (DNAT), the target address is

translated.
Policies
Policy ~ [Descrip 4] | [] Cacheable
Authentication policy NAT

Authentication provider

Authorization policy Select class: [GeneralNAT

Lo

Matcher policy
= NAT policy
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Figure 6.69. Sample GeneralNAT rule

Note

@ The original and translated netmasks do not need to be the same: it is possible to map an entire /24 network onto a single IP
address (/32 mask). However, the order of the pairs is important because the Application-level Gateway processes the list
from top to bottom.

www.balasys.hu 161



NAT policies (37

Depending on the NAT type (SNAT, DNAT), Application-level Gateway evaluates the NAT rules
one after the other. If a row containing the address to be NATed as the source network, the iteration
stops and Application-level Gateway modifies the TP address as specified in that row. If no match is
found, the original IP address is used.

When modifying the address, it calculates the host ID of the address using the target netmask and the
source network address and adds it to the target network.

Example 6.14. Address translation examples using GeneralNAT
The following two tables show a number of simple and special GeneralNAT cases. The Destination Address in these cases

issetto 0.0.0.0/0

Source network Target network Source IP address Translated IP address
10.0.1.0/24 192.168.1.0/24 10.0.1.5 192.168.1.5
10.0.1.0/24 192.168.1.0/25 10.0.1.130 192.168.1.2
10.0.1.0/25 192.168.1.0/24 10.0.1.42 192.168.1.42
Source network Target network Original IP address New IP address
0.0.0.0/0 192.168.2.2/32 172.17.3.5 192.168.2.2
0.0.0.0/0 192.168.3.0/31 172.18.1.1 192.168.3.1
0.0.0.0/0 192.168.3.0/31 172.18.1.2 192.168.3.0
192.168.3.1/32 172.19.2.0/24 192.168.3.1 172.19.2.0

Step 3. Configure caching.
Since the NAT decision may take a long time in some cases (for example, if there are many mappings

in the list),

the decisions can be stored in a cache. Storing the decisons in a cache accelerates future

decisions. Caching can be enabled/disabled using theCacheable checkbox in the configuration window
of the NAT policy.

Q|

.

www.balasys.hu

Tip
It is recommended to enable caching for complex NAT decisions.

Note

Enabling caching can have interesting, but sometimes unwanted effects on some NAT types, for example on RandomNAT.
Using RandomNAT and the Cachable option together would result in LoadBalancing, but with sticky IP addresses, the cache
would remember which source IP address was used before for a specific client's IP address and would use the same address
again. This can be very useful, but can also cause a lot of headache and troubleshooting.
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6.7.5.2. Types of NAT policies

Application-level Gateway supports the following types of NAT policies. For details on the parameters of these
NAT policies, see Section 5.8, Module NAT in Proxedo Network Security Suite 1.0 Reference Guide.

NAT policy

Description

General NAT

Simple mapping based on the original and desired
address(es). General NAT can be used to map a set of
IP addresses (a subnet) to either a single IP address or
to a set of IP addresses (a subnet). For details, see
Section 5.8.4, Class GeneralNAT in Proxedo Network
Security Suite 1.0 Reference Guide.

StaticNAT

This option can be used to specify a single IP
address/port pair to use in address transforms. It is
mainly used in DNAT configurations where incoming
traffic must be directed to an internal or DMZ server
that has a private IP address. Specifying port translation
is optional. When used in conjunction with SNAT,
StaticNAT can be used to map to IP alias(es). For
details, see Section 5.8.12, Class StaticNAT in Proxedo
Network Security Suite 1.0 Reference Guide.

OneToOneNAT

In OneToOneNAT mapping you must configure TP
address mappings for your address sets (domains)
individually. In other words, OneToOneNAT maps
networks to networks — with the possibility that your
networks consist of single IP addresses. To use
OneToOneNAT the two networks must be of the same
size. For details, see Section 5.8.10, Class
OneToOneNAT in Proxedo Network Security Suite 1.0
Reference Guide.

OneToOneMultiNAT

This option maps multiple IP address domains to
multiple IP address domains. It is primarily useful for
large-scale, enterprise deployments. It is like
OneToOneNAT but can have multiple NAT mappings.
For details, see Section 5.8.9, Class
OneloOneMultiNAT in Proxedo Network Security Suite
1.0 Reference Guide.

RandomNAT
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It means that the firewall selects an IP address from the
configured NAT pool randomly for each new
connection attempt. Once a communication channel (a
session) is established, subsequent packets belonging
to the same session use the same IP address. The port
number used in RandomNAT transforms can be fixed,
even for each IP address used in the NAT pool
separately. It is ideal when you want to distribute the
load (use) of addresses in your NAT pool evenly and
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NAT policy

Description

you do not have specific requirements for fixed address
allocations such as IP based authentication. For details,
see Section 5.8.11, Class RandomNAT in Proxedo
Network Security Suite 1.0 Reference Guide.

HashNAT

It maps individual IP addresses to individual IP
addresses very quickly, using hash values to determine
mappings and storing them in hash tables. For details,
see Section 5.8.5, Class HashNAT in Proxedo Network
Security Suite 1.0 Reference Guide.

NAT46

NAT46 embeds an IPv4 address into a specific portion
of the IPv6 address, according to the NAT46
specification described in RFC6052. For details, see
Section 5.8.6, Class NAT46 in Proxedo Network
Security Suite 1.0 Reference Guide.

NAT64

NAT64 maps specific bits of the IPv6 address to IPv4
addresses according to the NAT64 specification
described in REC6052. For details, see Section 5.8.7
Class NAT64 in Proxedo Network Security Suite 1.0
Reference Guide.

6.7.5.3. NAT and services

Table 6.2. NAT solutions

The NAT policies created in the Policies tab can be used in service definitions. Navigate to the Services tab,
select a service and choose a NAT policy as either the Source NAT policy or the Destination NAT policy service

parameter.
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Figure 6.70. Using a NAT policy in a service definition

Remember that NAT policies are independent configuration entities and come into effect only if they are used
in service definitions. Also, SNAT and DNAT policies are two different and independent service parameters:
it is not required to have either one or both in any service definition. One service can only use a single NAT
policy (or none) as its Source and another one (or none) as its Destination NAT policy parameter. These two
settings usually do not reference the same NAT policy (although this is not impossible).

In general, while all NAT policies are equal in that they are freely usable as either source or destination NAT
policies in service definitions, they are typically created with their future use in mind. There is no specification
on whether NAT policies are SNAT or DNAT policies: they are SNAT or DNAT policies only from the point
of view of the services that are using them.

NAT policies can be reused. Any number of services can use them.

Note
@ Although it is often considered a security-enhancing feature, NAT is not intended for access control of any type. Instead, use proper
Zone setups and service definitions for this purpose.
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6.7.5.4. NAT and other policy objects

NAT in Application-level Gateway is an option to change source/destination IP address information in the
server side of connections of the firewall, immediately before the connection is started. Since NAT (if used)
decisions are made after all other IP address related configurations, such as router, proxy configuration, NAT
can override these previous settings. NAT in Application-level Gateway can be used to shift IP address ranges,
to set IP addresses and to customize these operations.

In a service definition there are potentially two different components that directly deal with IP address setting:

W a router (compulsory),
®m and a NAT policy (or two) (optional).

In the address setting procedure the following processes are involved.

1. Incoming connection is accepted and a new session is created.

2. Destination address is set by the Router and using the Use client address as source option the source
address of the server side connection is also set.
Remember that the Router only gives a suggestion for the source/destination IP addresses as the
proxy or the NAT can later override these suggestions.

3. Router settings can be altered by the proxy if the Target address overrideable by the proxy option
is set or InbandRouter is selected and the proxy has some protocol based information.

4. NAT is performed, depending on NAT types (SNAT/DNAT).

5. Access control check is performed based on the final destination IP address decision. Check whether
the service is allowed as an inbound service into the zone where the destination IP address
belongs to.

6. The connection to the server is established.

Note

@ When checking the inbound services of the zone, the IP address to which the firewall actually connects to is considered. In other words,
the original destination address of the client may be overridden by the router, the proxy and DNAT as well. Zone access control uses
only the final IP address, all interim addresses (set by the Router, Proxy, but not used as the final one) are ignored in the access control
decision.

If a service uses an SNAT Policy, the Use client address as source is implicitly set as well so that SNAT uses
the client IP address instead of the firewall IP address. That is, if the NAT policy does not include SNAT
modification, the client's IP address is used even if the Use client address as source is unset in the router.

Tip
The versatility of NAT policies is especially useful in large-scale, enterprise deployments or where a lot of NAT is used.
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6.7.6. Resolver policies

Resolver policies specify how a given service should resolve the domain names in client requests. This capability
is essential when non-transparent services are used, as in these cases the PNS host has to determine the destination
address, and the results of a name resolution are needed. Application-level Gateway is also able to store the
addresses of often used domain names in a hash. Application-level Gateway supports DNS-based (DNSResolver)
and Hash table-based (HashResolver) name resolution.
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Figure 6.71. Resolver policies

DNSResolver policies query the domain name server used by Application-level Gateway in general to resolve
domain names. If a domain name is associated to multiple IP addresses (that is, it has more than one 'A' records),
these records can be retrieved by checking the Return multiple DNS records checkbox. (The DNS server
used by the PNS host can be specified on the Resolver tab of the Networking component, see Section 5.3,
Managing client-side name resolution (p. 77) for details.)

Tip

Retrieving multiple 'A’ records is useful when Application-level Gateway is used to perform load balancing.

— Example 6.15. Defining a Resolver policy
—